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1

WebSphere SPI Concepts

The Smart Plug-in for WebSphere Application Server (WebSphere SPI) enables you to
manage WebSphere Application Servers from an HP Operations Manager (HPOM) console.
The WebSphere SPI adds monitoring capabilities otherwise unavailable to HPOM. For more
information on HPOM, see HP Operations for UNIX Concepts Guide.

Introducing the WebSphere SPI

In conjunction with HPOM, the WebSphere SPI offers centralized tools that help you monitor
and manage systems using WebSphere Server. From the HPOM console, you can apply
performance and problem managing processes to monitor systems using the WebSphere
Server. WebSphere SPI metrics are automatically sent to the HP Operations agent. These
metrics can generate alarms or be consolidated into reports and graphs to help you analyze
trends in server usage, availability, and performance. You can also integrate the WebSphere
SPI with HP Reporter and HP Performance Manager (both products must be purchased
separately) to obtain additional reporting and graphing flexibility and capabilities. For details
on integrating the WebSphere SPI with other HP products, see Integrating HP Reporting and
Graphing Products with the WebSphere SPI on page 81.

Smart Plug-in Data

The WebSphere SPI has several server-related metrics that gather data about the following:
e Server availability

e Server performance

e Memory usage

e Transaction rates

e Servlet executing times, time-outs, request rates

e JDBC connection status

e Web application processing

Smart Plug-in Uses and Customizations

As a WebSphere Server administrator, you can choose the metrics crucial to the operation of
WebSphere Server by modifying the WebSphere SPI templates. The templates contain
settings that allow incoming data to be measured against predefined rules. These rules
generate useful information in the form of messages. The messages have color-coding to
indicate the severity level. You can review these messages for problem analysis and
resolution. There are several pre-defined corrective actions for specific events or threshold
violations. These corrective actions can be automatically triggered or operator-initiated.
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Functions of the WebSphere SPI

The WebSphere SPI messaging, reporting, and action-executing capabilities are based on the
HPOM concept of templates. The settings within these templates define various conditions
that may occur within the WebSphere Server and allow information to be sent back to the
HPOM management server. This helps you to proactively address potential or existing
problems and avoid serious disruptions to web transaction processing. The WebSphere SPI
performs the following functions described in the following sections:

Collecting and Interpreting Server Performance and Availability Information

After you configure the WebSphere SPI, and the templates are deployed to the managed
nodes, the SPI starts gathering server performance and availability data. This data is
compared with the settings within the deployed templates. The templates define conditions
that can occur within the WebSphere Server, such as queue throughput rates, cache use
percentages, timeout rates, and average transaction times. The templates monitor these
conditions against default thresholds (set within the templates) and trigger messages when a
threshold has been exceeded.

Displaying Information

The WebSphere SPI templates generate messages when a threshold is exceeded. These
messages can appear as:

Messages in the Message Browser— HP Operations agent software compares the values
gathered for WebSphere Server performance and availability against the monitor template
settings related to those specific areas. The agent software then forwards appropriate
messages to the HPOM console. These messages appear with color-coded severity levels in the
HPOM message browser.

Browser Actions View Window

I ed and re-creat
156.144) at Fri Aug 17

d4) &t Fri Aug 17

iration time
fre

0 0 crollom
own | Highlight | Details.. | 'erform Actiol Annotations.] Acknowledgd |

Instruction Text— Messages generated by the WebSphere SPI programs contain instruction
text to help analyze and solve problems. You can manually perform corrective actions
preassigned to events or they can be triggered automatically.
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Instruction text is usually present in the message details. Instruction text is also available in
the HP Operations Smart Plug-in for BEA WebSphere Server SPI Reference Guide..

=i |
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ASCII-Text Reports— In addition to the instruction text, some messages cause automatic
action reports to be generated. These reports show conditions of a specific WebSphere Server
instance. If a report is available, you can find it within the Annotations area of the Message
Details.

Generating Reports Using HP Reporter

You can integrate the WebSphere SPI with HP Reporter to provide you with
management-ready, web-based reports. The WebSphere SPI Report package includes the

templates for generating these reports. You can install the Report package on the Reporter
Windows system.

After you install the product and complete basic configuration, Reporter generates reports of
summarized, consolidated data every night. With the help of these reports you can assess the
performance of the WebSphere Server over a period of time.

Reporter uses the WebSphere SPI data to generate reports that illustrate for example, servlet
request rates, transaction throughput rates, and average transaction execution time.

WebSphere SPI Concepis 15
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Graphing Data with HP Performance Manager

Metrics collected by the WebSphere SPI can be graphed. The values can then be viewed for
trend analysis.

You can integrate the WebSphere SPI with HP Performance Manager to generate and view
graphs. (use the View Graphs application from the WBSSPI Admin applications group to view
graphs). These graphs show the values of the metrics collected by the WebSphere SPI. You
can click Perform Action to view graphed data from almost all the WebSphere SPI alarm
messages. Perform Action is present in the message browser and in the message details (you
can access details by either double-clicking the message or clicking Details...in the message
browser) in the message browser. The action launches your Web browser, where you can
choose a graph that shows values for the metric that generated the message as well as other
related metrics.

Customizing Templates and Metrics

You can use the WebSphere SPI templates without customization, or you can modify them to
suit the needs of your environment. Some of the modifications and customizations that you
can do are the following:

e Modify the default templates - Within a template, you can change the default settings for:
— Collection interval

— Threshold
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— Message text

— Duration

— Severity level of the condition

— Actions assigned to the condition (operator-initiated or automatic)

e C(Create custom template groups— You can create custom template groups using default
templates as base. For more information, see Chapter 4, Customizing the WebSphere SPI
Templates.

¢ C(Create custom metrics— You can define your own metrics or User Defined Metrics (UDMs)
to expand the monitoring capabilities of the WebSphere SPI. For more information about
UDMs see the HP Operations Smart Plug-in for User Defined Metrics User Guide.

WebSphere SPI Components

The WebSphere SPI has two main components:
e Applications (including reports)
e Templates

You can use the applications and templates to configure and receive data in the form of
messages, annotations, and metric reports. These messages (available in the message
browser), annotations (available through message properties), and metric reports (available
through applications or message details) provide information about the conditions present in
the servers running on specific managed nodes.

The WebSphere SPI configuration applications let you configure the management server’s
connection to selected server instances on specific managed nodes. After you configure the
connection, you can assign templates to the nodes. With HP Operations agent software
running on the managed nodes, you can use the WebSphere SPI reporting applications to
generate metric reports. In addition, you can generate graphs that show the WebSphere SPI
data (available through message properties).

Applications

The WebSphere SPI applications include configuration, troubleshooting, and
report-generating utilities. In the Application Bank window, the WebSphere SPI applications
are divided into the following groups:

e WBSSPI Admin
e  WebSphere
e  WBSSPI Reports

e JMX Metric Builder: This application group is available only if you install the SPIJMB
software bundle.

WBSSPI Admin Applications Group

WBSSPI Admin applications enable you to configure, control, and troubleshoot the
WebSphere SPI. You require root user permission to run WBSSPI Admin applications.

WebSphere SPI Concepis 17
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The WBSSPI Admin group contains the following applications (for more information, see
Appendix C, Applications):

e Configure WBSSPI- Launches the configuration editor and maintains the WebSphere
SPI configuration.

e Discover WebSphere— Sets basic configuration properties needed for discovery.

e Init Non-Root- Simplifies the configuration of a non-root HTTPS agent on a UNIX
managed node (OVO for UNIX 8.x only). For all the steps necessary to configure a
non-root HTTPS agent on a UNIX managed node, see Configuring a Non-Root HTTPS
Agent on a UNIX Managed Node (OVO for UNIX 8.x Only) on page 53.

e Self-Healing Info- Collects data that you can send to your HP support representative.

e Start Monitoring— Starts the collection of metrics for one application server or all
application servers on a managed node. Launch the Verify application to determine if
monitoring is started or stopped. By default, monitoring is on.

e Stop Monitoring— Stops the collection of metrics for one application server or all
application servers on a managed node.

e Start Tracing— Starts the collection of tracing information for selected metrics. Launch
this application only when instructed by your HP support representative.

e Stop Tracing— Stops tracing of the collections of metrics into a file. Run this application
only when instructed by your HP support representative.

e Verify— Verifies that the WebSphere SPI is properly installed on the server or managed
node.

e View Error File- Enables you to view the contents of the WebSphere SPI error log file.

e View Graphs- Enables you to view the WebSphere SPI graphs, generated by HP
Performance Manager, in a web browser (This requires additional setup. For more
information see Task 1: Configure the Management Server to Launch Your Web Browser
on page 37.

Chapter 1



WebSphere Application Group

You can manage WebSphere Server functions by using the applications in the WebSphere
Applications group.

To access the WebSphere applications double-click WBSSPI > WebSphere in the Application
Bank window.

= Avplication Group: WebSphere || ||

Check WehSphere Start Vieh Sphere Stop Web Sphere

opc_adm [Read—Write] Auto—Layout] [Connection Labels Off]

The WebSphere group contains the following applications:

¢ Check WebSphere— Does an interactive status check of selected WebSphere Application
Servers.

e Start WebSphere— Enables you to start one or all WebSphere Application Servers from
the HPOM console (requires setup).

e Stop WebSphere— Enables you to stop the WebSphere Application Servers from the
HPOM console (requires setup).

e View WebSphere Logs— Enables you to view the WebSphereApplication Server log files.

WABSSPI Reports

The WBSSPI Reports group contains reports that show information about WebSphere
conditions in the server.

You can generate a report about all WebSphere Servers configured on a managed node by
dragging the node to a report in the Application Bank window. Each report shows the status
of all the configured WebSphere Server instances on the managed node in relation to the
metric for which the report is generated.
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Application Group: WBS5P| Reports
Map Actions Edit Yiew Window

HJOECConn 1262_JOECConnPo 12635 JOECCon 1264 _JOECConr 1265 _JOECConn Pool Timeoul
r r r r

opc_adm [Read—¥rite] [Autu—Layuut]

Application Bank Reports Generated from Alarms

An alarm condition can generate a report. These reports are generated automatically and are
context sensitive, relating only to a single server on the managed node. These reports appear
within the Annotations section of a message.

If you configure the message browser to display the SULIAONE columns, a flag appears under
the S column (adjacent to the message) when a report is generated.
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JMX Metric Builder Applications

The JMX Metric Builder Applications group contains the following applications::
¢ Deploy UDM- Deploys the UDM file.

e Gather MBean Data— Collects MBean information to be used with the JMX Metric
Builder.

e JMX Metric Builder- Launches the JMX Metric Builder application that is used to
create UDMs and browse MBeans.

e  UDM Graph Enable/Disable— Starts/Stops data collection for UDM graphs. Also starts/
stops the HPOM subagent.

For more information about the JMX Metric Builder Applications group and steps to install
the SPIJMB software bundle, see the HP Operations Smart Plug-in for User Defined Metrics
User Guide.

WebSphere SPI Templates

The SPI for WebSphere template group contains templates grouped into three broad
categories:

e  WBSSPI-Templates-High Impact
e WBSSPI-Templates-Medium Impact
e WBSSPI-Templates-Low Impact

These are based on the impact that their data collections has on system performance. The
Low Impact group has only low impact metrics. The Medium Impact group has both medium
and low impact metrics. The High Impact group has all metrics: high, medium, and low
impact metrics. For complete listings of the specific metrics included in each group, see the
HP Operations Smart Plug-in for WebSphere Application Server Reference Guide.

All data collection affects performance in some way, with impact varying according to metric
(counter). The overhead cost associated with each WebSphere SPI metric is represented with
a rating of high, medium, or low. Metrics with medium or high ratings have higher
performance impacts. The calculations required for the collected data generally require
multiplication, division, or both. A metric with a low rating involves only a minor performance
cost since its calculation requires just a single addition or subtraction.

Under these broad categories, the following template groups are included: SPI for WebSphere
template group contains the following template groups and individual templates:

e  WBSSPI-Logfiles — Contains templates that generate messages based on log file and
error text detected in both the WebSphere Server log files and in the WebSphere SPI log
files. The information captured from these log files includes errors that occur in the
operation of the WebSphere Server or the WebSphere SPI and changes to WebSphere
Server configuration.

e  WBSSPI-Metrics — Contains metric templates that monitor the performance levels and
availability of a WebSphere Server.

Each metric template determines the threshold conditions for the monitored metric, the
message text that is sent to the HPOM message browser when the threshold is exceeded,
the actions to execute, and instructions that appear.
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WBSSPI-Schedule — Contains collector templates that specify the collection interval of
metric templates. Within the name of each collector template is its collection interval. For
example, the collection interval of template WBSSPI-40-High-1h is one hour (where 1h
represents one hour). Each collector template is assigned a collection interval of 5
minutes, 15 minutes, or one hour.

When you open any collector template, you see the metrics collected within the interval
(listed by number, following the -m option of the collector/analyzer command
wasspi wbs ca).

Each collector template controls when and what metrics are collected. Specifically, the
collector template does the following:

— Runs the collector/analyzer at each collection interval

— Specifies which metrics are collected

The SPI for WebSphere template group also contains the following individual templates:

WBSSPI-Messages — It intercepts WebSphere SPI messages for the HPOM message
browser.

WBSSPI Discovery — It updates the configuration on the HPOM management server
and managed nodes.

¥ Message Source Templates 1 [opc_adm]
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WebSphere Template Groups and System PMI Levels

When you deploy a template group on a managed node, the PMI level of the node is
automatically adjusted to that of the template group. For example, deploying the WebSphere
High Impact template group on a node would result in a PMI setting of “high” for the node.

) PMI levels, once set, do not automatically revert to lower impact levels, even after removing
templates from a node or deploying a lower impact level template group. To lower a PMI level
for a node, you must manually reset the PMI level within WebSphere.
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2 Installing, Upgrading, and Removing the
WebSphere SPI

Installing the WebSphere SPI

The HPOM management server and discovery package must be installed before you can
install the WebSphere SPI. It is not necessary to stop HPOM sessions before beginning the
WebSphere SPI installation.

The discovery package and WebSphere SPI are available on the HP Operations Smart
Plug-ins DVD.

For a complete list of software requirements, see the HP Smart Plug-in for WebSphere
Application Server Release Notes.

) The instructions that follow cover a command line swinstall installation. For HP-UX systems,
you can also use the graphical user interface (GUI).

) If you are going to create UDMs, you must also install the SPTIJMB software bundle. For more
information about this software bundle, see the HP Operations Smart Plug-in User Defined
Metrics User Guide.

For an HP-UX 11.23 and 11.31 (PA and TA) management server, type:
swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.depot WBSSPI

On a Solaris management server the packages are supported in both depot and solaris native
format.

For a Solaris management server in depot format, type:
swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot WBSSPI
For a Solaris management server in native format, perform the folowing steps:

1 Before installing the SPI software on the Solaris management server, set
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the
installation. Type:

PKG_NONABI_SYMLINKS=TRUE
export PKG_NONABI_SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the
HPOMSpiDVD-8.1.sparc package.

3 To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc
4  Select the following SPIs for installation:

e HPOvSpiWbs

25



26

e HPOvSpidmx
e  HPOvSpiShs

Removing the WebSphere SPI

Completely removing the WebSphere SPI installation deletes all WebSphere SPI components.
To remove the WebSphere SPI, complete the tasks in the following order:

e Task 1: Remove the WebSphere SPI Software from the Management Server

e Task 2: Remove WebSphere SPI Software from the Node Group and Managed Nodes

e Task 3: Delete WebSphere SPI Templates and Template Groups

e Task 4: Delete WebSphere SPI Applications

e Task 5: Delete the WebSphere SPI Message and Node Groups

e Task 6: Remove the WebSphere SPI Directory

e Task 7: Remove the Report Package (Optional)

e Task 8: Remove the Graph Package (Optional)
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Task 1: Remove the WebSphere SPI Software from the Management Server

1 Open a terminal window and log on as root.
2 In the terminal window:
e For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

/usr/sbin/swremove WBSSPIor
/usr/sbin/swremove SPIWebSphereAll

e For a Solaris management server, type:

/usr/sbin/pkgrm HPOvSpiWbs
/usr/sbin/swremove DSI2DDF
/usr/sbin/swremove SPI-SVCDISC-0OVO

The swremove or pkgrm command removes the files from the file system only. The
WebSphere SPI templates are still in the HPOM data repository and must be deleted
manually. Before the templates can be deleted, they (and the WebSphere SPI software) must
be de-assigned from the managed nodes.

Task 2: Remove WebSphere SPI Software from the Node Group and Managed
Nodes

1 Open the Node Bank and, from the Actions menu, select Agents - Assign Templates.

2 Select the WebSphere node group and all managed nodes to which WebSphere templates
were assigned.

3 Press the Remove nodes/groups button.
4 Open the Node Group Bank and select the WebSphere node groups.

5 From the Action menu click Install/Update SW & Config and select the following check
boxes:

e Templates

e Actions

¢ Monitors

e Commands
6  Select the Nodes in List option button.
7  Select the Force Update option button.

8 Click OK to remove the Templates, Actions, Commands, and Monitors from the managed
nodes. The following message is displayed in the message browser:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors
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Task 3: Delete WebSphere SPI Templates and Template Groups

Starting from the SPI for WebSphere template group, delete all templates and template
groups. Once these templates and template groups are deleted, delete the SPI for WebSphere
template group.

1

6

Open the Message Source Templates window and double-click the SPI for WebSphere
template group.

Press SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

Click Delete from All....
Click Yes in response to the message:
Do you really want to delete the template(s)?

If additional WebSphere SPI templates or template groups are in the SPI for WebSphere
template group, repeat steps 2 through 4 until you have deleted all WebSphere SPI
templates and template groups from the SPI for WebSphere template group.

Go up one level and delete the SPI for WebSphere template group.

) If you customized templates (copies of WebSphere SPI default templates) residing in other
HPOM template groups, remove them.

Task 4: Delete WebSphere SPI Applications

Unlike templates, applications can all be removed in a single step.

1
2
3

Task 5:

o A W N

Open the Application Bank.
Right-click the WBSSPI application group and click Delete.
Click Yes in response to the following message:

Do you really want to delete the application group?

Delete the WebSphere SPI Message and Node Groups

From the Window menu select Message Group Bank.

In the Message Group Bank window right-click the WBSSPI group and click Delete.
Repeat for the WebSphere group.

From the Window menu select Node Group Bank.

In the Node Group Bank window right-click the WebSphere (High, Low, and Medium)
node group and click Delete.

Task 6: Remove the WebSphere SPI Directory

1

From a command line, remove the WebSphere SPI directory by entering:

rm -rf /var/opt/OV/wasspi/wbs
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Task 7: Remove the Report Package (Optional)

If you installed the WebSphere SPI report package (on your Windows system running HP
Reporter), remove it:

1 On the Windows system running HP Reporter, from the Control Panel, double-click the
Add/Remove Programs icon.

2 Highlight the WebSphere SPI report package and click Remove.

Task 8: Remove the Graph Package (Optional)

If you installed the WebSphere SPI graph packages (on the HPOM management server and
on your system running HP Performance Manager), remove them.

On the HPOM management server, run the following command:
/usr/sbin/swremove WBSSPI-GRAPHS

On a Windows system running HP Performance Manager, follow these steps:

1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Select the WebSphere SPI graph package (HP Operations SPI for WebSphere Application
Server - Graphing Component Integration) and click Remove.

On an HP-UX system running HP Performance Manager that is not the HPOM management
server, follow these steps (if HP Performance Manager is installed on the HPOM management
server, the files are removed in

Task 1: Remove the WebSphere SPI Software from the Management Server on page 27):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

On a Solaris system running HP Performance Manager that is not the HPOM management
server, follow these steps (if HP Performance Manager is installed on the HPOM management
server, the files are removed in

Task 1: Remove the WebSphere SPI Software from the Management Server on page 27):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

Upgrading the WebSphere SPI

When you upgrade from a previous installation, all your configuration entries are preserved.
To upgrade the WebSphere SPI, follow these steps:

e Task 1: Remove WebSphere SPI Software from the Management Server

e Task 2: Delete WebSphere SPI Templates

e Task 3: Delete WebSphere SPI Applications

e Task 4: Upgrade the Management Server

e Task 5: Assign Operator Responsibilities

e Task 6: Assign Templates

e Task 7: Distribute Templates
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Task 8: Customize Templates

Task 9: Update WebSphere Log Template

Task 10: Move Nodes to New Node Group

Task 11: Delete Node Groups

Task 12: Distribute Actions, Monitors, Commands, and Templates on page 34
Task 13: Run the Discover WebSphere Application

Task 14: Install the New Report Package (Optional)

Task 15: Install the New Graph Package (Optional)

Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

Task 1: Remove WebSphere SPI Software from the Management Server

1
2

Open a terminal window and log on as root.
In the terminal window:
e For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:

/usr/sbin/swremove WBSSPI
/usr/sbin/swremove WBSSPI-GRAPHS

e For a Solaris management server in depot format, type:

/usr/sbin/swremove WBSSPI
/usr/sbin/swremove WBSSPI-GRAPHS

e For a Solaris management server in native format, type:

/usr/sbin/pkgrm HPOvSpiWbs

Task 2: Delete WebSphere SPI Templates

Delete all WebSphere SPI templates and template groups that appear under the SPI for
WebSphere template group and the SPI for WebSphere template group itself. If you
customized any of the default templates, note these changes (these customizations are not
saved).

1

6

Open the Message Source Templates window and double-click the SPI for WebSphere
template group

Press SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

Click the Delete from All... button.
Click YES in response to the message:
Do you really want to delete the template(s)?

Repeat steps 2 through 4 until you have deleted all WebSphere SPI templates and
template groups from the SPI for WebSphere template group.

Go up one level and delete the SPI for WebSphere template group.

) If you customized templates (copies of WebSphere SPI default templates) residing in other
HPOM template groups, remove them.
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Task 3: Delete WebSphere SPI Applications

Unlike templates, all WebSphere SPI applications can be removed in a single step.
1 Open the Application Bank.

2 Right-click the WBSSPI application group and click Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

Task 4: Upgrade the Management Server

The WebSphere SPI software is available on the HP Operations Smart Plug-ins DVD.

The following instructions that follow show the command line usage of swinstall. For HP-UX
systems, you can also use the graphical user interface (GUI).

For an HP-UX 11.23 and 11.31 (PA and IA) management server, type:
swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.depot WBSSPI

On a Solaris management server the packages are supported in both depot and solaris native
format.

For a Solaris management server in depot format, type:
swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot WBSSPI
For a Solaris management server in native format, perform the folowing steps:

1 Before upgrading the SPI software on the Solaris management server, set
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the
installation. Type:

PKG_NONABI_ SYMLINKS=TRUE
export PKG_NONABI_ SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the
HPOMSpiDVD-8.1.sparc package.

3 To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc
4 Select the following SPIs for upgrading:

e HPOvSpiWbs

e HPOvSpidmx

e  HPOvSpiShs

Task 5: Assign Operator Responsibilities

1 Log on to HPOM as administrator (opc_adm).
2 Open the User Bank window, right-click the opc_adm user, and click Modify.

3 Click Responsibilities in the Modify User:opc_adm user window.
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5
6

For WBSSPI and WebSphere Message Groups, ensure all check boxes are selected.
Assign the WBSSPI Node or Message Groups to any other appropriate operators.
Click Close.

Task 6: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:

1
2

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Assign Templates. The Define Configuration
window opens.

Click Add. The Add Configuration window opens.
Click Open Template Window. The Message Source Templates window opens.

From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

From the Add Configuration window, click Get Template Selections. The
WBSSPI-Messages and WBSSPI-Discovery templates appear in the right pane.

From the Add Configuration window, click OK.

Task 7: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

1

o O A WN

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select Nodes in List Requiring Update.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

The following message is displayed in the message browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.

Task 8: Customize Templates

If you noted any customizations in Task 2: Delete WebSphere SPI Templates on page 30,
make a copy of the default templates, and then make these same customizations to the copies.
In this version of the WebSphere SPI, the templates are no longer grouped by WebSphere
version numbers.

32
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Task 9: Update WebSphere Log Template

Update the audit, deprecated, and informational suppress conditions for the WebSphere Log

Template:

1 From the Message Source Templates window, open the SPI for WebSphere template
group.

2 Select a WBSSPI-Templates impact group (High, Low, and Medium) and follow these
steps:

a Open the impact group.
b  Open the WBSSPI-Logfiles group.
¢ Select the WebSphere Log Template and click Conditions.

d Move the Audit, Deprecated, and Informational conditions to the top of the list.
Message and Suppress Conditions

are Log Template

Audit
Deprecated
Informational

Fatal

e Click Close.

Task 10: Move Nodes to New Node Group

Move all managed nodes that are in the SPI for WebSphere node groups to the new
WebSphere node group.

1 Open the Node Bank and select the SPI for WebSphere node group.

2 Double-click each subgroup in the WebSphere 4.0 node group and note the managed nodes
in it.
Go back to the top level of the node bank (where the WebSphere node group is displayed).

4 Drag and drop, or copy and paste, the nodes (noted in step 2) from the IP submap to the
appropriate WebSphere node group.
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Task 11: Delete Node Groups

Delete all versioned node groups that are in the SPI for WebSphere node group (WebSphere
4.0).

1
2
3

Task 12

Open the Node Bank and select the SPI for WebSphere node group.
Select the WebSphere 4.0 and, from the Edit menu, click Delete.
Click Yes in response to the following message:

Do you really want to delete the node group?

: Distribute Actions, Monitors, Commands, and Templates

At the HPOM console, in the Node Bank window, select the nodes or node group on which
to install the WebSphere SPI.

From the Node Bank’s Actions menu select Agents = Install/lUpdate SW & Config.

In the Install/Update HPOM Software and Configuration window select the following
component check boxes:

e Templates

e Actions

¢ Monitors

e Commands

Using this dialog, deploy updated components to the managed nodes.
Check the Force Update check box.

Select the Nodes in list button. Upon completion, the following message and appears in
the message browser for each managed node:

The following configuration information was successfully distributed:
Actions Commands Monitors Templates.

) You might see some WebSphere SPI errors in the message browser which you can ignore
(these errors are the result of the transition to the updated programs). WebSphere SPI
templates/programs are updated on the Management Server and selected managed nodes.
These errors are resolved when the upgrade is complete.

Task 13: Run the Discover WebSphere Application

You must run the Discover WebSphere application but there is no need to re-enter any of the
WebSphere SPI configuration data (all configuration data is preserved). To re-deploy the file,
you can drag and drop multiple nodes, node groups, or single nodes. When you re-deploy the
file, relevant information is updated, transmitted, and stored on the node.

1
2
3

At the HPOM console, select the nodes in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI - WBSSPI Admin — Discover WebSphere.
(If the items do not appear, select Map = Reload.). The Introduction window opens.
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4 Click Next. A second Introduction window opens. This window displays information about
which properties might be required in order for the discovery process to work.

5 Read this information and click Next.

6  Modify the configuration using configuration editor.

’ If you set the GRAPH_SERVER property, note that this property is no longer
supported in the WebSphere SPI. Instead, set the GRAPH_URL property.

’ If you set the UDM_DEFINITIONS_FILE property, note that this property is not
to be supported in future versions of the WebSphere SPI. Note the locations of the
UDM files on your managed nodes and delete any occurrence of the
UDM_DEFINITIONS_FILE property from your configuration.

If you individually configured UDMs on your managed nodes, you must configure these

UDMs on the management server in the /opt/0V/wasspi/wbs/conf/
wasspl wbs udmDefnintions.xml file (or, set the UDM_DEFINITIONS_SOURCE
property to use another file).

Once you have consolidated your UDMs on the management server, delete your old UDM
files from the managed nodes and distribute the new UDM file to the managed nodes
using the Deploy UDM application.

7 Click Next to save any changes and exit the editor.
8 The Confirm Operation window opens. Click OK.

) If you click Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discover WebSphere application, click Next from the configuration editor, and then click OK.

) Do not close the Discover WebSphere application window until the discovery process
completes. The discovery process might take several minutes to complete.

Task 14: Install the New Report Package (Optional)

If you installed an older version of the WebSphere SPI report package (on your Windows
system running Reporter), you must uninstall it and install the new WebSphere SPI report
package.

1 On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

2 Highlight the WebSphere SPI report package and click Remove.

3 Follow the steps to install the WebSphere SPI report package in Integrating with HP
Reporter on page 83.

Your upgrade is now complete.
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Task 15: Install the New Graph Package (Optional)

If you installed an older version of the WebSphere SPI graph package (on your system
running HP Performance Manager), you must uninstall it and install the new WebSphere SPI
graph package.

On a Windows system running HP Performance Manager, follow these steps:
1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Highlight the WebSphere SPI graph package (HP Operations SPI for WebSphere
Application Server - Graphing Component Integration) and click Remove.

3 Follow the steps to install the WebSphere SPI report package in Integrating with HP
Performance Manager on page 87.

On an HP-UX system running HP Performance Manager that is not the HPOM management
server, follow these steps (if HP Performance Manager is installed on the HPOM management
server, the files are automatically updated when you install the SPI software):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

3 Follow the steps to install the WebSphere SPI graph package in Integrating with HP
Performance Manager on page 87.

On a Solaris system running HP Performance Manager that is not the HPOM management
server, follow these steps (if HP Performance Manager is installed on the HPOM management
server, the files are automatically updated when you install the SPI software):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

3 Follow the steps to install the WebSphere SPI graph package in Integrating with HP
Performance Manager on page 87.

Your upgrade is now complete.

Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node, see
Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO for UNIX 8.x Only) on
page 53.
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3 Configuring the WebSphere SPI

To successfully configure the WebSphere SPI, you must complete all configuration
prerequisites, WebSphere SPI configuration for managed nodes and the management server,
and additional configuration based on your environment.

Configuration Prerequisites

On the HPOM management server, complete the following tasks before configuring
WebSphere SPI:

e Task 1: Configure the Management Server to Launch Your Web Browser
e Task 2: Assign Operator Responsibilities for opc_adm

e Task 3: Assign Templates

e Task 4: Distribute Templates

Task 1: Configure the Management Server to Launch Your Web Browser

The WebSphere SPI uses the ovweb utility to start your web browser for displaying graphed
metrics (which requires HP Performance Manager). If you do not use HP Performance
Manager, skip this task.

1  Enter the browser invocation command in the ovweb. conf file. If no browser invocation
command is included in the ovweb. conf file, ovweb tries to start the default browser.

) ovweb. conf file must be located in the directory specified by the environment variable
$0V_CONF (used by HPOM). To find the HPOM directory structure on your management
server, open the /opt/OV/bin/ov.envvars. sh file and look for the $0V_CONF definition.

The browser invocation command must contain a %s to allow WebSphere SPI to pass a
URL to the browser. Open the file and insert the command according to the entry syntax
and example as follows:

Syntax: Browser: <browser command> %s
Check the web browser setting. To display the WebSphere SPI graphs, ensure that your
browser is JavaScript enabled. Check the setting within the browser’s Preferences.

2 In Task 3: Launch Discover WebSphere on page 47, if you are using HP Performance
Manager, set the GRAPH_URL property.

For more information about launching a browser in HPOM, consult the man pages for ovweb,
ovweb.conf, and ov.envvars. To access instructions for enabling graph displays, at a
command prompt enter: man ovweb
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Task 2: Assign Operator Responsibilities for opc_adm

1 Log on to HPOM as administrator (opc_adm).
Open the User Bank window, right-click the opc_adm user, and select Modify.

Click Responsibilities in the Modify User:opc_adm user window.

AN w0 N

For WBSSPI and WebSphere Message Groups, ensure all boxes are checked.

i1 Responsibilities for Operator [opc_adm]

5 Assign the WBSSPI Node or Message Groups to any other appropriate operators.

6 Click Close.

Task 3: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:

1 Open the Node Bank window and highlight the management server.
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2 From the Actions menu, select Agents > Assign Templates. The Define Configuration
window opens.

ixi Define Configuration =10l =1

3 Click Add. The Add Configuration window opens.

ixi Add Configuration
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4 Click Open Template Window. The Message Source Templates window opens.

il Message Source Templates 1 [opc_adm] =181l

5 From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

6 From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

7 From the Add Configuration window, click Get Template Selections. The
WBSSPI-Discovery and WBSSPI-Messages templates appear in the right pane.

ixi Add Configuration =gz

8 In the Add Configuration window, click OK.

Task 4: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

1 Open the Node Bank window and highlight the management server.

2 From the Actions menu, select Agents = Install/Update SW & Config.

3 In the Target Nodes section, select Nodes in List Requiring Update.

4 In the Install/Update Software and Configuration window check the Templates check box.
5 Select Force Update.
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6 Click OK.
The following message is displayed in the message browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.
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WebSphere SPI Configuration for Managed Nodes

To configure WebSphere SPI, complete the following tasks for each managed node:
e Task 1: Verify the Application Server Status

e Task 2: Collect WebSphere Login Information

e Task 3: Enable PMI

e Task 4: Connect using JSR 160

e Task 5: Update WebSphere’s SDK

Task 1: Verity the Application Server Status

Verify that your application servers are running. For WebSphere Server version 4, check the
server’s status from the WebSphere administrative console. Under the General tab, a colored
marker appears next to the Application Server name. A green marker means the server is
running. A red marker means the server is not running.

WebSphere Advanced Administrative Console

= R 5 i |

I lebSphere Administrative Domain
£ Yirtual Hosts =
— B3 Server Groups A0 Installed Meb Modules

=} B2 Modes
E|- dukat
3 Application Servers

a [Default Serwer

[ Generic Servers

E: (3 Enterprize Applications Default Serw
g

3 Resources

/opt/lebSphere/AppServersbin

E 1716703 10:.., Console Ready,

For WebSphere Server version 5 and above, check the server’s status from the WebSphere
administrative console.
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If you cannot verify the server’s status using the administrative console, run the following
commands on the managed node:

e UNIX: <WebSphere_Install_Dir>/bin/serverStatus.sh -all
For example: /opt/WebSphere/AppServer/bin/serverStatus.sh -all
e  Windows: <WebSphere_Install_Dir>\bin\serverStatus.bat -all

For example: C: \Program Files\WebSphere\AppServer\bin\serverStatus.bat
-all

Task 2: Collect WebSphere Login Information

If security is enabled on the WebSphere Server, collect the username and password for each
WebSphere Admin Server. The user must have the local WebSphere administrator privileges
assigned for the WebSphere Admin Server.

The username and password are needed by the WebSphere SPI discovery process to gather
basic configuration information and by the WebSphere SPI data collector to collect metrics.

Configuration of WebSphere SPI is simplified if the same username and password are used by
each WebSphere Admin Server.

If you are using WebSphere version 5.1.0 or earlier, you must use the default WebSphere
Admin Server username and password (the username and password configured when the
WebSphere application server was installed/configured).

If you are using WebSphere version 5.1.1 or later, you should be able to use the username and
password for users/groups assigned to the administrator or operator role.

If you are using LDAP directory, to access the WebSphere Console from LDAP, you must
create a user account similar to the user account of LDAP in the local WebSphere instance.
You must grant Administrator privileges to this user.
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Task 3: Enable PMI

If you are running WebSphere Server version 5, enable PMI using the WebSphere
administrative console and restart the server. For more information, see http:/
publib.boulder.ibm.com/infocenter/ws51help/index.jsp?topic=/
com.ibm.websphere.base.doc/info/aes/ae/tprf_prfstartadmin.html.

PMI is necessary for collecting metrics.

Task 4: Connect using JSR 160

You can configure the WebSphere Application Server 6.1 or later to use JSR 160 connection to
connect to the WebSphere Application Server. By default, the JSR 160 connection is disabled.

To enable JSR 160 connection set the JSR160 flag in the SPI Config file to true. By
default, this flag is set to false. The SPIConfig file is present in the <AgentDir>/conf/
wbsspi directory.

) If you use JSR 160 to connect to WebSphere Application Server 6.1 or later, the application
server can run in “security enabled” or “security disabled” mode. In the “security disabled”
mode the collector can run in both Transient and Persistent mode, but in the “security
enabled” mode the collector can only run in the Transient mode. To set the collector in
Transient mode, add a line—- COLLECTOR_MODE=TRANSIENT at the end of the
SPIConfig file.

If you are using WebSphere Application Server 6.1 or later, before starting the collector you
must set the following values for the attributes in the <WebSphere_HOME>/profiles/
<profile_name>/properties/sas.client.props file. Set these values for all the profiles
that you want to monitor.

e Set the value of 1oginSource attribute to properties (the default value is prompt).
com. ibm.CORBA.loginSource=properties

e Set the value of 1oginUserid attribute to the WebSphere admin user id and
loginPassword attribute to the WebSphere admin password:

com. ibm.CORBA. loginUserid=<admin_user>
com. ibm.CORBA. loginPassword=<admin_password>

If you do not update the sas.client.props file, the collector will fail.

) After updating the sas.client.props file, you must restart the WebSphere Application
Server, if it is running.

Task 5: Update WebSphere’s SDK

For WebSphere Application Server 6.1 running on Windows nodes, you must update IBM
Java SDK 1.5 to level SR4 or later (Java SDK 1.5 SR4 or later) or the collector may fail.

You can download Java SDK 1.5 SR4 or later from http:/www-1.ibm.com.
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WebSphere SPI Configuration from the Management Server

To configure WebSphere SPI, from the management server, complete the following tasks:

Task 1: Assign the WBSSPI-Messages Template

Task 2: Distribute Templates, Actions, Monitors, and Commands
Task 3: Launch Discover WebSphere

Task 4: Verify the Discovery Process

Task 5: Add Nodes to a WebSphere SPI Node Group

Task 6: Distribute WebSphere SPI Templates

Task 7: Complete Configuration

Task 8: Run the Verify Application

Task 1: Assign the WBSSPI-Messages Template

Assign the WBSSPI-Messages template to the managed nodes:

1
2

i1 Define Configuration

Open the Node Bank window and highlight the managed nodes.

From the Actions menu, select Agents - Assign Templates. The Define Configuration
window opens.

Configuring the WebSphere SPI

45



3 Click Add. The Add Configuration window opens.

4  Click Open Template Window. The Message Source Templates window opens.

iXi Message Source Templates 1 [opc_adm] 1Ol x|

5 In the Template Groups pane, select the SPI for WebSphere template group.
6 In the Type and Name pane, select the WBSSPI-Messages template.
7 From the Add Configuration window, click Get Template Selections. The

WBSSPI-Messages template appears in the right pane.
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8 Click OK.

Task 2: Distribute Templates, Actions, Monitors, and Commands

1 Highlight the managed nodes on which to install the SPI components.
2 From the Node Bank window’s Actions menu select Agents - Install/Update SW & Config.

3 In the Install/Update OVO Software and Configuration window select the following
component check boxes:

e Templates
e Actions
e  Monitors

e Commands

Using this dialog, you deploy program components to the managed nodes.

| Install / Update OYD Software and Configuration

4  Select the Force Update check box.
5 Select the Nodes in list option button.
6 Click OK.

Upon completion, the following message appears in the message browser for each managed
node:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

The WebSphere SPI is now installed on the management server and selected managed nodes.
If you want to install the WebSphere SPI on other managed nodes, repeat these steps.

Task 3: Launch Discover WebSphere

1 At the HPOM console, highlight the nodes in the Node Bank window.

2 From the Window menu, select Application Bank.
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From the Application Bank window select WBSSPI - WBSSPI Admin and double-click
Discover WebSphere. (If the above does not appear as described, select Map = Reload.) The
Introduction window opens. This window contains brief information about the Discovery
application.

Click Next. A second Introduction window opens. This window displays information about
which properties might be required in order for the discovery process to work.

Read this information and click Next.

If you already set the LOGIN and PASSWORD properties, the configuration editor opens.
Go to the next step.

If you have not set the LOGIN and PASSWORD properties, the Set Access Info for
Default Properties window opens.

|

Pleaze enter the Login and Pazsword information,
Thiz information iz required by the SPI to access a secured

application server’s environment,

Login |

Fazzword |

Verify Password |

Customize Next | Cancel |

If security is not enabled on the application server, leave these fields blank, click Next, and
go to step 9.

If security is enabled on the application server, the WebSphere Admin Server login
information is required. Enter the username and password collected in Task 2: Collect
WebSphere Login Information on page 43. The LOGIN and PASSWORD properties are
set to this information.

The LOGIN and PASSWORD properties set in this window are used as the default
WebSphere Admin Server login and password (they are set at the global properties level).
That is, if no NODE level or server-specific LOGIN and PASSWORD properties are set,
this WebSphere login and password are used by the WebSphere SPI to log on to all
WebSphere Admin Servers. For more information about the configuration structure, see
Structure on page 147.

If the WebSphere Admin Server login and password are the same for all
WebSphere application servers on all HPOM managed nodes, follow these steps:

a Set the LOGIN and PASSWORD properties in the Set Access Info for Default
Properties window.

b Click Next.
¢ Gotostep9.

Chapter 3



If the WebSphere Admin Server login and password are different for different
instances of WebSphere, you must customize the WebSphere SPI configuration by
setting the LOGIN and PASSWORD properties at the NODE or server-specific level (for
more information about the configuration structure, see Structure on page 147):

a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere
login and password in the Set Access Info for Default Properties window.

b  Click Customize to open the configuration editor.

7 From the configuration editor, set the configuration properties. For more information
about using the configuration editor, see Appendix B, The Configuration.

8 Click Next to save any changes and exit the editor.

9 The Confirm Operation window opens. Verify the nodes on which the operation is to be
performed. Click OK.

) If you click Cancel and made changes to the configuration, those changes remain in
the configuration on the management server. To make the changes to the selected
managed nodes’ configuration, you must select those nodes in the Node Bank
window, start the Discover WebSphere application, click Next from the
configuration editor, and then click OK.

’ Wait for the discovery process to complete before going to the next task. The
discovery process might take several minutes to complete.

Task 4: Verify the Discovery Process

1 Verify that the following messages appear in the Discover WebSphere application window
(the Discover WebSphere application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the Discover WebSphere application does not complete successfully, the following
message appears in the application window:

Failed to run discovery on node <node>

For information on troubleshooting the discovery process, see Troubleshooting the
Discovery Process on page 103.

2 Verify that the following message appears in the message browser for each managed node:

WASSPI-602- Updating the WBSSPI configuration data with discovered
information

Depending on the number of managed nodes in your environment, it might take several
minutes for these messages to display for all managed nodes.

3 IfService Navigator is already running, select File > Reload Configurations. In the Services
tree, open the Application node and look for the WebSphere service.

4 Run the Configure WBSSPI application to verify the properties set by the discovery process.
See Configure WBSSPI on page 172.

If you are having problems with the discovery process, see Troubleshooting the Discovery
Process on page 103.
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Task 5: Add Nodes to a WebSphere SPI Node Group

The WebSphere SPI automatically creates three node groups that are assigned the matching
WebSphere High, Medium, or Low template group:

e  WebSphere High
e  WebSphere Medium
e WebSphere Low

When you assign a managed node to a WebSphere SPI node group, you are also assigning the
templates you want to deploy on the node.

When data collection for the template group begins, the PMI level of the node is adjusted as
necessary to comply with the template group’s impact level. For example, data collection for a
WebSphere High Impact group results in a PMI level adjustment to high for the node if the
WebSphere PMI level is currently not at high. For more information, see WebSphere
Template Groups and System PMI Levels on page 23.

The High template group contains all WebSphere SPI metrics, while the Medium group
contains Medium and Low metrics, and the Low group contains only Low metrics.

To add nodes to a WebSphere SPI node group, follow these steps:

1 From the Window menu, open both the Node Group Bank and the Node Bank to display
(side-by-side) the WebSphere SPI node group and the managed nodes.

2 Drag and drop managed nodes running a WebSphere Server into the appropriate
WebSphere SPI node group, according to the PMI level desired for the node.

Task 6: Distribute WebSphere SPI Templates

>»

1 Open the Node Group Bank window and highlight a WebSphere SPI node group.

From the Actions menu, select Agents — Install/Update SW & Config.

In the Target Nodes section, select the Nodes in List Requiring Update radio button.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

o O A WN

The following message is displayed in the message browser:

The following configuration information was successfully distributed:
Templates

The WebSphere SPI templates are now distributed to the selected node group. WebSphere
SPI monitors now begin running according to their specific collection interval.

If you use HP Reporter, see Integrating HP Reporting and Graphing Products with the
WebSphere SPI.

Task 7: Complete Configuration

The configuration information on the management server and managed nodes must be
updated. You can do either of the following:
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e Wait 10 minutes for the automatic configuration template to run.

or

¢ Run the Configure WBSSPI application (which updates the configuration information on
the management server and managed nodes). See Configure WBSSPI on page 172.

Task 8: Run the Verity Application

Run the Verify application to verify that WebSphere SPI is properly installed and configured

See Verify on page 178.

1 At the HPOM console, select a WebSphere node group in the Node Group Bank window.

2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click Verify.

Additional WebSphere SPI Configuration

Based on your WebSphere Server configuration and application needs, you must finish
WebSphere SPI configuration by setting additional configuration properties or installing and
configuring additional components. Setting additional properties and configuring additional
components depends on your environment.

Conditional Properties

Based on your WebSphere configuration and application needs, you might need to set one or
more conditional properties. If you meet a condition, set the properties listed to the left of the
condition (these properties are not automatically discovered by the discovery process). For
more information about the properties, see Configuration Properties on page 159.

Table 1 Conditional Properties

Conditional Property

When Required

ALIAS

Required if more than one application server on a system
shares the same server name. The discovery process
automatically sets the ALIAS property, but you might want to
edit this value because this is the name used in messages,
reports, and graphs.

COLLECT_METADATA

Required if you want to use MBean information in the JMX
Metric Builder application to create UDMs.

JAVA_HOME

The value of JAVA_ HOME must include the path to
JAVA .EXE (path to the bin directory of Java) and not the path
to the actual JAVA_ HOME directory.

Required if:

¢ You are using a Java version not supplied with the
WebSphere Server.

e There are multiple Java installation directories.
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Table 1l Conditional Properties

Conditional Property When Required

ADDRESS Required if a WebSphere Server is configured to a virtual IP
address or is on a remote node.

START_CMD, Required if you want to start and stop a WebSphere

STOP_CMD, and application server from the HPOM console.

USER

LOGIN and Required if security is enabled on a WebSphere Server.

PASSWORD

MAX_ERROR_LOG_SIZE | Required if you want an error logfile larger than 2 MB.

Setting Conditional Properties

1 At the HPOM console, select the nodes in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin - Configure WBSSPI. (If
the items do not appear, select Map - Reload.)

The Introduction window opens.
4 Click Next.

5 From the configuration editor, set the properties. For information on using the
configuration editor, see The Configuration Editor on page 149.

6 Optionally, click Save to save any changes made to the configuration. Once you save your
changes, you cannot automatically undo them.

7  Click Finish or Next to save any changes and exit the editor.
If you click Next, the Confirm Operation window opens. Click OK.

) If you click Cancel and make changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Configure WBSSPI application, click Next from the configuration editor, and then click OK.

8 Ifyou added an application server or added/edited the HOME or PORT properties, run
the Discover WebSphere application on the managed nodes on which the application
server/properties were added or edited. Running the Discover WebSphere application
updates the Service Navigator map.
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Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO for
UNIX 8.x Only)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node
(OVO for UNIX 8.x only), follow these steps:

) You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo
is free software available from http:/www.sudo.ws. The OS-dependent software packages
are located at the bottom of the download page (http:/www.sudo.ws/sudo/
download.html). For more installation information, see the HP Operations Smart Plug-in
for IBM WebSphere Application Server Release Notes.

1 Switch the HTTPS agent to a non-root user. For more information, see the HTTPS Agent
Concepts and Configuration Guide.

2 On the managed node, set the OV_SUDO variable. As root or with HP Operations agent
user privileges, follow these steps:

a Stop all HP Operations agents. Run the following command:
opcagt -kill

b Set the OV_SUDO variable. Run the following command:
ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

In this instance, <sudo_program> is the location (including the absolute pathname)
where sudo is installed (for example, /usr/local/bin/sudo).

c¢ Start the HP Operations agents. Run the following command:
opcagt -start

d Verify OV_SUDO is set. Run the following command:
ovdeploy -cmd set | grep SUDO
The following displayed:
OV _SUDO=<sudo_program>

3 Configure the managed node. These steps MUST be completed to successfully run the SPI
in a non-root HTTPS agent environment.

a From the HPOM management server, deploy actions, commands, and monitors to the
managed node.

b Select the node in the Node Bank window.

¢ From the Application Bank window, select WBSSPI - WBSSPI Admin - Init Non-Root.
4 Edit the /etc/sudoers file using the visudo editor (installed with sudo):

a On the managed node, log in as root.

b Open the /<SPI_Config_DIR>/wasspi_wbs sudoers file

In this instance, <SPI_Config_DIR> is the location of the SPI’s configuration files on a
managed node. See Managed Node File Locations on page 145.

¢ In a separate window, run the visudo command (for example, type:
/usr/local/sbin/visudo).

d From the wasspi wbs_ sudoers file, copy, and append the following lines to the
sudoers file:
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Cmnd Alias WBSSPI ADMN = /opt/OV/nonOV/perl/a/bin/perl -S
wasspi wbs admin *

Cmnd Alias WBSSPI COLL = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wbs ca
*

Cmnd Alias WBSSPI DISC = /opt/OV/nonOV/perl/a/bin/perl
wasspi wbs discovery.pl

Cmnd Alias WBSSPI LFEN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wbs le
*

Cmnd Alias WBSSPI SHSC = /opt/OV/nonOV/perl/a/bin/perl -S

shs collector.pl *

Cmnd Alias WBSSPI ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wbs admin *

Cmnd Alias WBSSPI COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wbs ca *

Cmnd Alias WBSSPI DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/OV/bin/instrumentation/wasspi wbs discovery.pl

Cmnd Alias WBSSPI LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wbs le *

Cmnd Alias WBSSPI SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs collector.pl *

<OV_Agent username> <nodename> = NOPASSWD: WBSSPI ADMN, WBSSPI COLL, \
WBSSPT DISC, WBSSPI LFEN, WBSSPI SHSC, WBSSPI ADMNP, WBSSPI COLLP, \
WBSSPI DISCP, WBSSPI LFENP, WBSSPI SHSCP

In this instance, <OV_Agent_username> is the HP Operations agent user account and
<nodename> is the name of the managed node.

e Save the file and exit the visudo editor. Type :wgq
) Steps 3 and 4 must be performed every time the agent user is switched.
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The WebSphere SPI in High Availability Environments

High availability is a general term used to characterize environments that are business
critical and therefore are protected against downtime through redundant resources. Very
often, cluster systems are used to reach high availability.

You can configure the WebSphere SPI to accommodate cluster environments where failovers
allow uninterrupted availability of WebSphere Application Servers. WebSphere SPI
monitoring, when synchronized with the cluster environment, can switch off from the failed
node to the active node.

Configuration Prerequisites

The prerequisites for using the WebSphere SPI in high availability environments are:
e Management Server: HP-UX
e Node: HP-UX MCSG cluster

e OVO for UNIX 8.x HTTPS Agent version (for details, see the Agent cluster support
matrix.)

Configuring the WebSphere SPI for High Availability Environments
To configure WebSphere SPI for use in high availability environments complete the following
tasks:
e Task 1: Create the WebSphere SPI Monitoring Configuration File
e Task 2: Create the Clustered Application Configuration File
e Task 3: Configure the WebSphere SPI

Task 1: Create the WebSphere SPI Monitoring Configuration File
WebSphere SPI uses a monitoring configuration file <appl name>.apm.xml that works in
conjunction with the clustered application configuration file.

) <appl name>is the namespace_name. For more information, see the HP Operations for
UNIX HTTPS Agent Concepts and Configuration Guide.

The <appl name>.apm.xml file lists all the WebSphere SPI templates on the managed node
so that you can disable/enable these templates as appropriate, for inactive/active managed
nodes.

To create this clustered application configuration file for your WBS environment, follow these
steps:

1 Use the following syntax to create the <appl name>.apm.xml file:

<?xml version="1.0"?>
<APMApplicationConfiguration>

<Application>
<Name> ... </Name>
<Template> ... </Template>

<StartCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
startMonitor $instance</StartCommand>
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<StopCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
stopMonitor $instance</StopCommand>
</Rpplication>
</APMApplicationConfiguration>

2 Enter application namespace under the <Name></Name> tag.

3 After the file is created save it in the $OvDataDir/bin/instrumentation/conf
directory.

If there is only one WBS server running on the node, you must mention A/l under the
<template> tag.

Sample <appl_name>.apm.xml file

<?xml version="1.0"?>
<APMApplicationConfiguration>

<Application>
<Name>namespace name</Name>
<Template>All</Template>
<StartCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
startMonitor $instance</StartCommand>
<StopCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
stopMonitor $instance</StopCommand>

</Rpplication>

</APMApplicationConfiguration>

) <appl name>.apm.xml is dependent on the application namespace. It is not
dependent on the instance level. Therefore, the start and stop actions are provided
with the associated instance name as their first parameter when they are executed
at package switch time. The environment variable $instanceName is set by C1Aw
when start or stop tasks are performed.

Task 2: Create the Clustered Application Configuration File

The clustered application configuration file apminfo.xml, working in conjunction with the
<appl name>.apm.xnl file of WebSphere SPI, enables you to associate WebSphere SPI
monitored instances with cluster resource groups. As a result, when you move a resource
group from one node to another, in the same cluster, monitoring stops on the failed node and
starts on the new node.

To create the clustered application configuration file apminfo.xml, follow these steps:
1 Use a text editor to create the file. The syntax is:

<?xml version="1.0" ?>
<APMClusterConfiguration>
<Application>
<Name>namespace name</Name>
<Instance>
<Name><Instance Name></Name>
<Package><Package Name></Package>
</Instance>
<Application>
</APMClusterConfiguration>
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2 Enter namespace_name under the <Name></Name> tag.

3 Save the apminfo.xml file to the $OvDataDir/conf/conf directory.

Sample apminfo.xml file

<?xml version="1.0" ?>
<APMClusterConfiguration>

<Application>
<Name>namespace name</Name>
<Instance>
<Name>instance name</Name>
<Package>test</Package>
</Instance>
</Application>

</APMClusterConfiguration>

Task 3: Configure the WebSphere SPI

To configure the WebSphere SPI, follow these steps:

1 Launch the Discover WebSphere application with virtual node as the target. For details
about launching the discovery application, see Task 3: Launch Discover WebSphere on
page 47.

2 Launch the Configure WBSSPI application with the virtual node as the target. The
configuration editor opens.

3 Use the configuration editor to set the following properties (these properties are in
addition to the ones discovered by the Discover WebSphere application) :

e CLUSTERNAMESPACE
e CLUSTERINSTANCE

These properties should have the same value as defined in apminfo.xml file. For
example, CLUSTERNAMESPACE property must be set to namespace name and
CLUSTERINSTANCE must be set to instance name.

4 Copy the SiteConfig file from active node to passive node. The file is located in the
S$OvDataDir/conf/wasspi directory.

5 Set the value of ADMIN_HOST property to the name of the managed node that was
activated because of failover.
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WebSphere SPI Discovery in Cluster Environment

The WebSphere SPI can now monitor the WebSphere Application Servers through the
Deployment Manager in a Network Deployer scenario. This is applicable from WebSphere
Application Server version 6.1 and above.

Deployment Manager

The Deployment Manager acts as an intermediate manager for the WebSphere Application
Servers running on various nodes.

The Deployment Manager manages and collects information about WebSphere Application
Servers through node agents. Node Agents are servers that gather information from the
WebSphere Application Servers and pass it to the Deployment Managers.

The Deployment Manager also provides basic clustering and caching support, including
failover support and workload balancing.

The logical unit comprising of one Deployment Manager monitoring several application
servers through a set of node agents is called a Cell.

A typical distributed network deployer scenario appears as following:

8!
AN
g 5§ S

Legend

a Deployment Manager

b Node Agent

c Systems on which WebSphere Application Servers are running

Chapfer 3



WebSphere SPI Discovery in the Network Deployer Scenario

In the classic scenario, the discovery process discovers all systems running WebSphere
Application Server and populates the SiteConfig file with information about all discovered
nodes.

However, in a distributed Network Deployer secenario, the WebSphere SPI discovery process
performs the following functions:

e Discovers only the Deployment Managers and populates the SiteConfig file on the
HPOM management server with information about the Deployment Managers. The
WebSphere SPI instrumentation files and templates are deployed only on the Deployment
Managers.

e The WebSphere SPI creates a DistributedServerConfig file on the Deployment
Manager node and stores in it the information regarding the application servers managed
by that Deployment Manager. The DistributedServerConfig file has information
about every discovered application server along with the information about its
deployment manager. This is helpful if there is more than one Deployment Manager
installed on the same node.

Use Cases

The following are a few upgrade scenarios you may face when installing WebSphere SPI 6.00
in a distributed network deployer environment. If you have a classic set-up in your
environment, you can continue using WebSphere SPI as usual.

Use Case 1: You are a new customer of WebSphere SPI and want to monitor the distributed
WebSphere Network Deployer scenario.

1 Install the WebSphere SPI on the HPOM management server.

2 Deploy the WebSphere SPI templates and instrumentation to all the nodes on which the
Deployment Manager is running.

3 Run the Discover WebSphere Application.

The master SiteConfig contains only the details of the Deployment Managers. The details
of the application servers on individual nodes is available on the Deployment Manager’s
Distributed SiteConfig. The Distributed SiteConfig is available in the
<OvDataDir>/conf /wbsspi directory.

Use Case 2: You are an existing customer of WebSphere SPI and want to monitor the distributed
network deployer scenario in your environment.

1 Install the WebSphere SPI on the HPOM management server.
2 Deploy the instrumentation to all the nodes where Deployment Manager is running.

3 Manually remove all previous versions of WebSphere SPI policies from all the individual
nodes (where the WebSphere Application Server is running) . You can do this through the
HPOM console.

4  (Optional) Manually remove all instrumentation of previous version and the
<OvDataDir>/wasspi/wbs/ directory from all the individual nodes (where the
WebSphere Application Server is running). You must perform this task from the managed
node, it cannot be done through the HPOM console.
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Use Case 3: If you are an existing customer of WebSphere SPI and are planning to implement the
network deployer scenario.

A If you follow these steps, you might lose your data. Backup your data before you follow these
steps.

Follow steps as in Use Case 1.

Use Case 4: If you are an existing customer of WebSphere SPI and have implemented the network
deployer scenario but still want to use the SPI ignoring the network deployer scenario.

1
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Install the WebSphere SPI on the HPOM management server.
Run the Discover WebSphere Application.

Go to <OvDataDir>/conf /wbsspi directory.

Open SPIConfig file.

Set OVERRIDE DISTRIBUTED_ MODE=TRUE

This action ignores the network deployer scenario.

Save the SPIConfig file.

Clean master SiteConfig to remove the servers listed in the SiteConfig for the
corresponding node.

Rerun the Discover WebSphere Application.

Limitations in a Network Deployer scenario

Log file monitoring is not supported on federated servers.

The four status related metrics — WBSSPI_0001 Server Status, WBSSPI_0002 Server
Status Report, WBSSPI_0003 Admin Server Status, and WBSSPI_0004 Admin Server
Status Report are not collected in the network deployer scenario. However, if the
WebSphere SPI is unable to connect to the deployment manager, an alert message
indicating that the deployment manager is down appears in the message browser.

When you launch the View Server Status application, it returns the status of deployment
manager as “unknown”.
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4 Customizing the WebSphere SPI Templates

As you become familiar with the Smart Plug-in for WebSphere Application Server
(WebSphere SPI), you can determine which templates are most useful to you and which you

might want to change. This chapter assists you by providing more detail on the templates and
how to make those changes.

Basic Template Customizations

Make copies of the original templates so that the default templates remain intact. Otherwise,
your customizations will be overwritten when you upgrade to the next version.

Modifying Metrics Templates

Many metric attributes can be easily modified for all monitored instances of a WebSphere
Server by following these steps:

1
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Open the Message Source Templates window.

Open the SPI for WebSphere template group.

Open the desired impact template group and then the WBSSPI-Metrics template group.
Double-click the desired metric to open the Message and Suppress Conditions window.

Double-click the desired condition to modify (there is usually only one).
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The Condition window opens.

Condition

Ohbject Pattern

Threshold Duration

= Suppress Matched Condition Advanced Options...

= Suppress Unmatched Condition

@ + Message on Matched Condition

Set Attributes

Severity Application Message Group Ohject

critical

Actions

Message Text
Admin 5

Service Name

Message Type

Instructions... |Message Correlation...

On Server Log Only (put directly into History Log)

Node Command

Automatic

Operator initiated

Forward to Trouble Ticket

Notification

Cancel Test Pattern Matching...

The following attributes can be modified:

62

Threshold: Enter a value for the metric data that, when exceeded, would signify a
problem either about to occur or already occurring.

Duration: Enter a value for the length of time that the incoming data values for a
metric can exceed the established threshold before an alarm is generated.

Severity: Click the Severity button and select the desired severity setting.

Message Text: Be careful not to modify any of the parameters—surrounded by <>
brackets, beginning with $—in a message.

Actions: Generate metric reports or add custom programs. In the WebSphere SPI,
automatic actions are configured to generate metric reports showing data values at
the time an exceeded threshold occurred. You can view a generated WBSSPI report by
opening the message’s Annotations.
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The following illustration of the Condition window shows a threshold setting of 95 for
WBSSPI-0005.2. This metric monitors the total number of times per minute clients must
wait for an available EJB (enterprise java bean). A value of more than 95 would start to
impact the server response time the client experiences, generating an alarm (a warning
message).

Description

2: Major thresho ].El

Condition

Object Pattern

Threshold

6 Click OK.
7  Re-distribute the modified template (described in Task 6: Distribute WebSphere SPI
Templates on page 50).
Modifying Alarm Generation

An alarm can be generated once or multiple times, depending on its Message Generation
setting in the Modify Threshold Monitor window.

To change the change the Message Generation, follow these steps:

1
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Open the Message Source Templates window.

Open the SPI for WebSphere template group.

Open the desired impact template group and then the WBSSPI-Metrics Template group.
Select the template to modify.

Click Modify. The Modify Threshold Monitor window opens.
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Monitor

External =

Threshold Type

Mazimum Minimum
Message Defaults

Sewverity

unknown

Service Name

Cancel

Message Generation

with Reset without Reset Continuous

Application Message Group Object

Instructions... |Message Correlation... Advanced Options...

Help

6 Modify the Message Generation settings:

e With Reset: Alarms are generated once when the threshold value is exceeded. At the
same time, a reset threshold value is activated. Only when the reset threshold value is
exceeded does the original threshold value become active again. Then, when the
threshold value is again exceeded, another alarm is generated and the process starts

all over again.

¢ Without Reset: Alarms are generated once when the monitoring threshold value is
exceeded. Alarms reset automatically when metric values are no longer in violation of
the thresholds and are generated again when the threshold is exceeded.

¢ Continuously: Messages are sent/alerts generated each time the metric values are
collected and the threshold is exceeded.

7 Click OK.

8 Re-distribute the modified template (described in Task 6: Distribute WebSphere SPI

Templates on page 50).
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Advanced Template Customizations

The template changes described in this section range from making copies of default template
groups in order to customize a few settings, to deleting whole groups of metrics within a
template’s command line. This section is considered advanced because all changes described
require some advanced knowledge of the WebSphere SPI metrics.

Choosing Metrics to Customize

Determine which metrics you want to customize and what templates within the group you
want to use and then follow these steps:

1
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Open the Message Source Templates window.

Highlight the group you want to use and click the Copy... button.

Rename and save the group.

Within the renamed template group, copy each original template and rename it.

Delete the originals from the new group.

Customize the renamed templates within the group, as necessary.

Creating a new template group enables you to keep custom templates separate from the
original default templates, which you copy and place within the new group.

Using the WebSphere SPI Collector/Analyzer Command

The wasspi wbs_ca command is used in every collector template, named according to its
collection interval. You can view the default command line parameters within each collector
template in the Command text box in the Modify Scheduled Action window.

WebSphere SPI Collector/Analyzer Command Parameters

WebSphere SPI data collections are started with the wasspi_wbs_ca command, to which you
can add other parameters, as identified in the following table.

Parameter Description Syntax

-m Specifies the metric numbers or number -m <metric_number>

(metric) ranges on which to collect data. Example: -m 1,3-5,9-11,15
-matchver Specifies the specific WebSphere -matchver <version_number>

(match version)

application server version to monitor. This
option must not be used with the -minver
or -maxver options. If no matching versions
are found, the command does not run.

Example: -matchver 4

—maxver

(maximum version)

Specifies the highest WebSphere
application server version to monitor. Use
with -minver to specify a range of versions.
If no versions are found, the command does
not run.

-maxver <version_number>

Example: -maxver 6.1

Customizing the WebSphere SPI Templates
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Parameter

Description Syntax

-minver

Specifies the lowest WebSphere application | -minver <version_number>

(minimum version) | server version to monitor. Use with -maxver| Example: -minver 4

to specify a range of versions. If no versions
are found, the command does not run.

-r Generates an ASCII report for the specified | -r
(report) metrics
-t Creates a new template group by adding a | -m <metric_number> -t <prefix>-
(tag) prefix to an existing collector template Example: -m 220-223 -t DEV-
along with the metric numbers.
-i Lists specific servers to monitor. Must not | —-i <server_name>
(include) be used with the -e option. Example: -1 serverl,server3
-e Excludes specific servers from being -e <server_name>
(exclude) mopitored. Must not be used with the -1 Example: -e server2, server4
option.
-x Specifies a property/value: -x <property>=<property_value>
alarm: When off, overrides any default -x alarm=off
alarming defined for the metric.
prefix: Default: JMXUDM._. Specifies the | -x prefix=SALES
prefix of the metric ID.
print: When on, prints the metric name, -x print=on
instance name, and metric value to
STDOUT in addition to any configured
alarming or logging.
log: When off, prevents graphing or -x log=off
reporting functions.
Examples
e To specify metrics to collect:
— specific data on all configured servers:
wasspi_wbs ca -m 10-14,25,26
— data from specific servers only:
wasspi_wbs ca -m 245,246,260 -i serverl, server2
e To not collect data from specific servers:
wasspi_wbs ca -m 220-225 -e serverl, server2
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Using JMX Actions Command Parameters

The command parameters described in this section are used to run JMX actions. JMX actions
are one or more JMX calls (invoke, get, set) performed on an MBean instance or type. A single
JMX call can be performed from the command line. Multiple JMX calls can be specified in an
XML file or as a Metric subelement in a UDM file.

Parameter

Description

—a

Required

(action) Indicates a JMX action is performed.
Syntax: -a

-i

(include) Enables you to list specific servers on which to perform the JMX
actions. If this parameter is not specified, the JMX actions are performed on all
configured servers.

Syntax: -i <server_name>

Example: -i serverl, server3

—-m

(metric) Specifies the metric ID containing the action to perform. This metric ID
must be defined in a UDM file. This option must not be used with the -mbean
nor -xml options.

Syntax: -m <metric_id>
Example: -m TestUDM 1000
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Parameter

Description

-mbean Performs a JMX call on the specified MBeans. This option must not be used
with the -m nor -xml options.
Syntax: -mbean <objectname> <action>
Example: -mbean WebSphere:type=ThreadPool, * -get maximumSize
where <action> (a JMX call) is one of the following:
-get Returns the value of the apecified attribute.
Syntax: -mbean <objectname> -get <attribute>
Example: -get maximumSize
-invoke [-type]|Executes an MBean operation with the specified
parameters. A type parameter must be specified for
operations which accept parameters. -type supports
operation overloading. If an operation does not require
parameters, —-type is not specified.
Syntax: -mbean <objectname> -invoke <operation>
[-type <parameter_type> <parameter_value>] .
In this instance, <parameter_type> is one of the following:
short, int, long, double, float, boolean, java.lang.Short,
java.lang.Integer, java.lang.Long, java.lang.Double,
java.lang.Float, java.lang.Boolean, and java.lang.String.
Example: -invoke setInstrumentationlLevel -type
java.lang.String pmi=L -type boolean true
-set Assigns the specified value to the specified attribute.
Syntax: -mbean <objectname> -set <attribute> <value>
Example: -set growable true
-0 (object) Specifies an MBean instance.
Syntax: -o <mbean_instance>
Example: -0 exampleJMSServer
-xml Specifies the XML file that contains the JMX actions to perform. This option
must not be used with the -m nor -mbean options.
Syntax: -xml <filename>
Example: -xml myJMXActions.xml
Examples

¢ Set the maximum size for an alarming thread pool to 500 (where
<SOPTION (instancename) > specifies an alarming instance):

wasspi wbs perl -S wasspi wbs ca -a
-mbean WebSphere:type=ThreadPool, * -set maximumSize 500 -o
<SOPTION (instancename) >

e  Set the instrumentation levels to low on all PMI modules:

wasspi wbs perl -S wasspi wbs ca -a
-mbean WebSphere:type=Perf,* -invoke setInstrumentationlLevel -type
java.lang.String pmi=L

® Use the sample UDM TestUDM_1000 in the wbs UDMMetrics-sample.xml file:
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wasspil wbs perl -S wasspi wbs-ca -a -m TestUDM 1000
-1 examplesServer

Use the sample actions xml file:

wasspi wbs perl -S wasspi wbs-ca -a
-xml /var/opt/OV/wasspi/wbs/conf/wbs JMXActions-sample.xml
-1 examplesServer

Changing the Collection Interval for Scheduled Metrics

To change the metric collection interval, simply change the Polling Interval in the appropriate
collector template. For example, to change the collection of default metrics from 5 minutes to
10 minutes for the WebSphere High Impact template group, follow these steps:

1
2

N OO0 0 AW

Open the Message Source Templates window.

Select the template group SPI for WebSphere and click WebSphere-Templates-High-Impact —
WBSSPI-Schedule-High.

Select the collector template WBSSPI-40-High-05min.

Click Modify... The Modify Scheduled Action window opens.

Change the Scheduled Action Name to WBSSPI-40-High-10min.

Change the Schedule interval in the Minute box from 5m to 10m. For example, 0, 10, 20...

Distribute the new templates (described in Task 6: Distribute WebSphere SPI Templates
on page 50).

Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template
and rename with a name reflecting the new interval, deleting all but the metrics you are
changing. Set the new interval. Edit the original template to remove the changing metrics.
For example, to change the collection interval to 10 minutes for metrics 221-225, you would
follow these steps:

1
2

Open the Message Source Templates window.

Select the template group SPI for WebSphere and click WebSphere-Templates-High-Impact —
WBSSPI-Schedule-High.

Select the template WBSSPI-40-High-05min.

Click Copy.... The Copy Scheduled Action window opens. In the Schedule Action Name
box, change the Scheduled Action Name name to WBSSPI-40-High-10min.

In the command box delete all metrics after -m except 221-225.

wasspi_wbs_perl_su -5 wasspi_wbs_ca -n 20,223,01, |

BacENTUSER

Change the polling interval to 10m.
Click OK.

In the template group WBSSPI-Schedule-High, select the WBSSPI-40-High-05min template.
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9  Click Modify. The Modify Scheduled Action window opens. Delete 221-225 after -m from
the Command Box.

10 Re-distribute the modified templates as described in Task 6: Distribute WebSphere SPI
Templates on page 50.

Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you might want to set the threshold to 20
for SERVER _1 for metric 0212 and leave the threshold at 10 for all other servers. To do so,
copy the existing condition and modify it to serve as the exception. Follow these steps:

1 Double-click the metric to open the metric for customization (for example, double-click
WBSSPI-0212).

The Message and Suppress Conditions window is displayed.

2 Select the desired condition and click Copy... to make a copy of the condition.

3 Name the condition WBSSPI-0212.2.

4 In the Object Pattern field, enter the following details:
<ServerName>:<ServerPort>:<NodeName>:<*>:<*>:<*>
For example: To set threshold for the application server SERVER1, enter the following:
SERVER1 : <*>:<*¥>: <*> 1 <> 1 <*>

5 Click Test Pattern Matching... to test the pattern and verify pattern matching (you must set
up a match file first).

6 Change the value in the Threshold field from 10 to 20.

Creating Custom, Tagged Templates

Another advanced customization option is to use the tag option (-t on the command line),
which enables the collector/analyzer to recognize customized templates that have a tag
attached to the name. This option provides you with the flexibility of using more than a single
set of templates to define conditions pertaining to specific installations of a WebSphere
Server. It also preserves templates from being overwritten when an upgraded version of the
WebSphere SPI is installed.

When multiple nodes are managed by a number of groups, this option enables you to create
specially tagged templates that are obviously separate from your original setup. In such a
case, you would make copies of the templates, rename them with the tag, re-work the collector
template to pick up the tagged names, and assign them to the various groups.

For example, you might create a group of templates and change each template name to
include CLIENTO1 in it. You can name a metric monitor template as
CLIENTO01-WBSSPI_0212 (retaining the metric number, which must be used) and name the
collector template as FIRST_CLIENT-40-05min. You could then set up another group for
SECOND_CLIENT and change all those templates to include the CLIENT02 in the name.

To Create the New Template Group

1 Copy the original template group. In the Message Source Templates window select the
group and click Copy....
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2 Name the new group according to how you plan to identify the new schedule and collector
templates. For example, if you are including CLIENTO1 in the template names, include
that within the new template group name.

3 In the Message Source Template window, expand the new template group to show all
templates and select each template you plan to use, click Copy..., and rename it according
to your naming scheme.

¢ The names you give the new metric monitor templates in the group would contain the

new name followed by the original metric number. For example, a copy of
WBSSPI-0001 could be called CLIENT01-WBSSPI_0001.

¢ The name you give the new collector schedule template would also contain the
identifying name. You would also modify the scheduled collection for the new group by
inserting the -t property on the command line. For example:

wasspi_wbs ca -m 16 -t CLIENTOl1-

4 Delete all original templates from the new group.

Template Variables

The following variables are used by the WebSphere SPI templates. If you are creating your
own templates, you can use these variables.

Name Description

instancename The instance for which the metric is being reported for multi-instance
metrics.

map_port See port. This variable could be deprecated in future releases.

map_servername

The application server name with spaces replaced with underscores (“_").
Used for service map keys where spaces are prohibited.

Example: my server

node The node on which the application server is running.
Example: mool.hp.com

port The port on which the application server is listening. Corresponds to the
PORT configuration property.
Example: 9001

servername The application server name. Corresponds to the NAME configuration

property.
Example: my server

Customizing the WebSphere SPI Templates
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Monitoring a WebSphere Server on Unsupported Platforms

The WebSphere SPI supports monitoring WebSphere Server systems running on HP-UX,
Solaris, Linux (Red Hat), AIX, and Windows 2000. However, it is possible to configure the
WebSphere SPI to monitor WebSphere Server systems running on unsupported platforms, in
other words, “remote systems.”

This section explains how to determine if your environment is conducive to setting up remote
monitoring. If you determine that your environment meets the criteria, and you have some
expertise using the WebSphere SPI and the WebSphere Server, you can use the information
in this section to get started.

Requirements for Monitoring Remote Nodes

For a WebSphere Server system running on an unsupported platform, you can use the
WebSphere SPI to monitor that remote system if the following conditions apply:

e The remote system is covered by a purchased license (using Tier 1 pricing).

e The WebSphere SPI runs on at least one managed node on a supported platform: HP-UX,
Solaris, Linux (Red Hat), AIX, or Windows 2000.

e The local/proxy system and remote system must be running the same version of
WebSphere Server. For example if the proxy system is running WebSphere Server version
5, the remote system must also be running WebSphere Server version 5.

e (Optional, for logfile monitoring) The remote system runs on a platform supported by the
HP Operations agent software .

Remote Monitoring

The following section provides an overview of remote monitoring and shows how it is
implemented. Also included are details on how to set up the WebSphere SPI to access
WebSphere Server metrics and logfiles on unsupported platforms by using both the
WebSphere SPI and HP Operations agent software.

In a standard configuration, WebSphere SPI programs/templates are deployed on the local,
managed node. In a non-standard configuration, the local system is used as a proxy through
which remote metric information becomes accessible.
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Remote system data collection/interpretation relies on the local managed node to act as the
proxy on which data collection is configured.

OpenView Operations OpenView Operations
Managed Node Management Server

Proxy System

=l

— Mg, VO Agent

Configuration entries requirement: Within the configuration, entries for both local and
remote systems are included. You can include multiple remote system entries in a local
system’s section. See example on Task 1: Configure the Remote WebSphere Server System on
page 74, showing how the remote entry appears (with system IP address).

Template deployment requirement: Templates for the correct WebSphere PMI level should be
deployed on the local node. If you need a separate template group (for example High Impact or
Medium Impact) to cover a different level, you can copy and rename the existing templates
and specify the WebSphere Server name on the command line using the -i or -e options. For
information about using these command line parameters, see Using the WebSphere SPI
Collector/Analyzer Command on page 65 .

HP Operations agent deployment requirement (optional logfile monitoring): To access remote
WebSphere Server logfiles, the HP Operations agent software must be installed on the remote
system. Using standard HPOM processes, you can modify the standard logfile templates
included with the WebSphere SPI to specify the correct logfile names, and then deploy them
to the remote system.

) Monitoring remote systems using logfile versioning is not supported.

Configuring Remote System Monitoring

You can monitor a WebSphere Server on remote systems (running on platforms other than
HP-UX, Solaris, Linux, AIX, or Windows 2000) by completing the following tasks.
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Task 1: Configure the Remote WebSphere Server System

Using the Configure WBSSPI application in the HPOM WBSSPI Application Bank, configure
each local managed node that communicates with a remote WebSphere Server. In the
configuration, include additional entries for remote WebSphere Servers.

1 Choose a WebSphere Server managed node from which to monitor the remote WebSphere
Server.

2 At the HPOM console, launch the Configure WBSSPI application. In the Application Bank
window select WBSSPI - WBSSPI Admin - Configure WBSSPI.

3 In the configuration that appears, include an entry for each remote WebSphere Server
system: SERVER<n> ADDRESS=<DNS server name or IP address>

Make sure that NUM_SERVERS is set to the correct number of servers (<n>) and that
HOME and JAVA_HOME are set at the global level.

The following example shows how local and remote WebSphere Servers are configured in
the same file. For the remote servers, the SERVER<n> ADDRESS=<IP_address>

(SERVER2 ADDRESS=15.75.27.109 or SERVER2 ADDRESS=hardey.hp.com) line is
added:

HOME=/opt/WebServer/AppServer

JAVA HOME=/opt/WebServer/AppServer/java
NODE local node ({

NUM SERVERS=2

SERVER1 NAME=lara

SERVER1 PORT=900

SERVERZ NAME=harley

SERVERZ PORT=905

SERVERZ ADDRESS=hardey.hp.com

}

There are two WebSphere Servers configured in the preceding configuration. SERVER1 is
the local server, running on an HP-UX managed node. SERVER2 is running on an HPOM
managed node, that is a non-Red Hat Linux system (a platform unsupported by
WebSphere SPI). The remote system is configured similar to that of the local system but
contains the new line SERVER2 ADDRESS=harley.rose.hp.com.

4 To verify that the SPI is monitoring the remote node, run the following command:

wasspi_wbs_perl -S wasspi_wbs_ca -m 5 -i <remote_server NAME|ALIAS> -x
print=on

You must use ALIAS if it is set for the remote server.
Task 2: Integrate the HP Performance Agent (Optional)
Since the HP Performance Agent (also known as the MeasureWare Agent) collection occurs on
the managed node (not the remote system), if you use PerfView and would like to graph the

remote system data, you must ensure that MeasureWare integration is enabled on the (local)
managed node.

Task 3: Assign Local Node to a WebSphere SPI Node Group

Assign the local managed node to the appropriate node group. For example, you would assign
the local node to the WBS High node group if the local and remote managed nodes are to
collect metrics that require the system be set at a high WebSphere PMI level.
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Configuring Remote Logfile Monitoring (Optional)

Monitoring remote system logfiles is supported if both the following are true:
e The remote system that has an HP Operations agent running on it .
e The system does not re-version logfiles when they roll.

To set up logfile monitoring, at the HPOM console copy the WebSphere SPI logfile template
and then configure, assign, and deploy the copied logfile template to the remote system.

Configure the Logfile Template for Remote Logfiles
1 Open a copy of the WebSphere Log Template located under WBSSPI-Logfiles in the SPI
for WebSphere group. For example, SPI for WebSphere > WBSSPI-Lodfiles.

2 In the Logfile text box, enter the location of the logfile on the remote system: /<path>/
<file_name>.

3 Assign and deploy the logfile template to the remote HPOM managed node.

The log file template and the HP Operations agent, both present on the remote system, make
WebSphere Server logfile monitoring possible.
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Limitations of Remote Monitoring

e The WebSphere SPI and the HP Operations agent do not support access to logfiles that
are re-versioned each time the logs are rolled.

e  When no HP Operations agent is present on the remote system, monitoring of WebSphere
Server logfiles on the remote system cannot occur.
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In the HPOM Application Bank, WebSphere SPI applications cannot be executed on
remote systems.

The proxy system and remote system must be running the same version of the WebSphere
Server.

Restoring Default WebSphere SPI Templates

When WebSphere SPI templates are installed in HPOM, the following commands
automatically upload them when swinstall is run. Any customized template settings you
might have done for the previous installation are overwritten.

To restore the default SPI for WebSphere template groups you originally installed:
1 Delete all current templates.

Run the command:
/opt/OV/bin/OpC/opccfgupld -silent -replace \
-subentity var/opt/OV/share/tmp/OpC_appl/wasspi/wbs_set

Alternatively, you can use the -verbose option instead of the -silent option.
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Using Templates/Applications to View Annotation Reports

Some templates have actions defined with threshold violations or error conditions that
automatically cause reports to appear in the message Annotations. These reports are
snapshots of data values collected from the server around the time that the alarm occurred.

) The reports discussed in this section should not be confused with those generated by HP
Reporter, which show more consolidated, historical data generated as web pages in
management-ready presentation format.

You can access the data as follows:

e To view the Message Details. Double-click a message in the HPOM message browser, or
just select the message and click Annotations. Reports are available there, showing data
values on a single server.

e To view reports. Open both the Node Bank and Application Bank windows. Continue to
open application windows WBSSPI > WBSSPI Admin — Reports. Select a node and drag it
onto the WebSphere SPI metric report you need. These reports show all server data on a
node.

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports show data on a single
WebSphere Server instance with an exceeded threshold. They are generated as soon as the
alarm is triggered in HPOM.

Viewing an Automatic Action Report

When an Automatic Action Report is executed from HPOM, the server is queried for
additional data. If your message browser is set to display the SUTAONE column, you will see
an “S” under the “A” column (see the following illustration), which indicates that a
successfully generated report is available in the Annotations area of the Message Details.

=

Browser Actions View Window

Sev.Dup. SUIACNE Date Time Node

61 0. 3. h W PI
WebSphere 5 WebSphere
h HE IT/C OpC

To view an automatically generated metric report relating to an alarm condition, click
Annotations... in the message browser. Column descriptions provide further clarification.
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Application Bank Reports

Application Bank reports run for all WebSphere Server instances configured on the managed
node. The reports generated from the Application Bank reflect the current state of a
WebSphere Server on the managed node. You manually generate these reports in HPOM by
dragging the managed node from the Node Bank window to a specific metric report among
those shown in the Application Bank window.

WebSphere SPI reports require that the targeted managed node have a PMI level setting at or
above the rating (as shown in the table below) for the metric you are selecting.

Table 2 Performance Impact Ratings (PMI Levels) of Reporting Metrics
Low 5,42,222,224,247, 265
Medium 40, 221, 246, 262
High 41,212,213, 220, 261, 263, 264

When manually generated, a report from the Application Bank > WBSSPI Reports window
shows that metric data for ALL WebSphere Server instances on the managed node.

Application Group: WBSSPI Reports

Map Actions Edit View Window

sl =8 QY 22

1220_EJEPool I221_EJEMethRe: 1222 EJEMethod 1224 _EJEEntD; 1246_\Webipp Sens 1247_WebApp ServletErvorR
[]

261_JOEBCConn| 1262 _JDEBCConnPoc 263 JOBCCor 1264_JDEBCConn 1265 JOBCConn PoclTimecutRt
F F F F F

opc_adm [Read—Write] Auto—Layout] [Connection Labels Off]
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The following Application Bank report was generated for Metric #5 (1005).

— Dutput of Application No. 1

- Default Server
0 AM

Checking WebSphere SPI Nodes for License Count

You can use an HPOM reporting utility to check the number of templates you installed on
your managed nodes. In reviewing the number of templates per managed node, you can see if
you consistently installed templates across your managed systems. In addition, you can also
ensure that the number of licenses you purchased is in compliance with the report results.

To run the report:

1

2
3
4

At the HPOM console select the node or node group that you want to check.
From the Actions menu select Utilities > Reports....
In the Reports window among the reports listed select WBSSPI License Check.

Select an output destination and click OK.

Customizing the WebSphere SPI Templates 79



80

Chapter 4



5 Integrating HP Reporting and Graphing
Products with the WebSphere SPI

The WebSphere SPI can be integrated with the following HP reporting and graphing products
(these products must be purchased separately):

HP Reporter: HP Reporter produces management-ready, web page reports, showing
historical and trending information.

Working in conjunction with HP Reporter, the WebSphere SPI produces a variety of
reports showing consolidated information on the WebSphere Application Server.

After integrating WebSphere SPI with HP Reporter, every night, HP Reporter generates
reports that show the performance and availability of a WebSphere Application Server on
configured managed nodes. For information on how to integrate HP Reporter with
WebSphere SPI, see Integrating with HP Reporter on page 83.

HP Performance Agent: HP Performance Agent collects, summarizes, time stamps, and
detects alarm conditions on current and historical resource data across your system. It
provides performance, resource, and end-to-end transaction response time measurements,
and supports network and database measurement information. For information about HP
Performance Agent, see HP Performance Agent for UNIX User’s Manual.

If you integrated HP Performance Agent with the WebSphere SPI, the WebSphere SPI
automatically uses it. If you want to use the HP Operations subagent (CODA) that is
included with HP Operations Manager (does not support HP Performance Agent), you

must configure your managed nodes to do so. For more information, see Integrating with
CODA on page 82.

HP Performance Insight: HP Performance Insight is a network management system
that collects, processes, and reports data. The data is used to generate reports. For more
information about HP Performance Insight, see the HP Performance Insight
Administration Guide.

For information about how to how to integrate WebSphere SPI with HP Performance
Insight and generate reports, see the Application Server Report Pack User Guide.

HP Performance Manager: HP Performance Manager provides graphing capability. It
generates graphs of WebSphere SPI metrics data.

For information on how to integrate WebSphere SPI with HP Performance Manager, see
Integrating with HP Performance Manager on page 87. After integrating WebSphere SPI
with HP Performance Manager, graphs are available the following day.
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Integrating with CODA

The WebSphere SPI can detect if you are using HP Performance Agent. If you are, the

WebSphere SPI installation automatically uses it.

If you want to use the HP Operations subagent (CODA) included with OVO for UNIX 7.x, you

must configure the managed nodes to do so. This configuration does not support HP
Performance Agent.

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda. opt file in the following directory:

Operating System File Location

HP-UX, Linux, Solaris /var/opt/OV/conf/dsi2ddf/
AIX /usr/lpp/OV/conf/dsi2ddf/
Windows \usr\ov\conf\dsi2ddf\

If the directory dsi2ddf does not exist, create it.

2 Save the empty file.
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Integrating with HP Reporter

The WebSphere SPI must be installed and configured before it can be integrated with HP
Reporter.

If you are upgrading the WebSphere SPI report package, you must remove the old version
before installing the new version. See Task 14: Install the New Report Package (Optional) on
page 35.

The WebSphere SPI report package must be installed on the Windows system running HP
Reporter. Follow these steps:

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:
\OV_REPORTER\WEBSPHERE_SPI_06.00.000\WBSSPI-Reporter.msi

2 Follow the instructions as they appear.

3 Check the HP Reporter status pane to note changes to the HP Reporter configuration.

’ For Windows 2000 managed nodes, during the installation, an error message
might appear that indicates the installer has detected an older version of the
installer on your system. You can safely ignore the message and continue.
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The HP Reporter main window displays IBM WebSphere Availability and Performance

reports.
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You can find instructions in the Reporter help for assigning WebSphere SPI reports to the
targeted nodes. To access help, select Reports or Discovered Systems in the left panel of
the Reporter main window and right-click it. Select Report Help or Discovered Systems
Help from the submenu that appears. See the topic “To assign a report definition to a
Discovered Systems Group.”

Add group and single system reports by assigning reports as desired. See the Reporter
help and the online Concepts Guide.

>»

Group and single system WebSphere SPI reports require that you identify systems
by their full name. For example, abc . xyz.comis acceptable while abc is not.

WebSphere SPI Reporter Reports

The reports available through the integration of HP Reporter and the WebSphere SPI show
consolidated data on server performance and availability on all WebSphere Server systems.
In addition, other reports show data for single systems. These reports are available the day
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following your installation of the WebSphere SPI report package on the HP Reporter Windows
system. If you have not yet completed the report package installation, see Integrating with

HP Reporter on page 83.

The following tables show all pre-defined reports.

Table 3  All/Group Reports
Report Title Description Metric
Availability Shows the percent uptime for all WebSphere 2
Servers by day.
Top 20 Servers— Transaction | Shows the average throughput for the top 20 77
Throughput execute queues of all servers.
Top 20 Servers—JDBC Shows the average throughput for all 66
Connection Pool Throughput connections pools on the server for the top 20
servers.
Top 20 Servers—Servlet Shows the total servlet request rate for the top 45
Request Rate 20 servers.
Top 20 Servers— Servlet Shows the total servlet sessions being handled by | 41
Sessions the top 20 servers.
Top 20 Servers— Servlet Shows the average response time for the top 20 | 245
Average Response Time requested servlets for all servers for the
reporting period.
Top 20 Servers— EJB Method | Shows the number of all EJB method calls per 22
Calls Rate minute for the top 20 servers.
Top 20 Servers— Entity EJB Shows the number of all Entity EJB loads and 24
Load/Stores Rate stores to/from the database per minute for the
top 20 servers.
Table 4 Single System Reports
Report Title Description Metric
Server Availability Contains spectrum graphs showing minutes of uptime by | 2
Details day and hour for each WebSphere Server.
Admin Server Shows the uptime percent for each WebSphere Admin 4
Availability Details server by day.
EJB Average Shows the average response time for the top 20 EJBs for a | 221
Response Time server for the reporting period.
EJB Method Calls Shows the number of all EJB method calls per minute for |22
Rate the top 20 EJBs for a server.
Entity EJB Load/ Shows the number of all EJB loads and stores to/from the | 224
Stores Rate database per minute for the top 20 EJBs on a server.
EJB Pool Utilization | Shows the EJB pool utilization as a percent for the top 20 | 220
EJBs on a server.
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Table 4

Single System Reports

Report Title Description Metric
EJB Pool Misses Shows the percent of time that a call to retrieve an EJB 225
Percent from the pool was not successful during the collection
interval for the top 20 EJBs.
EJB Pool Size Shows average pool size for the top 20 EJBs for one server | 223
for each day.
JDBC Connection Charts throughput against utilization for the JDBC 263
Pools Throughput vs. | connection pools on the selected server, one chart for each
Utilization connection pool.
JDBC Connection Charts connection pool size against the average wait time | 260
Pools - for a connection for the JDBC connection pools on the
Size vs. Wait Time selected server, one chart for each connection pool.
JDBC Connection Charts the number of clients waiting for a database 265
Pools - connection from the pool against the timeout rate for
Clients Waiting vs. waiting clients for the DB connection pools on the selected
TimeoutRate server, one chart for each connection pool.
JCA Connections Shows the JCA resource connection pool utilization as a 250
Utilization - Top 20 percent.
Resources
Transaction Shows the average transaction throughput for the selected | 77
Throughput server by day.
Thread Pool Activity | Charts the average size of the thread pool against the 211
average number of active threads for all thread pools on
the selected server, one chart for each thread pool.
Servlet Request Rate | Shows the request rate (per second) for the top 20 servlets | 245
for one server for each day.
Servlet Average Show the average response time for the top 20 requested | 246
Response Time - Top | servlets for one server for the reporting period.
20 Servlets

HP Performance Insight Reports for the WebSphere SPI

The reports available through the integration of HP Performance Insight and the WebSphere
SPI show consolidated data on server performance and availability on WebSphere application
server systems.
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The following table shows all pre-defined reports.

Report Title Description Metric
Server Availability— The server availability chart plots the availability status |2, 77
Throughput of the application server on an hourly, daily, and monthly
basis. The transaction throughput chart displays the
number of transactions processed by the application
server per second.
EJB Pool Utilization The percentage of EJB pool utilization. 20
JDBC Throughput— The percentage of available JDBC connection in the 66, 263
Utilization connection pool and the number of clients serviced by the
connection pool per second.
Near Real Time Server | The server status for the last six hours. 2,77
Availability
Servlet Request Rate— | The servlet request rate measures the number of requests | 45, 246
Response Time for a servlet per second. The servlet response time chart
shows the average execution time for an individual
servlet.
EJB Load-Stores Rate | The number of all entity EJB loads and stores to and from | 24
the database per minute for the top 20 servers. For the
selected server, lists the top 20 EJBs.
EJB Method Calls Rate | The number of all EJB method calls per minute for the top | 22
20 servers.
EJB Top 20 The percentage of EJB retrievals that were not successful | 25,
during the collection interval, average pool size, and 221,
average response time in milliseconds for the top 20 EJBs.| 223
JDBC Connection Pool | The average number of connections allocated per day for |61, 65,
Details the top 20 servers. The DB pool is shown along with 260,
clients waiting, client timeout rate, average pool size, and | 266
average wait time.
Servlet Sessions The total number of servlet sessions being handled by the | 41
top 20 servers.
Thread Pool Activity Comparison of the average size of thread pools with the | 210,
average number of active threads on the selected server. | 211
Transaction Throughput | The average number of transactions processed per second | 77
by the top 20 servers for the previous day.

Integrating with HP Performance Manager

To integrate the WebSphere SPI with HP Performance Manager, follow these steps:

1 Install and configure the WebSphere SPI. Verify that you completed Task 1: Configure the
Management Server to Launch Your Web Browser on page 37. Also, verify that you set the
GRAPH_URL property. See Property Definitions on page 161.
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2 Ifyou are upgrading the WebSphere SPI graph package, remove the old version before
installing the new version. See Task 15: Install the New Graph Package (Optional) on

page 36.

3 Install the graph package.

On a Windows system running HP Performance Manager, follow these steps:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the
DVD-ROM drive, and in Windows Explorer, double-click
\OV_PM\WEBSPHERE_SPI_06.00.000\WINDOWS\HPOVvSpiWbsGc-06.00.000.msi.

b  Follow the instructions as they appear.

On an HP-UX system running HP Performance Manager which is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are already swinstalled when you install the SPI

software):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and

type:

swinstall -s <mount_point>/OV_PM/WEBSPHERE SPI_06.00.000/HPUX/
HPOvSpiWbsGc-06.00.000.depot WBSSPI-GRAPHS

On a Solaris system running HP Performance Manager which is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are already installed when you install the SPI

software):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and

type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/WEBSPHERE SPI_06.00.000/
SOLARIS/HPOvVSpiWbsGc-06.00.000.sparc all

4 To graph any WebSphere Server metric, use the data source name WBSSPI METRICS.

For information on how to view the graphs, see the HP Performance Manager documentation.
Graphs are available the day following integration.

WebSphere SPI Metrics Available for Graphs

The following tables show the graphs available for mapping collected metric values. Use HP
Performance Manager to view any one of the metrics included in any of these tables.

Table 5 JVM

Metric Number/Name

Metric Description

1005_JVMMemUtilPct

Percentage of heap space used in the JVM.

Table 6 Server Performance

Metric Number/Name

Metric Description

1013_ ThrdPoolPctMax

Percentage of time Number of threads in pool reached
configured maximum size.

1014_ThrdPoolCrtRt

Number of threads created per minute.
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Table 7

Enterprise Java Beans (EJB)

Metric Number/Name

Metric Description

1020_EJBPoolUtil

Percentage of active beans in the pool.

1022_EJBMethCallsRt

Number of EJB method calls per minute.

1024_EJBEntDatLdStRt

Number of times an EJB was written to or loaded from the
database per minute.

1025_EJBPoolMissPct

Average Percentage of time a call to retrieve an EJB from the
pool failed.

1026_EJBConcLives

Average Number of bean objects in the pool.

Table 8 Servlets

Metric Number/Name

Metric Description

1040_ServSessAveLife

Average lifetime of a servlet session in milliseconds.

1041_ServSessActSess

Number of sessions currently being accessed.

1042_ServInvSessRt

Number of sessions being invalidated per second.

Table 9 Web Applications

Metric Number/Name

Metric Description

1045_WebAppServReqRt

Number of requests for a servlet per second.

1047_WebAppServErrRt

Number of errors in a servlet per second.

1048_WebAppServLoad

Number of servlets currently loaded for a web application.

1049_WebAppServRelRt

Number of servlets reloaded for a web application per
minute.

Table 10 JDBC

Metric Number/Name

Metric Description

1061_JDBCConPoolWait

Average number of threads waiting for a connection from
connection pools

1062_JDBConPoolWtTim

Average time that a client waited for a connection in
milliseconds.

1065_JDBConPoolTimRt

Number of times a client timed out waiting for a connection
from the pool per minute.

1066_JDBCConPoolThru

Number of connections allocated and returned by
applications per second.
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Table 11 Transactions

Metric Number/Name Metric Description

1070_TranGlobDur Average duration of global transactions.

1071_TranLocDur Average duration of local transactions.

1072_TranGlobCommDur Average duration of commits for global transactions.

1073_TranLocCommDur Average duration of commits for local transactions.

1074_TranRollbackRt Number per second of global and local transactions rolled
back.

1075_TranTimeoutRt Number per second of timed out global and local
transactions.

1076_TranCommitRt Number per second of global and local transactions that were
committed.

1078_TranStartRtt Number per second of global and local transactions that were
begun.

Example Integration

The following example describes how to graph multi-instance data stored in a data source by
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all
data for all instances are reported in one graph. The data for each SERVERNAME can also be
displayed in a separate graph.
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This example uses the Java interface option of HP Performance Manager.

1 Start the Java Interface option of HP Performance Manager. The Performance Manager
Java Interface window opens.

Desploy |l
[) Mew 2 open.. [ Save |5 Save Az X Delete. [&, Preview @ Help M
General

Datasource: M Metrics |

Default Selection; ]Mnm Sources

Mote: The default selection is onty used during graph design to preview the graph and retrieve metric w
information. Onece you finish design and save the graph, you can then make multiple selections fo

draw the graph. T Filter

[ Complex Graph Design using multiple sources

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window, and then the Sources tab at the right of
the window.

b Click - | next to the Datasource text box and select a data source
(WBSSPI_RPT METRICS).

¢ Click - |nexttothe Default Selection text box and select the node on which the data
source resides.
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3

Click the General tab at the right of the window.

Dispiay [ BGRRJ: |11 A
Ol Hew @& Open... B Save B Save As.. 2 Delete . [§ Preview § Help W
it General ]
Type: IIahIa '| MI
Description: ml
~Date Range Foints Every: T=Filter

Duration: |3 [days =] 15 minutes -

Ending: I~ MNow * Last Limit Mumber of Points to:

T Date: Tirre: I
Shift

[~ Cwerride Shit Defaulls
Start [00: 00 /= Btop ; 59)=] ™ Skin Holidays
Davg ¥ Sun B hon | Tue W Wwed B Thu W Fi | Sat

Metric Display Order:
" Ayerage data value

* Label {alphabatical)
FaliT :
From this window,
a Select line from the Type drop-down list. This generates a line graph.
b Enter a Date Range.
c¢ Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection
window opens.

i 1

Metric Selection E

_IE CPL ;I
- [ METIF

_IE Fo

- [ DISK

- [§ WBSSPI_METRICSWBSSPI_METRICS

- [§ WBSSPI_RPT_METRICSWBSSPI_RPT_METRICS

----- I~ [ INTERvAL

----- I~ § mETRICID

----- I~ [{ oBJECTMAME

----- [~ [{ SERVERNAME

----- I~ [ sorTID

----- I~ [ waLue i
----- I~ [ vaLUEID

Lahel: |
Type: IIine vI

Y huis: left =

Colar: [ ] Auto =

~Line Style

Style: |solid | Marker: [none -] width: |1

“Fill Style
Style: |- [7]

Missing Data: Ihidden vI

Filter |

014 Cancel Help

6 From the Metric Selection window,
a Next to the WBSSPI RPT METRICS data source, click + to expand it in the tree.
b Select the check box next to VALUE.
¢ Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which
VALUE is displayed and click Properties. The Metric Properties window opens.

Metric Properties - WESSPI_RPT_METRICS:WBSSPI_RPT_METRICS:V...
Label: |@e@SERVERMAME @@ORIECTHAME
Type: Iablej
¥ fods: [t =)
Color, I:l."d.ﬁl:l j

Line Style

Stie: [zoid ]| Marker | =] wadtn: |

Fill Shie

Siyle: [solid 7]
Missing Data: |previous ~| Sum [aute =]
Instance: |
Filter: LSERVERNAME=" " &&0BJEC TNAME=@ J

Ok | Cancel | Help |

8 From the Metric Properties window,

a In the Label text box, enter:

— @@SERVERNAME : @ROBJECTNAME if you are creating one graph with all

SERVERNAMESs

— @QOBJECTNAME if you are creating one graph with one SERVERNAME

b In the Marker drop-down list, select any marker other than none.

c¢ In the Missing Data drop-down list, select:

— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click - | next to the Filter text box. The Metric Filter window opens.

% Metric Filter

-,

METRICD  =| = =] n

Ok

Cancel |

9  From the Metric Filter window,

a Select METRICID from the first drop-down list.

b  Select = from the second drop-down list (if it is not already selected).

¢ Enter a metric number (for example, 11) in the text box.

d Click OK.
10 From the Metric Properties window,

a In the Filter text box, append the following:
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— &&SERVERNAME=Q & §OBJECTNAME=QQ if you want one graph to display all
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME="<server_ name>” &&OBJECTNAME=G if you want one graph to
display one SERVERNAME and all OBJECTNAMEs associated with the
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file.
See step 13.

b  Click OK.
1 Click Save As at the top of the window. The Save As window opens.

Save As
Farmily: | j
Categony: | ﬂ
Marme: | j

Cemee] Help

12 From the Save As window,

a Enter a family (for example, WBSSPI_Graphs) in the Family text box. The family
name serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name text box to uniquely identify the
graph.

¢ Entering text into the Category text box is optional.

d Click OK. The information is saved in a graph template file named
VPI GraphsUser<family>.txt (for example,
VPI GraphsUserWBSSPI Graphs.txt).

For more information about this window, see the online help.

13 Edit the graph template file. The file is located in the HPOM data directory on the system
of the HP Performance Manager instance on which you are working. The graph file might
look similar to the graph in following example.
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#*********************************************

#* OpenView Performance Manager
#* user Defined Graph Templates
#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool

#**********************************************

FAMILY: WBSSPI_Graphs

GRAPH: Metricll
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME : mool

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @QE@SERVERNAME :@@OBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_ 2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11

LABEL: @@SERVERNAME :@EOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: to the end of the first section of each graph (in the example above,
add SUMFROMRAW : after SYSTEMNAME: mool). This enables HP Performance Manager
to summarized data from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter text box in the Metrics Properties window in
step 10, edit the FILTER field.

¢ Save the file. The graph file now contains the following:
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#*********************************************
#* OpenView Performance Manager

#* user Defined Graph Templates

#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool
#**********************************************
FAMILY: WBSSPI_Graphs

GRAPH: Metricll

GRAPHBACKGROUND: None

DATERANGE: 1 day

GRAPHMULTIPLEGRAPHS: Yes

POINTSEVERY: raw

DATASOURCE: mwa

SYSTEMNAME: mool

SUMFROMRAW :

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=Q&&OBJECTNAME=@
LABEL: @@SERVERNAME :@@OBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool
SUMFROMRAW :

CLASS: WBSSPI_RPT METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @Q@SERVERNAME :@@OBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

14 From the Performance Manager Java Interface window, click the Display tab.
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| Display | Design |

Selact one oF more sources to see a list of available graphs,
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—— —— S— 253& MBME""_:
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Ending: = How " Last [ Display graph in HTHL
" Date: Tirne:

Shift
[T Cwerride Shift Defaults
. =
Stant = Stop - H
Davs [+ [+ [+ [+ = F

Logon Diraww Help

15 In this window,

a In the window below the Sources text box, navigate to the server on which the data
source resides.

b In the Graphs window, navigate to the family of graphs and select the graph you
created.

c¢ Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph appears.

) If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from
the graph template file. You must edit the graph template file and re-enter this
entry.

16 From the SPI, enable graphing:

a From the HPOM console, open the Node Bank window and select a node or groups of
nodes on which you want to enable graphing.

b  Open the Application Bank window.
¢ In the Application Bank window select WBSSPI - WBSSPI Admin.
d Double-click UDM Graph Enable.
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6 Basic Troubleshooting and Error Messages

Using the Self-Healing Info Application

The Self-Healing Info application gathers WebSphere SPI troubleshooting data and stores
this data in a file that you can submit to HP Support for assistance. For information on how to
use this application, see Self-Healing Info on page 176.

) The file created by the Self-Healing Info application might be hidden on some Windows
managed nodes. If you do not see the file, open Windows Explorer and, from the Tools menu,
select Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden
files and folders.

Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OvInstallDir%>/ is

/var/opt/0OV)

File Type Log

Filename /<%O0vInstallDir%>/wasspi/wbs/log/
<managed node> disc_server.log

Description Records the updates done by the WBSSPI Discovery policy to the

management server’s configuration for each managed node. Log files
are overwritten each time the discovery policy is run on the managed
node. Logging to this file is always enabled.

UNIX Managed Nodes

The following log and trace files are found on the managed nodes running on UNIX (typically,
/<OvAgentDir>/ is /var/opt/0V/ or /var/lpp/OV/):
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File Type
Filename

Description

File Type
Directory

Description

File Type
Directory

Description

File Type
Directory

Description

File Type

Filename

Description

Log
/<OvAgentDir>/1og/javaagent.log

HPOM discovery agent log file containing the status of the HPOM
discovery agent. By default, logging to this file is enabled at
LoG_LEVEL 3. Set the LOG_LEVEL variable in <OvAgentDir>/conf/
svcDisc/OvJavaAgent.cfg to 6 or higher (up to 9) to capture
troubleshooting information (the higher the number, the more
information is collected). To disable this log, set the LOG_LEVEL to
0. Additional information can be configured in this file to define log
file size and the number of archived files kept. By default, the log file
size is 1MB and five archived versions are kept.

Log
/<OvAgentDir>/1og/wbsspi/config.log
Records output from the WebSphere SPI configuration scripts.

Log
/<OvAgentDir>/1og/wbsspi/errorlog

Records WebSphere SPI error messages. This log file is monitored by
WebSphere SPI policies.

Log
/<OvAgentDir>/1og/wbsspi/discovery.log
Records output from the WebSphere SPI discovery process.

Trace

/<OvAgentDir>/1og/wbsspi/discovery.trace (archived files
have a three digit number appended to the filename)

Discovery binary trace file used by your HP support representative.
By default, tracing to this file is enabled. To disable tracing, in
<OvAgentDir>/bin/instrumentation/

wasspi wbs discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi wbs discovery.pl file is overwritten
(therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new
trace file is created when the discovery policy is run.
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File Type

Directory

Description

File Type

Directory

Description

Trace

/<OvAgentDir>/1og/wbsspi/trace.log (archived files have a
three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Trace

/<OvAgentDir>/1og/wbsspi/traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows
(typically, <OvDataDir> is

\Program Files\HP OpenView\Installed Packages\{790 ...}\):

File Type Log

Directory \<OvDataDir> \wasspi\wbs\log\config.log

Description Records output from configuration scripts.

File Type Log

Directory \<OvDataDir> \wasspi\wbs\log\errorlog

Description Records WebSphere SPI error messages. This log file is monitored by
WebSphere SPI policies.

File Type Log

Directory \<OvDataDir> \wasspi\wbs\log\discovery.log

Description Records output from the WebSphere SPI discovery process.
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File Type Trace

Filename \<OvDataDir>\wasspi\wbs\log\discovery.trace (archived
files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative.
By default, tracing to this file is enabled. To disable tracing, in
<OvDatatDir>\bin\instrumentation\wasspi wbs discovery.
pl, set the $trace_on variable to 0. To enable this trace, set the
$trace_on to 1. When instrumentation is deployed, the
wasspl wbs discovery.pl file is overwritten (therefore, if you
disable tracing, it becomes enabled when instrumentation is
deployed). Five archived versions are kept. A new trace file is created
when the discovery policy is run.

File Type Trace

Directory \<OvDataDir> \wasspi\wbs\log\trace.log (archived files have a
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

File Type Trace

Directory \<OvDataDir>\wasspi\wbs\log\traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Troubleshooting the Discovery Process

If the discovery process does not automatically discover multiple installations on a Windows
managed node, set the HOME_LIST property and run the Discover WebSphere application.

If the discovery process does not automatically discover and update the WebSphere SPI
configuration, follow these steps:

1

Check for errors in the message browser of the managed nodes not being discovered.
Follow the instruction text of any error messages displayed.

Verify that a WebSphere application server is installed on the managed node. If an
application server is not installed, install an application server, and complete the
configuration tasks listed in Chapter 3, Configuring the WebSphere SPI.

Verify the WebSphere application server status. The application server must be running.
See Task 1: Verify the Application Server Status on page 42.

On a Windows managed node, verify the installation directory of the server (\Program
Files\WebSphere\AppServer or \WebSphere\AppServer). If the WebSphere
application server is not installed in the default path, configure the HOME property using
the non-default installation path.

On a UNIX managed node, if the WebSphere application server processes are not running
(use ps -ef to check for these processes), verify the installation directory of the server. If
the WebSphere application server is not installed in the default path, configure the
HOME property using the non-default installation path.

Operating System Default Installation Path (UNIX)
AIX /usr/WebSphere/AppServer
HP-UX, Linux, Solaris /opt/WebSphere/AppServer

Verify that the Configure WBSSPI application is not running. Only one process can access
the configuration at a time. If Configure WBSSPI is running, other processes that must
access the configuration (like the discovery process) hang until the configuration becomes
available.

Check if the HPOM management server is suppressing duplicate messages:

a From the HPOM console, select Actions = Server = Configure. The Configure
Management Server window opens.

b  Look for the “Suppress and count duplicate messages” check box. If this box is
checked, uncheck it.

Check the /<%0VAgentDir>/log/wbsspi/discovery.log file for additional
information.

Restart the HPOM management server:
a Stop all HPOM GUIs that are running by selecting File — Exit.

b  Stop the HPOM management server processes. Enter:
/opt/OV/bin/ovstop opc ovoacomm

¢ Delete all HPOM temporary files. All pending messages (messages not saved in the
database) and all pending actions (automatic actions, operator-initiated actions,
scheduled actions, and command broadcast) are lost. Enter:
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*
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d Restart the HPOM management server process. Enter:
/opt/0OV/bin/OpC/opcsv -start
/opt/0OV/bin/OpC/opcsv -status

e Restart the HPOM GUI. Enter: opc

Troubleshooting Applications

Problem

Configuration variable SERVER<n> STOP CMD missing for server Default
Server

Solution

Before you can successfully run the Stop WebSphere application, you must
set the STOP_CMD and USER properties. Set these properties using the
Configure WBSSPI application. See Configure WBSSPI on page 172 for
more information about this application.

Problem

Configuration variable SERVER<n> START CMD missing for server, Default
Server

Solution

Before you can successfully run the Start WebSphere application, you
must set the START_CMD and USER properties. Set these properties
using the Configure WBSSPI application. See Configure WBSSPI on
page 172 for more information about this application.

Problem

For WebSphere 6.1, Stop WebSphere application does not stop WebSphere
Application Servers.

Cause

Stop WebSphere application does not work well if security is enabled in

WBS and the username/password options are specified while setting the
STOP_CMD property.

Workaround

Edit the <connection type>.client .props file on the managed node. For
details see
http:/www-1.ibm.com/support/docview.wss?uid=swg21142299

Problem

When launched, the Verify application gives improper output.

Solution

Before you launch the Verify application, ensure that you installed the
latest version of Self-Healing Service (SHS) component (version 2.20) from
the SPI DVD. If you upgrade WebSphere SPI without the SPI DVD, you
must upgrade the SHS component also. You can download the SHS
component from
http:/support.openview.hp.com/self healing _downloads.jsp.
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Problem

When launched, the Self-Healing Info application gives improper output.

Solution

Ensure that you installed the latest version of Self-Healing Service (SHS)
component (version 2.20) from the SPI DVD. If you upgraded

WebSphere SPI without the SPI DVD, you must upgrade the SHS component
also. You can download the SHS component from
http://support.openview.hp.com/self healing downloads.jsp.

Problem

When launching the applications, the applications hang or there is no output.

Solution

The applications will not work if the memory is low. Check the performance
of the node and the management server. The physical memory available
must be more than 500 MB.

Problem

Check WebSphere application shows a wrong status for a server instance or
does not give any output.

Solution

If a server is up and running but Check WebSphere application returns the
server status as NOT_RUNNING (or does not give any output), turn ON the
monitoring for that particular server by using the Start Monitoring
application.

Problem

Datasource not getting created on RHEL 4.0 platform.

Solution

Ensure that you installed the latest version of DSI2DDF component
(02.22.000) from the SPI DVD. If you upgraded WebSphere SPI without the
SPI DVD, you must upgrade the DSI2DDF component also. You can
download the latest DSI2DDF component from:
ftp://ovrntfs.rose.hp.com/prelim/dsi2ddf/02.22/HPUX11.00/
DSI2DDF_A.02.22.00.depot
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Error Messages

This section provides information on error messages resulting from conditions detected in the
operation of the WebSphere SPI, not the WebSphere Server. The following error messages are
all within the WBSSPI Message Group.

For any given problem, only the most recent error message is displayed (the older error
message is automatically acknowledged). This reduces the number of error messages
displayed in the message browser.

WASSPI-]

Description | Unable to create the lock file <filename>. File already exists.
Severity Critical
Help Text Probable Cause:

Temporary lock files are used to avoid collisions when multiple WebSphere SPI data
collector processes attempt to access the same data file. This error occurs when the lock file
cannot be created after several attempts because it already exists.

Suggested Action:

If a file by the same name already exists, it might not have been deleted by a previous run
of the WebSphere SPI data collector. You should delete this file manually.

WASSPI-2

Description | Cannot access the SPI configuration.
Severity Critical
Help Text Probable Cause:
A WebSphere SPI configuration file could not be located or accessed. Either the file does
not exist or there was a problem reading the file.
Suggested Action:
1 Verify that the collector template that runs the WebSphere SPI data collector specifies
the correct directory on the command line. The option
-Dwasspi .config.dir=<configDirectory>must be specified on command line
invocation of the data collector. <configDirectory> must be /var/opt/OV/conf/wbsspi on
Unix platforms or \usr\OV\wasspi\wbs\conf on Windows platforms.
2 Verify that the WebSphere SPI has been configured correctly by running the Verify
utility from the Application Bank. If the configuration is not correct, run the
WebSphere SPI configuration utility from the Application Bank to reinstall the files.
3 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem, for example an I/O exception. You can view the
SPI error log for a managed node by using the 'View Error File' application in the
Application Bank window. You can view the SPI error log for a managed node by using
the 'View Error File' application in the Application Bank window. The error message
can be identified by the date/time stamp.
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WASSPI-3

Description | Error parsing command line.

Severity Critical

Help Text Probable Cause:

The WebSphere SPI data collector command line is incorrectly specified in a schedule
template.

Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help
identify the data collector command line syntax error. You can view the SPI error log
for a managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Ifthe error occurred in a schedule template that shipped with the WebSphere SPI,
reinstall the SPI and run the WebSphere SPI configuration utility from the Application
Bank.

3 Ifthe error occurred in a schedule template not shipped with the WebSphere SPI,
correct the schedule template that contains the incorrect command line. See the
WebSphere SPI User's Guide for more information on the WebSphere SPI data
collector command line.
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WASSPI-4

Description | Error getting the metric definitions.

Severity Critical

Help Text Probable Cause:

The WebSphere SPI data collector could not read the metric definitions XML document.
This error can be caused by a missing configuration property, an I/O error, an XML
parsing error, a missing file, or a corrupted serialized data file.

Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the 'View Error File' application in the Application Bank window. The error
message can be identified by the date/time stamp.

2 Ifthe METRIC_DEFINITIONS_FILE property is missing from the WebSphere SPI
configuration file, reinstall the SPI and run the SPI configuration utility from the
Application Bank.

3 Ifthe problem is with the metric definitions file (MetricDefinitions.xml) that is shipped
with the WebSphere SPI, reinstall the WebSphere SPI. Run the SPI configuration
utility from the Application Bank.

4 If the problem is with a user-defined metric definitions file that is not shipped with the
WebSphere SPI, verify that this XML file adheres to the MetricDefinitions.dtd
specification. See the HP Operations Manager Smart Plug-in for IBM WebSphere
Application Server SPI Configuration Guide for more information on writing
user-defined metrics. Reinstall your user-defined metric definition file. Run the SPI
configuration utility and verify that the UDM_DEFINITIONS_FILE property in the
SPI configuration file, is specified correctly.

5 If the underlying error is ClassNotFound, this is an internal error. Report this to HP
Support.

WASSPI-5

Description | Error processing metric <metric_number>.

Severity Major

Help Text Probable Cause:

An error occurred while trying to collect data or perform calculations for the specified
metric.

Suggested Action:

See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. The error messages previous to this one might also
provide more information about the problem. You can view the SPI error log for a managed
node by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.
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WASSPI-6

Description | Required property <property name> is missing from the WebSphere configuration.
Severity Major
Help Text Probable Cause:

The specified required property is missing from the WebSphere SPI configuration file.

Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you specified the correct server information for the WebSphere Servers on this
managed node.

2 Verify the property is specified correctly in the WebSphere SPI configuration file (/
var/opt/0OV/conf/wbsspi/SiteConfig on Unix platforms or
\usr\OV\wasspi\wbs\conf\SiteConfig on Windows platforms) on the managed
node in question.

WASSPI-7

Description | Unable to contact server <server_name> at url=<URL>, port=<port>.
Severity Critical
Help Text Probable Cause:

The specified server is not running at the specified port.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that you
specified the correct server name and port information for the WebSphere Servers on

this managed node.

2 Verify that the properties, SERVERx_NAME and SERVERx_PORT are specified
correctly in the WebSphere SPI configuration file (/var/opt/0OV/conf/wbsspi/
SiteConfig on Unix platforms or \usr\OV\wasspi\wbs\conf\SiteConfig on
Windows platforms) on the managed node in question.

3 Verify that the WebSphere Server is running on the managed node.
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WASSPI-8

Description | Error saving graphing or reporting data to file <file name>.
Severity Critical
Help Text Probable Cause:

If the error message specifies the reporting data file, the agent on the managed node might
be in an inconsistent state.

Suggested Action:
Restart the agent on the managed node.

Probable Cause:

The specified graphing or reporting data file could not be found or an I/O error occurred
when trying to access the file.

Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the WebSphere SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for
instructions on how to turn on tracing.

Run the Self-Healing Info application.
5 Contact HP support with the information gathered in the previous steps.

WASSPI-9

Description | Unable to retrieve property <property. name>.
Severity Critical
Help Text Probable Cause:

A required property is missing from one of the WebSphere SPI configuration files.

Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the WebSphere SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you specified the correct information for the WebSphere Servers on the managed node
in question.

3 Verify that the missing property is now specified in the WebSphere SPI configuration
file (/var/opt/0OV/conf/wbsspi/SiteConfig on Unix platforms or
\usr\OV\wasspi\wbs\conf\SiteConfig on Windows platforms) on the managed
node in question.
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WASSPI-10

Description | Encountered problem accessing file <filename>.

Severity Critical

Help Text Probable Cause:
The specified file could not be found, created, or accessed. This file could be a temporary
file.
Suggested Action:

1

See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.

WASSPI-11

Description | No servers were specified in the WebSphere SPI configuration file.
Severity Major
Help Text Probable Cause:

The number of WebSphere instances specified in the WebSphere SPI configuration file for
the managed node in question is 0.

Suggested Action:

1

Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you specified the correct server name and port information for the WebSphere Servers
on this managed node.

Verify that the property, NUM_SERVERS, in the WebSphere SPI configuration file
(/var/opt/0OV/conf/wbsspi/SiteConfig on Unix platforms or
\usr\OV\wasspi\wbs\conf\SiteConfig on Windows platforms) is set to the
number of WebSphere Servers on this managed node.
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WASSPI-12

Description | Command <command> returned error exit code <exit code>.
Severity Critical
Help Text Probable Cause:

A command started by the WebSphere SPI collector has returned an error (non-zero) exit
code.

Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. See the WebSphere SPI User's Guide for
instructions on how to turn on tracing.

3 Run the Self-Healing Info application.
4 Contact HP support with the information gathered in the previous steps.

WASSPI-13

Description | Exception occurred while running an opcmon process.
Severity Critical
Help Text Probable Cause:

The WebSphere SPI data collector attempted to run a process to execute an opcmon call.
Either the process could not be created or was interrupted.

Suggested Action:

For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are
set high enough to allow process creation.

WASSPI-14

Description

Unable to find file <file_name>.

Severity

Critical

Help Text

Probable Cause:
A file required by the WebSphere data collector could not be found.
Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.

Reinstall the WebSphere SPI on the managed node.

Run the WebSphere SPI configuration utility from the Application Bank.
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WASSPI-15

Description | Error parsing XML document <file_name>.

Severity Critical

Help Text Probable Cause:
An error occurred while parsing the specified XML document.
Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.

2 Ifthe XML document was provided by the user, correct the document. See the HP
Operations Manager Smart Plug-in for IBM WebSphere Application Server SPI
Configuration Guide for more information about the correct format for a user-defined
metric definition document.

3 If the XML document is a document that is shipped with the WebSphere SPI, run the
SPI configuration utility from the Application Bank to reinstall the WebSphere SPI
configuration files.

WASSPI-16

Description | A bad filter (<filter_value>) was specified for metric <metric_number>.
Severity Major
Help Text Probable Cause:

A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action:

1 If the metric is specified in an XML document that was provided by the user, correct
the document. See the HP Operations Manager Smart Plug-in for IBM WebSphere
Application Server SPI Configuration Guide for more information about the correct
format for a user-defined metric definition document.

2 Ifthe metric is a pre-defined metric that is shipped with the WebSphere SPI, run the
SPI configuration utility from the Application Bank to reinstall the WebSphere SPI
configuration files.
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WASSPI-18

Description | Error logging to datasource <datasource_class_name>. Logging process returned exit code
<exit_code>.

Severity Warning

Help Text Probable Cause:

The agent on the managed node might be in an inconsistent state.
Suggested Action:

Restart the agent on the managed node.

Probable Cause:

The ddflog process started by the WebSphere SPI data collector returned a non-zero error
code.

Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for
instructions on how to turn on tracing

3 Run the Self-healing Info application.

Contact HP support with the information gathered in the previous steps.

WASSPI-19

Description | Encountered problem instantiating XSLT transformer with <file_name>.
Severity Major
Help Text Probable Cause:

The XSL document that specifies the auto action report output contains errors.
Suggested Action:

1 Reinstall the WebSphere SPI.

2 Run the WebSphere SPI configuration utility from the Application Bank.

WASSPI-20

Description | Encountered problem creating report for metric <metric_number>.

Severity Major

Help Text Probable Cause:
An error occurred while producing a text report for the specified metric.
Suggested Action:
1 Reinstall the WebSphere SPI.
2 Run the WebSphere SPI configuration utility from the Application Bank.
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WASSPI-21

Description | Encountered problem instantiating factory implementation <class name>.
Severity Critical
Help Text Probable Cause:

The java property specifying the class name is incorrect or the class does not implement
the AppServerFactory interface.

Suggested Action:

Verify that the java property appserver. implementation is set to the fully qualified
name of the class which implements the AppServerFactory interface.

For example, if set on the java command-line:

-Dappserver.implementation=com.hp.openview.wasspi.WBSAppServerFactory

WASSPI-22

Description

The PMI instrumentation level was changed from <old_level> to <new_level> for module
<module_name> in server <server_name>.

Severity

Warning

Help Text

Probable Cause:

A requested metric's impact rating exceeded the instrumentation level settings of the
application server. The instrumentation level of the appropriate PMI module was raised to
enable collection of the requested metric.

WASSPI-23

Description | Error initializing collector analyzer for server <server_name>.
Severity Critical
Help Text Probable Cause

An exception was encountered while preparing to monitor server <server_name>.
Suggested Action

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the WebSphere SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for instructions
on how to turn on tracing.

Run the Self-healing Info application.

5 Contact HP support with the information gathered in the previous steps.
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WASSPI-24

Description | Error logging in to server <server_name> with login <login>.
Severity Critical
Help Text Probable Cause:

A security exception occurred while logging in to server <server_name>.
Suggested Action:
1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that you specified the correct login and password on the managed node on which
the error occurred.

3 Verify that the login has appropriate permissions.

WASSPI-25

Description | Performance monitoring service is not enabled on server <server_name>.
Severity Warning
Help Text Probable Cause:

PMI service is not enabled on server <server_name>.
Suggested Action:
1 Use the WebSphere Administrative Console to enable PMI on server <server_name>.

2 Restart server <server_name>.

WASSPI-26

Description | The data logging process for server <server_name> timed-out.
Severity Major
Help Text Probable Cause
Depending on your configuration, either HP Performance Agent or CODA failed to exit
before the time-out.
Suggested Action
1 Restart CODA using command opcagt -start.
2 Restart HP Performance Agent using command mwa restart.
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WASSPI-27

Description | RMI collector unable to process <command>.

Severity Warning

Help Text Probable Cause
An exception was encountered while performing an rmid related operation.
Suggested Action

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node
by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for instructions
on how to turn on tracing.

Run the Self-healing Info application.

5 Contact HP support with the information gathered in the previous steps.

WASSPI-30

Description | Failed to start <rmid_path> on port <port>.

Severity Critical

Help Text Probable Cause:
The specified path is already in use.
Suggested Action:

Run the WebSphere SPI configuration utility from the Application Bank. Set the
RMID_PORT property to a port number which is not currently in use.

WASSPI-31

Description | Lost connection to RMI collector while processing <command>.

Severity Warning

WASSPI-32

Description | Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning
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WASSPI-33

Description | No actions matched server <server name>, version <version>.
Severity Warning
Help Text Probable Cause: JMXAction elements define FromVersion and ToVersion tags which do

not match the server version.

Suggested Action: If the action is valid on the server, adjust either the JMXAction
definition's FromVersion/ToVersion elements or the server's VERSION property.

WASSPI-34

Description | Metric <metric id> does not define any actions.
Severity Warning
Help Text Probable Cause: The metric ID specified with the action -m option does not define a

JMXActions element.

Suggested Action: Correct the action -m option if an incorrect metric ID was specified.
Otherwise, add a JMXActions definition to the metric definition.

WASSPI-35

Description | Error executing action <action command-line>.
Severity Major
Help Text Probable Cause:
An unexpected error occurred while executing the action.
Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following
the error message.

WASSPI-36

Description

MBean <JMX objectname> on server <server name>, does not expose operation <operation
name>.

Severity Warning
Help Text Probable Cause:
An action's JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action:
Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

Description

MBean <JMX objectname> on server <server name>, does not expose attribute <attribute
name> for write.

Severity

Warning

Help Text

Probable Cause:

An action's JMXCalls element defines a write attribute exposed by the specified MBean as
read-only.

Suggested Action:

If it is a custom MBean, update the MBean's management interface so the attribute is
writable. Otherwise, remove the attribute definition from the JMXCalls element.

WASSPI-38

Description

MBean <JMX objectname> on server <server name>, does not expose attribute <attribute
name>.

Severity

Warning

Help Text

Probable Cause: An action's JMXCalls element defines an attribute not exposed by the
specified MBean ObjectName.

Suggested Action: Correct the JMXCalls element or remove the attribute from the
element.

WASSPI-39

Description | Error invoking operation <operation name> on MBean <JMX objectname>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while invoking an operation on the specified MBean. The
managed resource might have thrown an exception.

Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following
the error message.
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WASSPI-40

Description | Error setting attribute <attribute name> on MBean <JMX objectname>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while setting an attribute on the specified MBean. The
managed resource might have thrown an exception.

Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-41

Description | Error getting attribute <attribute name> from MBean <JMX objectname>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while getting an attribute from the specified MBean. The
managed resource might have thrown an exception.

Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following
the error message.

WASSPI-42

Description

Error running command <command>.

Severity

Critical

Help Text

Probable Cause

A command started by the WebSphere SPI collector reported an error.
Suggested Action

1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. See the WebSphere SPI User's Guide for
instructions on how to turn on tracing.

3 Run the Self-healing Info application.
Contact HP support with the information gathered in the previous steps.
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WASSPI-43

Description | Error publishing event <event-type>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action

View the managed node’s error log to determine the cause which is logged following the
error message.

WASSPI-201

Description | File <filename> not found.

Severity Critical

Help Text Probable Cause:
A configuration file could not be found.
Suggested Action:

Run the WebSphere SPI configuration utility from the Application Bank. Verify that the
correct information was specified for the WebSphere Servers on the managed node on
which the error occurred.

WASSPI-202

Description | Cannot read file <filename>.
Severity Critical
Help Text Probable Cause:

e A file could not be opened or it could not be found.
¢ Permissions might be incorrect or a directory might be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information was specified for the WebSphere Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.
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WASSPI-203

Description | Cannot write file <filename>.
Severity Critical
Help Text Probable Cause:

Permissions might be incorrect, or a file or directory might be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information was specified for the WebSphere Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the ITO user to write this file.

WASSPI-204

Description | Error sending opcmsg <message>.
Severity Critical
Help Text Probable Cause:

There was a problem running opcmsg. opcmsg might be missing or not have permissions to
execute (ITO installation errors) or the system process table might be full.

Suggested Action:
Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.

WASSPI-205

Description

Error sending opcmon <command>.

Severity

Critical

Help Text

Probable Cause: There was a problem running opcmon. opcmon might be missing or not

have permissions to execute (ITO installation errors) or the system process table might be
full.

Suggested Action:
Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.
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WASSPI-206

Description | Cannot read directory <directory>.

Severity Critical

Help Text Probable Cause:
The permissions on the directory prevent the ITO user from reading it or the directory is
corrupt.
Suggested Action:

Verify that the permissions are correct for the ITO user for this directory.

WASSPI-207

Description | Cannot move <filename> to <filename>.
Severity Critical
Help Text Probable Cause:

1

Insufficient permissions.

2 Insufficient disk space.
3 File table problems.
Suggested Action:

1

Verify that the permissions are correct for the ITO user.

2 Verify that there is enough disk space to create files.
3 Run the WebSphere SPI configuration utility from the Application Bank.

WASSPI-208

Description | WBSSPI must be configured before it can be used.
Severity Critical
Help Text Probable Cause:

The WebSphere SPI was not configured on this node.
Suggested Action:

1

Run the WebSphere SPI configuration utility from the Application Bank. Verify that

you specified the correct information for the WebSphere Servers on the managed node

on which the error occurred.

Run the Verify utility from the application band to confirm that the SPI was
successfully configured.
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WASSPI-209

Description | Cannot contact WebSphere Server.
Severity Critical
Help Text Probable Cause:

e The server could be down or not responding.

e The SPI might be configured incorrectly.
Suggested Action:

1 Verify that WebSphere is up and running properly.

2 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information was specified for the WebSphere Servers on the managed node
on which the error occurred.

WASSPI-210

Description | Cannot configure SPI.
Severity Critical
Help Text Probable Cause:

The SPI configuration process failed.
Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the underlying cause of the problem. The error messages previous to this one provides
more information about the problem. You can view the SPI error log for a managed
node by using the View Error File application in the Application Bank window. The
error message can be identified by the date/time stamp.

2 Reinstall the SPI and run the WebSphere SPI configuration utility from the
Application Bank.

WASSPI-211

Description | Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause: There are insufficient permissions for the ITO user to create the
directory or there is insufficient disk space.
Suggested Action:
Verify that the permissions are correct for the HPOM user for this directory. Verify that
there is enough disk space.
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WASSPI-213

Description | Improper parameters to program <name>. Usage: <usage>.
Severity Critical
Help Text Probable Cause:

The parameters to the program are incorrect.

Suggested Action:

Correct the parameters.

WASSPI-214

Description | Cannot run program <program name>.
Severity Critical
Help Text Probable Cause:

The program failed to run. It might be missing, permissions might be incorrect, the
process table might be full.

Suggested Action:

1 Verify that the file exists. If it is a SPI program and the file is missing, reinstall the SPI
and run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that the permissions are correct for the ITO user.

WASSPI-216

Description | Configuration variable <name> missing for server <server_name>.
Severity Critical
Help Text Probable Cause: A required SPI configuration variable was not found.

Suggested Action:
1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that the correct information was specified in the configuration for the managed
node on which the error occurred.
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WASSPI-218

Description | WebSphere monitoring has been turned OFF for <server_name>.

Severity Warning

Help Text Probable Cause:
Collection was turned off for the specified server.
Suggested Action:

Collection can be turned on by setting COLLECT = ON in the SiteConfig file in the SPI
configuration directory on the managed node. The configuration directory is /var/opt/
OV/conf/wbsspi on Unix platforms or \usr\OV\wasspi\wbs\conf on Windows
platforms.

WASSPI-219

Description | WebSphere monitoring has been turned ON for <server name>.

Severity Critical

Help Text Probable Cause:

Collection has been turned on for the specified server.

Suggested Action:

Collection can be turned on by setting COLLECT = OFF in the SiteConfig file in the SPI
configuration directory on the managed node. The configuration directory is /var/opt/

OV/conf/wbsspi on Unix platforms or \usr\OvV\wasspi\wbs\conf on Windows
platforms.

WASSPI-221

Description | <file_name> does not exist.

Severity Critical

Help Text Probable Cause:

The specified file does not exist. If it is a log file, no entries were ever logged to it. Ifitis a
property file, it has not been configured.

Suggested Action:

Log files: If there have never been any entries written to the file, no action is necessary.
Otherwise, run the WebSphere SPI configuration utility from the Application Bank.

Property files: Run the WebSphere SPI configuration utility from the application bank.
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WASSPI-222

Description | <file_name> is empty.
Severity Critical
Help Text Probable Cause:

The specified file is empty. If it is a log file, no entries were ever logged to it, or the entries
were cleaned out. If it is a property file, it is not properly configured.

Suggested Action:

If the file is a configuration file, run the WebSphere SPI configuration utility from the
Application Bank.

WASSPI-223

Description | Cannot read <file_name>.
Severity Critical
Help Text Probable Cause:

1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you specified the correct information for the WebSphere Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-224

Description | ddfcomp returned an error configuring <name>.
Severity Critical
Help Text Probable Cause: ddfcomp returned an error. This could be because neither

MeasureWare nor CODA is installed on the system or because of an error configuring
MeasureWare or CODA.

Suggested Action:
1 If the performance agent is not installed, this error can be ignored.
2 Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for
instructions on how to turn on tracing.

Run the Self-healing Info application.
5 Contact HP Support with the information gathered in the previous steps.
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WASSPI-225

Description | No logfiles were found. Did you run Configure WBSSPI?

Severity Critical

Help Text Probable Cause:
The logfile list is empty.
Suggested Action:

Reinstall the SPI and run the WebSphere SPI configuration utility from the Application
Bank.

WASSPI-226

Description | Cannot read file <file_name>.

Severity Critical

Help Text Probable Cause:

e A file could not be opened or it could not be found.

e Permissions might be incorrect or a directory might be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that you specified the correct information for the WebSphere Servers on the
managed node on which the error occurred.

3 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-227

Description | No HP performance agent is installed. Data source will not be configured.

Severity Warning

Help Text Probable Cause:

If a performance application is available, the SPI integrates with it. This warning
indicates that none is available.

Suggested Action:

If you must have a performance agent installed, verify that it is installed correctly and is
running; reinstall it if necessary. Otherwise, this message can be ignored.
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WASSPI-228

Description | ddflogreturned an error logging <logfile-name>: <system-error-msg>

Severity Critical

Help Text Probable Cause:

The agent on the managed node might be in an inconsistent state.
Suggested Action:

Restart the agent on the managed node.

Probable Cause:

ddflog returned an error. This could be because the SPI was not properly configured to
support logging performance data.

Suggested Action:
1 Try reconfiguring the WASSPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.

3 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for
instructions on how to turn on tracing.

4 Run the Self-healing Info application.
5 Contact HP Support with the information gathered in the previous steps.

WASSPI-229

Description | Cannot connect to directory <directory-name>

Severity Critical

Help Text Probable Cause:

The directory does not exist, or the user the agent is running under does not have
appropriate permissions to the directory.

Suggested Action:
1 Run the WebSphere SPI configuration utility from the Application Bank
2 Reinstall the SPI and run the WebSphere SPI configuration.
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WASSPI-230

Description | Cannot get lock <file> after <time>
Severity Critical
Help Text Probable Cause:

The lock file <file> was not cleared in the <time> indicated. This could be due to a very
slow running or hung SPI process. Possibly a SPI process that had a lock was killed before
the lock it had open had been cleared.

Suggested Action:
Make sure no SPI processes are running. Manually remove the lock file.

WASSPI-23]

Description | Error starting JRE <JVM_file>: <message>
Severity Critical
Help Text Probable Cause: Some error occurred starting Java. This could be that the specified JVM

does not exist, has bad permissions, or that there are system resource limitations such as
process table entries or memory, or that the JAVA_HOME variable in the SPI SiteConfig
file is not set correctly.

Suggested Action:

Check your JAVA_HOME or HOME variables in the SPI configuration file. Check for
other errors generated at the same time. They might indicate the real cause.

WASSPI-232

Description | Server <name> specified on command line, but not in configuration

Severity Critical

Help Text Probable Cause: There was a -i or —e specified on the collector command line which
specified a server name that was not listed in the SPI configuration. The collector only
knows about servers listed in the configuration.
Suggested Action:
1 Specify a correct server name on the command line.
2 Run the WebSphere SPI configuration utility from the Application Bank. Verify the

WebSphere Server names are correctly listed and spelled in the SPI configuration file.
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WASSPI-234

Description | Error running program <file>, return value: <n>
Severity Critical
Help Text Probable Cause:

The SPI attempted to run some application or auxiliary program and encountered an error
doing so. The application or program is shown in the message as <file> and the return code
from attempting to run it is shown as <n>.

Suggested Action:

If the application is a SPI application, make sure the SPI has been installed and
configured correctly. If not, reinstall or reconfigure. If it is a system application, make sure
there are no system problems that prevent the application from running.

WASSPI-235

Description | Restart of MeasureWare agents failed
Severity Warning
Help Text Probable Cause:

The SPI attempted to automatically restart the MeasureWare agents and the automatic
attempt failed.

Suggested Action:

Restart the MeasureWare agents manually using the mwa restart server command.

WASSPI-236

Description | Failure when running XSLT on <xml> with stylesheet <xsl/>: <message>
Severity Critical
Help Text Probable Cause:

As part of setting up graphing for user defined metrics, a translation of the UDM XML is
done. This message indicated that the translation failed for some reason.

Suggested Action:
Review the message shown. It is most likely that there is an error in the XML.

WASSPI-237

Description | Setting up Data Source <datasource>
Severity Normal
Help Text This is an informational message that a HP Performance Manager or MeasureWare

datasource was setup.
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WASSPI-238

Description | No User Defined Metrics found
Severity Warning
Help Text Probable Cause:

The UDM Graph Enable application was run, but no UDM metrics had been defined.
Suggested Action:
Check that the UDM XML file has been named correctly.

WASSPI-240

Description | UDM Data Logging integration Complete
Severity Information
Help Text The UDM Graph Enable application successfully executed and UDM graph metrics will be

available for graphing.

WASSPI-241

Description | Cannot delete file <file>
Severity Critical
Help Text Probable Cause:

The SPI attempted to delete a file, but was unable to do so. It might be that the protection
of the file is set so that the ITO user cannot delete it, or that there is some system problem
preventing the file from being deleted.

Suggested Action:

Make sure the protection of the file is correct.

WASSPI-242

Description | UDM graphing successfully disabled.
Severity Information
Help Text The UDM Graph Disable application successfully executed.
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WASSPI-254

Description | Java exited with an error
Severity Critical
Help Text Probable Cause:

While running the collector or other java application, either Java encountered an error of
some kind, or the Java application exited with an error exit.

Suggested Action:
Check for other errors generated at the same time, they might indicate the real cause.
Review the SPI's error log. It might give some other clues.

WASSPI-303

Description

The SPI configuration for <node_name> was updated by discovery in the HPOM server.

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. This message is sent to inform an operator
that the WBSSPI Discovery has:

e Found WebSphere application servers on a managed node that were not been
configured,

e Found new WebSphere application servers on a configured node
e Detected changes in the application servers configuration.

The WBSSPI-Discovery components automatically update these changes in the SPI
configuration.

Review the new configuration details that are included as part of the message text and
verify the information for correctness.

WASSPI-501

Description

Retrieving configuration data from the HPOM server

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
‘A’ (Action) column for this message should change from R (running) to S (success).

If the entry in this column changes to F (fail), the operation was not completed
successfully. Select this node and run the Discovery application again.

If the problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions on
how to manually configure the WebSphere SPI.

Basic Troubleshooting and Error Messages 133



WASSPI-502

Description

Updating the WBSSPI configuration data with discovered information

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
‘A’ (Action) column for this message should change from R (running) to S (success).

If the entry in this column changes to F (fail), the operation was not completed
successfully. Select this node and run the Discovery application again.

If the problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions on
how to manually configure the WebSphere SPI.

WASSPI-503

Description

The configuration for <node_name> node was automatically updated by the WBSSPI
Discovery ...

Help Text

This is a normal operation performed by the WBSSPI Discovery policy action. It sends this
message to inform an operator that the WBSSPI Discovery either discovered WebSphere
application servers on a managed node that was not configured or detected changes in the
application servers configuration. The Discovery components automatically update these
changes in the SPI configuration.

Review the new configuration details that are included as part of the message text and
verify the information for correctness. The new configuration can also be viewed by
launching the WBSSPI Configure application.

WASSPI-541

Description

No running WebSphere application servers found
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Help Text Probable Cause: A WebSphere application server is not present (or not running) on the
node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Make sure that all of the application servers you want to monitor are running, before the
WBSSPI-Discovery template is deployed or the Discovery application is launched. Only the
servers that are running will be automatically configured.

NOTE: If it is confirmed that WebSphere application servers exist on the system and are in
the running state, this message indicates that the WBSSPI Discovery is unable to discover
the application servers. Try the followings:

1 Launch the Discovery application.

2 Select the Default Properties item corresponding to this managed node. Select the
HOME_LIST property from the Select a Property to Set... menu and click Set Property.

3 Enter the HOME directory where WebSphere application server programs are installed
on this node. If there are more than one installation instance of WebSphere, enter the
HOME directories, separated by a semicolon. (For example, /opt/WebSphere/AppServer;/
opt/ibm/ WebSphere5/AppServer).

Click Next and complete the operation.

5 Allow the WBSSPI Discovery application to complete. (A message starting with
WASSPI-303 appears in the message browser with the node name embedded in the
message text).

If the WBSSPI configurations are not properly updated and the application servers are not
displayed on the Service Navigator's Services tree, check the WBSSPI Discovery log file
called <OvAgentDir>/log/wbsspi/discovery.log on the managed node for any
ERROR log entries.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configuration. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.
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Help Text
Contd.

WebSphere Application Server Version 4
Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, start the
WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions on
how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

WASSPI-561

Description

Failed to communicate with the WebSphere 4 AdminServer on port: <port number>

Help Text

Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-562

Description | Security access failure. Missing or invalid LOGIN/PASSWORD parameter for WebSphere
4 AdminServer on port: <port number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configuration or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

WASSPI-563

Description | Security access failure. Invalid LOGIN/PASSWORD parameter for WebSphere 4
AdminServer on port: <port number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties) for this
node are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-564

Description

Security access failure. Unable to communicate with the WebSphere 4 AdminServer on
port: <port number>

Help Text

Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

138

Chapter 6



WASSPI-565

Description | Security access failure. Unable to log in to the WebSphere 4 AdminServer on port:
<port number>

Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Also make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-571

Description

Failed to communicate with WebSphere Application Server

Help Text

WebSphere Application Server versions 5

Probable Cause: A WebSphere application server is not present (or not running) on the
node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Make sure that all of the application servers you wish to monitor are running, before the
WBSSPI-Discovery template is deployed or the Discovery application is launched. Only
the servers that are running will be automatically configured.

WebSphere Application Server versions 5

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Configure
WBSSPI application and verify the accuracy of the information. The PASSWORD
information is encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

WASSPI-572

Description

WebSphere Login Error - Missing Login Data

Help Text

WebSphere Application Server versions 5

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Make sure that the LOGIN and PASSWORD properties for this node
are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.
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WASSPI-573

Description

WebSphere Login Error - Invalid Login Data

Help Text

WebSphere Application Server versions 5

Probable Cause: The discovery application was unable to authenticate itselfin a secured
WebSphere Server environment. This is likely due to incorrect values for the LOGIN and
PASSWORD properties being provided in the WBSSPI configurations for this node.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Make sure that the LOGIN and PASSWORD properties for this node
are present and valid in the WBSSPI configurations. Launch the Configure WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

WASSPI-58]

Description

INTERNAL ERROR - <error message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application might not
function properly due to one (or more) of the following conditions on the managed node:

e A WBSSPI Discovery application, script, or data file is missing, has been removed, or is
placed in non-standard directory paths.

e There were problems with the HP agent installation.
e The HP agents installation directory cannot be determined.

e HPOM operator account that runs the WBSSPI Discovery does not have the permission
to open/read the specified file or execute the required script/command.

¢ General network errors.

Suggested Action: Check with the HPOM or the IT specialist in the organization on

matters related to these issues. Once the problems are resolved, select the node and run
the Discovery application again.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

Contact your HP Support representative if the problem cannot be resolved or if further
assistance is needed.
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WASSPI-585

Description

SYSTEM ERROR - <error message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application might not
function properly due to one (or more) of the following conditions on the managed node:

e Operating system commands used by WBSSPI Discovery are missing, are removed, or
placed in non-standard directory paths.

¢ The system's PATH variable has not been set for certain system commands.

e Required operating system files or software installation registry cannot be found or is
in a non-standard directory path.

e HPOM operator account that runs the WBSSPI Discovery does not have the permission
to open/read system files or execute the necessary system commands.

® General network errors.

Suggested Action: Check with the HPOM or the IT specialist in the organization on

matters related to these issues. Once the problems are resolved, select the node and run
the Discovery application again.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.

WASSPI-591

Description

WEBSPHERE ERROR - <error message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application might not
function properly due to one (or more) of the following conditions on the managed node:

e WebSphere commands used by WBSSPI Discovery are missing, are removed, or placed
in non-standard directory paths.

e HPOM operator account that runs the WBSSPI Discovery does not have the permission
to open/read files or execute commands in the WebSphere installation directories.

Suggested Action: Check with the HPOM or the WebSphere application server specialist
in the organization on matters related to these issues. Once the problems are resolved,
select the node and run the Discovery application again.

Note: If problem persists, see Chapter 3, Configuring the WebSphere SPI for instructions
on how to manually configure the WebSphere SPI.
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Others

Description | An unknown error appears in the WebSphere SPI error log.

Severity Warning

Help Text Suggested Action:

1 See the text following the error message in the WebSphere SPI error log to help identify
the problem. You can view the SPI error log for a managed node by using the View
Error File application in the Application Bank window. The error message can be
identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. See the HP Operations Manager Smart
Plug-in for IBM WebSphere Application Server SPI Configuration Guide for
instructions on how to turn on tracing.

Run the Self-healing Info application.
5 Contact HP Support with the information gathered in the previous steps.
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A File Locations

You can find the WebSphere SPI configuration files and error logs in specific directories.

HPOM Management Server File Locations

Operating

System File File Location

HP-UX Configuration | /opt/OV/wasspi/wbs/conf
Solaris Configuration | /opt/OV/wasspi/wbs/conf

Managed Node File Locations

On Windows or UNIX managed nodes that were already running the WebSphere SPI and are
being switched to a non-root HTTPS agent environment (UNIX only: if these directories do
not exist, see the next table for file locations):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/OV/conf/wbsspi

HP-UX, Solaris, Linux | Error Logs /var/opt/OV/log/whbsspi

AIX Configuration | /usr/lpp/0OV/conf/wbsspi

AIX Error Logs /usr/lpp/0OV/1log/wbsspi

Windows (HTTPS) Configuration | \Documents and Settings\All
Users\Application Data\HP\HP BTO
Software\wasspi\wls\conf

Windows (HTTPS) Error Logs \Documents and Settings\All
Users\Application Data\HP\HP BTO
Software\wasspi\wls\log
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On newly configured WebSphere SPI managed nodes in the non-root HTTPS agent
environment (UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration |/var/opt/0OV/conf/wbsspi
HP-UX, Solaris, Linux | Error Logs /var/opt/0OV/log/wbsspi
AIX Configuration | /var/opt/OV/conf/wbsspi
AIX Error Logs /var/opt/OV/log/wbsspi
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B The Configuration

This appendix contains information about the configuration structure, how to use the
configuration editor, descriptions of the configuration properties, and samples of the
configuration.

Structure

For examples of the configuration, see Sample Configurations on page 167. The basic
structure of the configuration is (lines preceded by # are treated as comments and are
ignored):

# Global Properties
<property>=<value> ...

# GROUP Block
GROUP <group_ name>
{

<node name> ...

}

# NODE Block
NODE <node name | group name>

{

<property>=<value> ...

}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can
be overridden by properties set within a GROUP or NODE block or by server-specific
properties.

GROUP Block

# GROUP Block
GROUP <group name>
{

<node name> ...

}
GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block
<group_name> is repeated within the configuration, the last definition takes precedence.

<node name> lists the nodes in the group and is the primary node name configured in HPOM.
) The node name specified in a GROUP block matches the value returned by the HPOM

variable $OPC_NODES, which is the primary node name configured in HPOM.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the
Default Properties item in the <Group Name> folder.

NODE Block

# NODE Block
NODE <node name | group name>

{

<property>=<value> ...

}

Properties set in a NODE block apply to nodes belonging to the group defined by
<group_name> (to set common properties for a group) or to the specified <node_name> (to set
properties for a single node).

For a group, enter the <group name> defined by the GROUP block and define the group’s
common properties.

For a single node, enter the <node name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the
Default Properties item in the <Node Name> folder.

Server-Specific Properties

Each property specified as SERVER<n>_property refers to a specific WebSphere Server
instance. When more than one WebSphere Server instance is running on a given managed
node, the number <n> differentiates the servers. Numbering begins at “1” and each
WebSphere Server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:
1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 <property> (global property)
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The Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the
configuration using this editor only.

The main features of the configuration editor are the following:

Configure WBSSPI - Tree

The Configure WBSSPI tree that appears in the left pane of the Configure WBSSPI
application’s main window shows the WebSphere SPI configuration in a tree structure.

The following is an example of the tree.

) If no application servers or groups are configured, the “Application Servers” and “Groups”
folders are not displayed. If you are running Configure WBSSPI for the first time and you did
not select any nodes before you launched the application, the “Nodes” folder is not displayed.

=F ] Configuration
=k 7 Defaults
I— Default Properties
=k T fpplication Servers
|— <App_Serverl_Name:
=F 7 Groups
.:l- 7 <Group_Mame:
I— Default Properties
=k T fpplication Servers
|— <App_Server?_Name:
=F ] Nodes
=k 7 <Mode_Name>
I— Default Properties
=k T fpplication Servers
|— <App_Server3_Name:

The icons are defined as follows:

The configuration properties can be viewed.

L

The configuration properties can be viewed and set.
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The following table lists each item in the tree:

Item Name

Description

Application Servers

A folder that contains a list of all the application servers.
This folder can appear under Defaults (global properties),
Group_Names (GROUP block), or Node_Names (NODE
block).

<Application_Server_Name>

The server name as defined in WebSphere.

Configuration

A folder that contains all WebSphere SPI configuration
information for the WebSphere environment.

Default Properties

Lists the configuration properties that were set. This item
appears under Defaults (global properties), Group_Names
(GROUP block), or Node_Names (NODE block).

Defaults

A folder that represents the global properties. Default
properties set at this level apply to all nodes. However,
these properties can be overridden by properties set under
the GroupName and Node_Name folders (see Property
Precedence on page 148).

Groups

A folder that represents the GROUP block.

<Group_Name>

A folder that identifies the name of a group of nodes with
common properties. Default properties set at this level
apply to all nodes that belong to the specified group. These
properties can be overridden by properties set under the
Node_Name folders (see Property Precedence on page 148).

Nodes

A folder that represents the NODE block.

<Node_Name>

A folder that represents a single node whose name matches
the value returned by the HPOM variable $OPC_NODES,
which is the primary node name configured in HPOM.
Default properties set at this level apply to the specified
node only (see Property Precedence on page 148).
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Configure WBSSPI - Buttons

The following buttons are available in Configure WBSSPI:

Button

Description

Cancel

Exit Configure WBSSPI.

If you set configuration properties without saving them, these changes are not
saved.

If you added or removed an application server, node, or group without saving the
change or if you modified a configuration property, a Confirm Cancel window
appears. Click Save and Exit to save the changes before exiting, Exit without Save to
exit without saving the changes, or Return to Editing to continue editing the
configuration (changes are not saved).

Finish

Exit Configure WBSSPI. Appears instead of the Next button if you launched
Configure WBSSPI without selecting any nodes.

Next

Exit Configure WBSSPI. Takes you to the “Confirm Operation” window that lists
the nodes you selected before you started Configure WBSSPI. The selected
managed nodes’ configurations are updated with your changes. If you made
changes to nodes that were not selected (are not displayed in the “Confirm
Operation” window), the changes are saved to the HPOM management server’s
configuration, but to make the changes to those managed node’s configuration,
you must select those managed nodes from the node bank, restart Configure
WBSSPI, and then exit.

Save

Save changes to the HPOM management server’s configuration and continue
editing the configuration. You can also select File > Save to save your changes.

Configure WBSSPI - Actions

Actions that you can perform depend upon the item that is selected in the tree and from where
you access the action. The following actions can be accessed from the Actions menu, File
menu, or by right-clicking on an item in the tree.

Action Description Selected Tree Item
Add Application Add an application server. See Add | 3 Application Servers
Server Application Server on page 152. 2 Defaults
A <Group_Name>
3 <Node_Name>
Add Group Create a group to which you can 3 Any item in the tree
assign nodes that have common e Any item in the tree
properties. See Add Group on
page 154.
Add Node Add a managed node to the Nodes 23 Any item in the tree
folder. Add Node on page 155. Any item in the tree

The Configuration
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Action Description Selected Tree Item
Exit Exit the Configure WBSSPI 3 Any item in the tree
application. This action is available | e Any item in the tree
from the File menu. If any changes
were made that were not saved, the
Confirm Cancel window appears.
Remove Application| Remove an application server or all | :3 Application Servers
Server/Remove ALL| listed application servers. See <Application Server Name>
App Servers Remove Application Server/Remove

ALL App Servers on page 155.

Remove Group/
Remove ALL
Groups

Remove a WebSphere SPI group or
all listed WebSphere SPI groups. See
Remove Group/Remove ALL Groups
on page 155.

23 Groups

3 <Group_Name>

Remove Node/
Remove ALL Nodes

Remove a managed node or remove
all managed nodes. See Remove
Node/Remove ALL Nodes on

page 156.

3 Nodes
3 <Node_Name>

Save

Save changes to the configuration.
This action is available from the File
menu only if changes were made to
the configuration.

23 Any item in the tree
Any item in the tree

Set Configuration

Set WebSphere SPI configuration

B <Application_Server. Name>

Properties tab properties. See Set Configuration e Default Properties
Settings Tab on page 156.

View Configuration | View WebSphere SPI configuration | :3 Any item in the tree

Settings tab properties. See View Configuration | ef Any item in the tree

Settings Tab on page 157 .

Add Application Server

Add an application server at the global properties, GROUP, or NODE level in the WebSphere

SPI configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you
are prompted to set the ALIAS property (to uniquely identify each server). For more
information about the ALIAS property, see Property Definitions on page 161.
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The Configuration

Before adding an application server,

for WebSphere
Server version 4:

If the WebSphere administrative server port number is the same for all
managed nodes, set the PORT property at the global properties level.

If the WebSphere administrative server port number is the same for a
group, set the PORT property at the GROUP level.

If the WebSphere administrative server port number is the same for a
node, set the PORT property at the NODE level

Setting the PORT property at those levels enables you to use the “Use
inherited Server Port” check box. For more information about this
checkbozx, see step 4. For more information about setting the PORT
property, see Set Configuration Settings Tab on page 156 and
Configuration Properties on page 159.

for WebSphere
Server version 5,
6.0, and 6.1:

Set the PORT property to the application server’s
BOOTSTRAP_ADDRESS port number at the application server level of
configuration (the BOOTSTRAP_ADDRESS is unique for each server on
a managed node). For more information about setting the PORT
property, see Set Configuration Settings Tab on page 156 and
Configuration Properties on page 159.

To add an application server, follow these steps:

1 Right-click one of the following items in the tree: Defaults (global properties level),
Application Servers (global properties level), <Group_Name> (GROUP level), or
<Node_Name> (NODE level) and select Add Application Server.

The Configure WBSSPI Application: Add App Server window appears.

2 Enter the Application Server Name. This is the name of the application server as defined
in WebSphere and is case-sensitive.

3 Enter the Server Port.

For WebSphere Server version 4, this is the bootstrap port number for the WebSphere
administrative server.

For WebSphere Server version 5 and above, this is the BOOTSTRAP_ADDRESS port
number for the application server.

If the Use Inherited Server Port check box is selected, you must not enter a port number
in the Server Port field.

4 If available, select the Use Inherited Server Port: xxx check box if you want to use the
specified port number (“xxx”).

If the PORT property is not set, the check box is not available.

If you do NOT want to use the specified port number, unselect the check box and enter a
port number in the Server Port field.

If you select the check box, you must not enter a port number in the Server Port field.

The specified port number is determined by the value set for the PORT property at the
global properties, GROUP, or NODE level:

e Ifthe PORT property is set at the global properties level, WebSphere SPI is
configured to use this same port number on all nodes and groups for all WebSphere
version 4 administrative servers or for all WebSphere version 5 and above application
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servers. For WebSphere version 5 and above, if there is more than one application
server per node, only one server can use the inherited server port. The PORT property
must be edited for the other application servers.

e Ifthe PORT property is set at the GROUP level, WebSphere SPI is configured to use
this same port number for the group for all WebSphere version 4 administrative
servers or for all WebSphere version 5 application servers. For WebSphere version 5,
if there is more than one application server per node in the group, only one server can
use the inherited server port. The PORT property must be edited for the other
application servers.

The port number set at the GROUP level takes precedence over the port number set
at the global properties level.

e Ifthe PORT property is set at the NODE level, WebSphere SPI is configured to use
this same port number for that node for all WebSphere version 4 administrative
servers or for all WebSphere version 5, 6.0, and 6.1 application servers. For
WebSphere version 5, 6.0, and 6.1 if there is more than one application server per
node, only one server can use the inherited server port. The PORT property must be
edited for the other application servers.

The port number set at the NODE level takes precedence over the port number set at
the global properties level.

5 Click OK.
The NAME and PORT properties are set.
The application server is added and its properties are displayed. You can also set
additional configuration properties for this server. Set Configuration Settings Tab on
page 156 for more information.

6 Click Save to save your changes.
If you do not want to add this application server, right-click the application server name,
select Remove Application Server, and click Save.

Add Group

Assign nodes to a group that have common properties in the WebSphere SPI configuration.

To add a group, follow these steps:

1

Right-click any item in the tree and select Add Group.
The Configure WBSSPI Application: Add Group window opens.

Enter the Group Name. The group name identifies the group of nodes with common
properties and is NOT case-sensitive.

Click OK.
The group is added and the Set Configuration Properties tab for the group is appears.

Select Add Node to Group, select one node from the list to add to the group, and click OK.
Repeat this step until all nodes are added to the group.

Set the configuration properties for this group using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab on page 156.

Click Save to save your changes.

If you do not want to add the group, right-click the group name, select Remove Group, and
click Save.
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Add Node

Add a managed node to the WebSphere SPI configuration.

To add a node, follow these steps:

1

Right-click any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the following
message appears:

All available managed nodes have been added to the configuration.
Click OK to exit this action.

From the pulldown menu, select a node to add.

Click OK.

The node is added and the Set Configuration Properties tab for the node appears.

Set the configuration properties for this node using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab.

Click Save to save your changes.

If you do not want to add the node, right-click the node name, select Remove Node, and
click Save.

Remove Application Server/Remove ALL App Servers

Remove a WebSphere Server or all listed WebSphere Servers from the WebSphere SPI
configuration.

To remove an application server, follow these steps:

1

Right-click the application server name and select Remove Application Server.

The selected application server name is removed from the list and its configuration
properties are removed from the configuration.

Click Save to permanently remove the application server.

Click Cancel to cancel the removal of the application server (the application server name
appears the next time you run Configure WBSSPI). In the “Confirm Cancel” window, click
Exit without Save.

To remove ALL application servers, follow these steps:

1

Right-click the Application Servers folder and select Remove ALL App Servers.

The selected Application Servers folder and all application servers listed in the selected
folder are removed (all configuration properties for the listed application servers are
removed from the configuration).

Click Save to permanently remove the application servers.

Click Cancel to cancel the removal of all application servers (the Application Servers
folder and all application server names listed in the folder appear the next time you run
Configure WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

Remove Group/Remove ALL Groups

Remove a WebSphere SPI group or all listed WebSphere SPI groups from the WebSphere SPI
configuration.
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To remove a group, follow these steps:

1

Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed
from the configuration.

Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you
run Configure WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the WebSphere SPI configuration.

To remove a node, follow these steps:

1

Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed
from the configuration.

Click Save to permanently remove the node.

Click Cancel to cancel the removal of the node (the node name appears the next time you
run Configure WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

To remove ALL nodes, follow these steps:

1

Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all
configuration properties for the listed nodes are removed from the configuration).

Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed
in the folder appear the next time you run Configure WBSSPI). In the “Confirm Cancel”
window, click Exit without Save.

Set Configuration Settings Tab

Set WebSphere SPI configuration properties at the global properties level or for the selected
application servers, groups (GROUP level), or nodes (NODE level).

Items with the p& icon are the only items for which you can set configuration properties
(Default Properties and <Application Server. Name>).

To set the configuration properties of an item, select the item and click the Set Configuration
Properties tab in the right pane.

Setting a Property

To set a property in the configuration, follow these steps:

1

2
3
4

Select a property from the “Select a Property to Set” pulldown menu.
Select Set Property. The property and an empty value filed appear in the table.
Click the empty value field and enter a value.

Repeat steps 1 through 3 for each property to set.
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5 Click Save.

) For the LOGIN and PASSWORD properties, when you select Set Property, a separate window
opens. Enter the login and password values in this window.

For more information about individual properties, see Configuration Properties on page 159.

Modifying a Property

To modify a property (except LOGIN) in the configuration, follow these steps:
1 Select the property from the table.

2 Double-click the value field.

3 Edit the value.

If a node contains duplicate server names (the NAME property is set to the same value),
you are prompted to set the ALIAS property (to uniquely identify each server). See
Property Definitions on page 161.

4  Repeat steps 1 through 3 for each property to modify.

5 Click Save.

To modify the LOGIN property in the configuration, follow these steps:

1 Select LOGIN/PASSWORD from the Select a Property to add pulldown menu.

2 Select Set Property. The Set Access Info for Default Properties window opens.
3 Enter the new password and verify password.

4 Click OK.

5 Click Save.

Removing a Property

To remove a property from the configuration, follow these steps:
1 Select the property from the table.

2 Click Remove Property.

3 Repeat steps 1 and 2 for each property to remove.

4  Click Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the
AUTO_DISCOVER property. You can only set this property by selecting or unselecting the check
box.

Selecting the check box (default) causes the discovery templates (if distributed) to
automatically update the WebSphere SPI configuration information in the service map and
configuration. If the discovery templates are not distributed, the service map is created but
not updated.

View Configuration Settings Tab
View all WebSphere SPI configuration properties set in the configuration on the

HPOMHPOM management server or the WebSphere SPI configuration properties for the
selected application servers, groups, or nodes.
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To view the configuration properties of an item, select the item and click the View
Configuration Settings tab in the right pane.

The following table describes the view when the specified item is selected.

Item Name Description of View

Application Servers View all configuration properties set for all the listed
application servers.

<Application_Server_Name> | View all configuration properties set for the application
server (these properties can be modified by selecting the Set
Configuration Properties tab).

Configurations View all configuration properties saved in the configuration
on the HPOM management server.

Default Properties View all configuration properties that are set (these
properties can be modified by selecting the Set Configuration
Properties tab).

Defaults View all configuration properties set at the global properties
level.

Groups View all configuration properties set for all the listed groups.

<Group_Name> View all configuration properties set for the specific group.

Nodes View all configuration properties set for the listed nodes.

<Node_Name> View all configuration properties set for the specific node.

View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting
this check box, the view of the configuration properties changes to show all inherited
properties (those properties defined at a global properties level or GROUP level) that affect
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By unselecting this check box, the view shows only the configuration properties set at that
level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after the
property, the property cannot be modified at that level. For example, if the property HOME is
set at the global properties level (under the Defaults folder), it can only be modified in the
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after
it) in a <Group_Name>'s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree.
For example, if the property HOME is set at the global properties level (under the Defaults
folder) and the property HOME is set at the GROUP level, the GROUP level property value
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest:
1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level
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Configuration Properties

The Configuration

Table 12 on page 160 lists all properties by WebSphere SPI requirements, where:

Property Name of the property.

Requirements  Lists the property requirements for specific
components where:

R - Required: the property must be set.

C - Conditional: the property might need to be
set if certain conditions are met.

O - Optional: the property is not required for
the component to work.

blank - Not Applicable: the property does not affect
this component.

WebSphere SPI Configuration requirements for the WebSphere SPI
to work.

Discovery Requirements for the discovery process to work.
Process

Auto-Discovered The property is automatically set by the discovery

process.

Level of The level at which this property can be set within the
Configuration configuration structure.

Default The global, group, or node level within the
Properties configuration structure.

Application The server-specific level within the configuration
Server structure.

For a description of the property, see Configuration Properties on page 159.
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Table 12 Properties Listed by WebSphere SPI Requirements

Property

Requirements

WebSphere
SPI

Discovery
Process

Auto-
Discovered

Level of
Configuration

Default
Properties

Application

Server

HOME

C

v

v

JAVA_HOME

v

NAME

PORT

NI NN

ADDRESS

ALIAS

AUTO_DISCOVER

COLLECT_METADATA

NI N NS N I NN

GRAPH_URL

HOME_LIST

JMB_JAVA_HOME

JMX_CLASSPATH

NI N N RN N

LOGFILE

LOGIN

PASSWORD

PROFILE_HOME

NI NS RN RN N

RMID_PORT

RMID_START TIME

NI NN IENR RN

START_CMD

STOP_CMD

TYPE

<

USER

VERSION

NI NN IENR N

MAX_ERROR_LOG_SIZE

TIMEOUT

<

UDM_DEFINITIONS_SO
URCE

O| O] O Q| ] | Q| | | ] al a| a] al | a| al | al | | | " J| =
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Property Definitions

WebSphere SPI

Property Requirements Description
ADDRESS Conditional The domain name or IP address where the server is
Required if the server | listening. If not specified, the server is listening on the
is running on a virtual primary IP of the node on which the server is running.
IP address or is on a Example: SERVER]1_ADDRESS = product.hp.com
remote node
ALIAS Conditional Unique name on a managed node assigned to an application

Required if more than
one application server
on a system share the
same server name

server if more than one application server on a system
share the same server name. The alias, if set, is the name
used in messages, reports, and graphs (otherwise,
SERVER<n>_NAME is used).

If SERVER<n>_ALIAS is modified, the data for the old alias is
saved but is not mapped to the new alias.

Example:

NODE petstore.hp.com {
SERVER1 NAME=dog
SERVER]1 ALIAS=beagle
SERVER2 NAME=dog
SERVERZ ALIAS=dachshund

}

NODE flying ace.hp.com {
SERVER1 NAME=snoopy
SERVER1 ALIAS=beagle
SERVER2 NAME=snoopy
SERVER2 ALIAS=red baron

}

AUTO_DISCOVER

Conditional

Required if you do not
want the discovery
templates to
automatically overwrite
the configuration

Default: AUTO_DISCOVER check box is selected.

Select the AUTO_DISCOVER check box to automatically
update the WebSphere configuration information in the
service map and configuration.

Unselect the AUTO_DISCOVER check box if you do not
want the discovery templates to automatically overwrite the

information configuration information.
COLLECT_ Conditional Default: OFF. Enter “ON” to collect metadata (MBean
METADATA information) displayed by the JMX Metric Builder

Required if you want to
use the MBean
Explorer in the JMX
Metric Builder
application.

application. The metadata is used to create UDMs (user
defined metrics).

Metadata for each MBean server is temporarily saved to the
following file: /var/opt/OV/wasspi/wbs/
metadata/<managed node>/<NAME / ALTAS>.xml or
/var/opt/0OV/metadata/wbs/<managed node>/

<NAME | ALTAS>.xml (UNIX) or
<%0vAgentDir$¢>\wasspi\wbs\metadata\

<managed node>\<NAME | ALIAS>.xml (Windows)
where NAME and ALIAS are the properties set for the
managed node and ALTAS is always used if it is set.

The Configuration
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WebSphere SPI

Property Requirements Description
GRAPH_URL Conditional The fully-qualified URL used to launch HP Performance
Required if you want to Manager. Set at the global level only.
view graphs with HP | Example: GRAPH_URL=http://
Performance Manager | <server_name>:<port_no>/0OVPM
, the default port number is 8081 (PM 8.10 on Unix and
Windows)
HOME Required The directory where the WebSphere Server is installed.
Example:
HOME = /opt/WebSphere/AppServer or
HOME = C:\WebSphere\AppServer
HOME_LIST Conditional For Windows managed nodes only. A list of WebSphere
Required if the Server installation directories, each directory separated by
discovery process does |2 semicolon. Set this property only if there are multiple
not find multiple server | installations of the WebSphere Server on a Windows
installations on the managed node that the discovery process does not find.
same node After setting this property, run the Discover WebSphere
application.
JAVA_HOME Required The directory where Java is installed that is used by the

Required if using a
Java version not

collector. The value of JAVA_HOME must include the path
to JAVA .EXE (path to the Bin directory of Java) and not the

supplied with path to the actual JAVA_HOME directory.
WebSphere The java engine is expected to be $JAVA_HOME/bin/java.
Example: $JAVA_HOME = /opt/WebSphere/AppServer/
java/bin
JMB_JAVA_HOME Conditional The directory where Java (JDK 1.4.1 or higher) is installed

Required if you are

that is used by the JMX Metric Builder on the HPOM

using the JMX Metric | Management server. The JDK must be version 1.41 or
Builder higher.
JMX_CLASSPATH Conditional The location of the jar files implementing JMX.

Required if you are

Example: SERVER]1_JMX_CLASSPATH = /JMX/Sun/lib/

configuring a JMX jmxri.jar
collector
LOGFILE Conditional A comma-separated list of fully qualified filenames of
Required only if there | WebSphere Server logfiles.
are WebSphere logfiles | Example: SERVER1 LOGFILE =
to be monitored that /opt/WebSphere/myserver/websphere.log
are not the default ones| SERVER2 LOGFILE =
C:\WebSphere\myserver\websphere.log
LOGIN Conditional A WebSphere-defined user (not a system user) that is used
Required if security is | to monitor a WebSphere Server.
enabled on WebSphere | Example: SERVER1_LOGIN = janedoe
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Property

WebSphere SPI
Requirements

Description

MAX_ERROR_LOG_
SIZE

Optional

Required if you want an
error logfile larger than
2MB

Default: 2MB. The maximum number of MB allowed for
the error logfile. When the error logfile reaches the
maximum limit, it is renamed as a backup file and logging

resumes. When a new backup file replaces an old backup
file, the old backup is deleted.

Example: MAX_ERROR_LOG_SIZE = 20

NAME?

Required

The server name as defined in WebSphere. Use the
WebSphere administrative console to obtain this
information.

Example: SERVER]1_NAME = exampleServer

NUM_SERVERS

Optional

The number of WebSphere Servers on the managed node.
Example: NUM_SERVERS = 3

PASSWORD

Conditional

Required if security is
enabled on WebSphere

The password for the WebSphere-defined user (USER or
SERVER<n>_USER).

Example: SERVER]1_PASSWORD = janedoel23

PORTP

Required

For WebSphere Server version 4

Default: 900. The bootstrap port number for the
WebSphere administrative server. Verify that this is the
same as the port number configured in admin.config.

Example: SERVER1_PORT = 900

For WebSphere Server version 5 and above

Default: The bootstrap port number of the application
server. The bootstrap port number for the WebSphere
application server. Verify that this is the same as the port
number listed in the administrative console.

Example: SERVER1_PORT = 2809

PROFILE_HOME

Conditional

Required for
WebSphere Server
version 6.0 and 6.1

For WebSphere Server version 6.0

The directory for the application server profile:
<WebSphere Home>/profiles/default.
For WebSphere Server version 6.1

The directory for the application server profile:
<WebSphere Home>/profiles/AppSrv0l.

Examples:
PROFILE_HOME
default

PROFILE HOME =
C:\WebSphere\AppServer\profiles\AppSrv0l

/opt /WebSphere/AppServer/profiles/
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WebSphere SPI

Property Requirements Description
RMID_PORT Conditional Default: WebSphere Application Server 4: 9243;
Required if the default WebSphere Application Server 5: 9242;JMX connector:
port on which rmid 9241
listens is already in use| The port on which rmid listens. By default, if an HPOM
managed node is monitoring application servers and MBean
servers using the JMX connector, the SPI uses two ports
(one for the application servers and one for the MBean
servers). For example, if you are monitoring a WebSphere
Application Server version 5 and an MBean server, the SPI
uses port 9242 and 9241. If RMID_PORT is set, the SPI
uses this one port for all servers (this property cannot be set
at the application server level). For example, if you are
monitoring a WebSphere Application Server and an MBean
server and set RMID_PORT to 9250, the SPI uses port 9250
only.
Example: RMID PORT=9250
RMID_START_ Conditional Default: 30 (seconds)
TIME Required if rmid takes | The amount of time, in seconds, to wait for rmid to start
longer than 30 seconds | before timing out.
to start Example: RMID_START TIME=60
START CMD Conditional A system command that is run when the HPOM Application
Required if you want to | Bank Start WebSphere application is used. This command
start the WebSphere | is run by SERVER<n>_USER which must be configured in
application server from | order for the Start WebSphere application to work.
the HPOM console NOTE: This command must exit; that is, the WebSphere
process must run in the background or as a service, and it
must be protected from its parent process dying.
Example: SERVER1_START CMD = /sbin/init.d/
WebSphere start
STOP_CMD Conditional A system command that is run when the HPOM Application
Required if you want to | Bank Stop WebSphere application is used. This command is
stop the WebSphere run by SERVER<n>_USER which must be configured in order
application server from | for the Stop WebSphere application to work.
the HPOM console Example: SERVER1_STOP_CMD = /sbin/init.d/
WebSphere stop
TIMEOUT Optional Default: 120 (seconds). The maximum amount of time, in
seconds, WebSphere SPI tries to connect to WebSphere.
When the specified time is exceeded, WebSphere SPI sends
an alarm to the message browser indicating hat WebSphere
is unavailable. If metric I002_ServerStatusRep is being
collected, the unavailability of the server is logged.
If no time limit is desired, set this property to -1.
Example: SERVER1_TIMEOUT=30
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Property

WebSphere SPI
Requirements

Description

TYPE

Conditional

Required if you are

Default: websphere. The type of JMX connector server. Set
to websphere for WebSphere Server version 5 and ovrmi for

configuring a JMX other JMX connector servers.
collector Example: SERVER1_TYPE=ovrmi

UDM_DEFINITIONS_| Optional Default: /opt/0OV/wasspi /wbs/conf/

SOURCE wasspi_wbs_udmDefinitions.xml. The fully qualified path
name to or file name of the metric definitions XML file on
the HPOM management server. If a path name is set, the
wasspi_wbs_udmDefinitions.xml file is the assumed file
name of the UDM file.

Example: SERVER1_UDM_DEFINITIONS_SOURCE = /opt/OV/
conf /wbsspi /udm.xml
USER Conditional The system username for starting and stopping the
Required if you want to| WebSphere Server from the HPOM Application Bank.
start and/or stop the The default is the username under which the HP
WebSphere application | Operations agent runs.
server from the HPOM | Example: SERVER1_USER = websphere
console

VERSION Conditional Default: 4.0 0. The version number of the WebSphere

Required if you are
configuring remote
monitoring

Server in the format Major# <space> [Minor#] where:

e Major# - The primary version number (for example, for
example, if the version is 4.0.1 the Major# is 4.0)

e Minor# - The secondary version number (for example, if
the version is 4.0.1 the Minor# is 1).
If Minor# is not specified, the default value is 0.

Example: SERVER1_VERSION = 4.0 1
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165



a. For WebSphere Server version 4, the WebSphere administrative server displays the server names of all configured
application servers in a domain. Use these names when defining NAME.

=] S|
Console View Tools Help
® | & @ w| X K-
= % WebSphere Administrative Domain |2 Name
0 Virtual Hosts [ Installed EJB Hodules
[ Server Groups _|E2 Installed beb Hodules
= B3 Modes :
= ) dukat
£ B fpplication Servers
2 i (General MAdvanced [File [Transaction IV Settinas [Services [Custon |
(2 Generic Servers i
[ Enterprise Applications | mpplication Server name: “(lefault Serw
B2 Resources :

Enwironments [ Enviromment. ..

Working directory: |/aptAlebSphere/fppServersbin

Node startup state: [Last state

Maximum startup attemptss |2

Options,,.
Clear

Typ
@ 1716703 10:... Console Ready.

For WebSphere Server version 5 and above, the WebSphere administrative console displays the server names of
all configured applications servers. Use these names when defining NAME.

‘A websphere Administrative Console - Microsoft Internet Explorer provided by ard 4 -1oj x|
File Edt Wiew Faworites Took Help -
N JEIAE el el el R

| Aress [&] hitp:/inode2:9090/sdminjsscurefiogon.do =] @ Jurs ™

Home | Save | P | Logout | Help | B[B]
w 10z s . .
ser " Application Servers
oursunc?
Anspplication server |s & sarver which provides services required to run enterprize applcstions. 1]
B Servers
Applcabion Servers
B Applications Totat 1
B Resources [ Fiter
B Security B Preferences
B Erwironment New| Delete |
B System Admi — s
B Troubleshoating [T e ¢ sasdtt
| | - |sereen rode2
L
WebSphere Status [i] =Pravious Nexts February 24, 2004 7-45:06 P PST &
WebSphere Configuration Problems
Total Viorkzpace Flies 0 3 Totsl Configurstion Probiems D
[ Preterances
&7 pane [ [ BEvocaintrane:

b. For WebSphere Server version 4, the default value configured for PORT is 900. However, if the bootstrap port
number is configured in the HOME/bin/admin.config file, use the port number configured in this file. In
admin.config, search for com.ibm.ejs.sm.adminServer.bootstrapPort=<nnnnn>

For WebSphere Server version 5 and above, the default value configured for PORT is the bootstrap port number
for the application server. According to the WebSphere documentation, the port number can be found using the
administrative console: Servers — Application Servers — server_name — End Points
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Sample Configurations

The sample WebSphere SPI configurations with entries contained in this section illustrate
various features and utilization methods.

Example 1: Single Node/Two Servers

The following example is for a single node running two servers: the administration server and
one managed server. The properties HOME and JAVA_HOME are global defaults that apply
to all servers and nodes. When the file is saved, passwords are encrypted.

HOME = /opt/WebSphere/AppServer
JAVA HOME=/opt/WebSphere/AppServer/java

NODE main.hp.com

{
SERVER]1 NAME= adminserver
SERVER1 PORT= 900
SERVERI LOGIN= system
SERVER1 PASSWORD = password

SERVER2 NAME= managedserver
SERVER2 PORT= 905

SERVER2 LOGIN= system
SERVER2 PASSWORD= password

Example 2: Multiple Nodes/Repeated Properties

The Configuration

The following example shows how you can configure a group of related systems that have
numerous properties in common. Some nodes, however, might have one or two properties that
you need to specify differently. You can address these kinds of situations in two steps:

1 Use the Add Group action in the configuration editor to name the group, specify the nodes
in it, and set the configuration properties. See Add Group on page 154.

2 Use the Add Node action in the configuration editor to define individual node properties
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). See Add Node on page 155.

) Properties set for a node take precedence over the same properties set for a group.
For the complete order of property precedence, see Property Precedence on
page 148.

In the example, the global default properties HOME and JAVA_HOME are overridden for
node europa.hp.com. Since the start commands are set to use the system init command
/sbin/init.d/WebSphere start which runs at system boot and starts all of the
WebSphere Servers, we have configured USER to be root.

HOME = /opt/WebSphere/AppServer
JAVA HOME = /opt/WebSphere/AppServer/java
USER = root

GROUP production
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mercury.hp.com
venus.hp.com
mars.hp.com
jupiter.hp.com

NODE production
{
SERVER]1 NAME= partsserver
SERVER1 PORT= 900
SERVER]1 LOGIN= system
SERVER1 PASSWORD= password
SERVER1 ADMIN HOST= earth.hp.com
SERVER1 ADMIN PORT= 900
SERVER1 START CMD= /sbin/init.d/WebSphere start

SERVERZ2 NAME= orderserver

SERVER2 PORT= 910

SERVERZ LOGIN= system

SERVERZ2 PASSWORD= moresecret

SERVER2 START CMD= /sbin/init.d/WebSphere start

NODE jupiter.hp.com
{
SERVER1 PASSWORD= differentlpassword
SERVER2 PASSWORD= different2Zpassword
}

NODE europa.hp.com

{
SERVER1 HOME = /opt/websphere
SERVER1 JAVA HOME = /opt/websphere/java
SERVER]1 NAME= testserver
SERVER1 PORT= 920
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

Example 3: WebSphere Servers with Virtual IP Addresses

The following example shows how to configure WebSphere Servers that use virtual IP
addresses. The property SERVER<n>_ADDRESS is set to the name or IP address where the
server is listening.

NODE saturn.hp.com
{
SERVER1 HOME = /opt/WebSphere/AppServer
SERVER1 JAVA HOME = /opt/WebSphere/AppServer/java
SERVER]1 NAME= partsserver
SERVER1 PORT= 900
SERVER1 ADDRESS= juno.hp.com
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

168 Appendix B



SERVER2 HOME = /opt/WebSphere/AppServer
SERVER2 JAVA HOME = /opt/WebSphere/AppServer/java
SERVERZ2 NAME= orderserver

SERVER2 PORT= 901

SERVERZ2 ADDRESS= 15.15.1.1

SERVERZ LOGIN= system

SERVERZ PASSWORD= mypssword

Example 4: Administrative Privileges Using Same Login Information

The following example shows the location of the LOGIN and PASSWORD properties if this
information is used for all WebSphere administrative privileges. When the file is saved, the
password is encrypted.

HOME = /opt/WebSphere/AppServer

JAVA HOME = /opt/WebSphere/AppServer/java
LOGIN = admin

PASSWORD = password

NODE main.hp.com

{
SERVER]1 NAME = serverl
SERVERliPORT 900

SERVER2 NAME = server2
SERVER27PORT 905
}

NODE europa.hp.com

{
SERVER1 HOME = /opt/wbs/appserver
SERVER1 JAVA HOME = /opt/wbs/appserver/java
SERVER]1 NAME= testserver
SERVER1 PORT= 915

Example 5: Administrative Privileges Using Different Login Information

The Configuration

The following example shows the location of the LOGIN and PASSWORD properties if this
information is different for administrative privileges. On the main.hp.com node, SERVER1
and SERVER2 have separate administrative privileges. When the file is saved, the passwords
are encrypted.

HOME = /opt/WebSphere/AppServer
JAVA HOME = /opt/WebSphere/AppServer/java

NODE main.hp.com
{
SERVER1 NAME = serverl
SERVER1 PORT = 900
SERVER]1 LOGIN = serverl admin
SERVER1 PASSWORD = serverl password
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SERVERZ NAME = server2

SERVERZ PORT = 905

SERVER2 LOGIN = server2 admin
SERVERZ2 PASSWORD = server2 password

NODE europa.hp.com

{
LOGIN = europa_admin
PASSWORD = europa_ password

SERVER]1 NAME= testserver
SERVERl_PORT= 915

SERVER2 NAME= anotherserver
SERVERZ_PORT= 920
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C Applications

The WebSphere SPI applications include configuration and troubleshooting utilities.
WBSSPI Admin applications include:
e Configure WBSSPI

e Discover WebSphere

¢ Init Non-Root

e Self-Healing Info

e Start/Stop Monitoring

e Start/Stop Tracing

e Verify

e View Error File

e View Graphs

WebSphere applications include:

¢ Check WebSphere

e Start/Stop WebSphere

e View WebSphere Logs
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WABSSPI Admin Applications Group

172

The WBSSPI Admin applications group contains the following applications. These
applications require the “root” user permission, therefore it is recommended that this group is
assigned to the HPOM administrator.

Additional WBSSPI Admin applications for user defined metrics (UDMs) are available with
the SPIJMB software bundle. For more information about how to install the software bundle
and the additional applications, see the HP Operations Smart Plug-in for User Defined
Metrics User Guide.

Configure WBSSPI

The Configure WBSSPI application launches the configuration editor. You can use the
configuration editor to maintain the WebSphere SPI configuration by viewing, editing, or
setting configuration properties.

If you are configuring WebSphere SPI for the first time, use the Discover WebSphere
application to automatically set basic configuration properties. For more information, see
Chapter 3, Configuring the WebSphere SPI.

Function

The Configure WBSSPI application performs the following functions:

e Updates the configuration on the HPOM management server and selected managed
nodes.

¢ Creates the directories and files required by WebSphere SPI on the selected managed
nodes.

e Sets up data sources for reporting and graphing.
e Sets up the WebSphere Server log files and WebSphere SPI error log file for monitoring.

Configuration information for all WebSphere instances on all HPOM managed nodes is
maintained on the HPOM management server. In addition, every managed node maintains
information about WebSphere Application Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the HPOM
management server. However, when launching the Configure WBSSPI application if you
select a node, the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the
Configure WBSSPI application otherwise the changes are saved on the management server
by default.

To Launch the Configure WBSSPI Application

1 From the HPOM console, select the nodes in the Node Bank window.
2 Select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin — Configure WBSSPI. (If
the items do not appear, select Map = Reload.)

The Introduction window opens.

4  Select Next.
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5 The configuration editor opens. For more information about using the configuration
editor, see The Configuration Editor on page 149.

6 Optionally, select Save to save any changes made to the configuration. Once you save your
changes, you cannot automatically undo them.

7 Select Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Select OK.

’ If you click Cancel in the Confirm Operation window, the changes made by you are
not saved to the selected managed nodes’ configuration and remain in the
configuration on the management server. To make the changes to the selected
managed nodes’ configuration, you must select those nodes in the Node Bank
window, launch the Discovery application, click Next in the configuration editor,
and then click OK in the Confirm Operation window.

8 During configuration, if you added an application server or added/edited the HOME and/
or PORT properties, run the Discover WebSphere application on the managed nodes on
which the application server/properties were added or edited. Running the Discover
WebSphere application updates the service map.

Discover WebSphere

Applications

The Discover WebSphere application sets basic configuration properties needed for discovery.
It also launches the configuration editor through which you can configure the WebSphere SPI
by setting initial configuration properties.

Function

The Discover WebSphere application updates the configuration on the HPOM management
server and selected managed nodes.

Configuration information about the all the WebSphere Application Servers running on all
managed nodes is maintained on the management server. In addition, every managed node
maintains information about WebSphere Application Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the HPOM
management server. However, when launching the Configure WBSSPI application if you
select a node, the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the
Configure WBSSPI application otherwise the changes are saved on the management server
by default.

To Launch the Discover WebSphere Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Select WBSSPI > WBSSPI Admin and double-click Discovery.
(If the above does not appear as described, select Map - Reload.)

The Introduction window opens. This window contains brief information about the
Discovery application.
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Select Next.

4 A second Introduction window opens. This window displays information about which
properties might be required in order for the discovery process to work.

Read this information and select Next.

5 If you did not set the WebSphere SPI LOGIN and PASSWORD properties, the Configure
Access Info for Default Properties window opens.

If you set the LOGIN and PASSWORD properties, the configuration editor opens. Go to
the next step.

Set the LOGIN and PASSWORD properties to the WebSphere login and password
configured in Task 2: Collect WebSphere Login Information on page 43. The WebSphere
administrative login information is required when security is enabled. If security is not
enabled, leave these fields blank, select Next, and go to step 9.

The LOGIN and PASSWORD properties set in this window are used as the default
WebSphere administrative login and password (they are set at the global properties
level). That is, if no NODE level or server-specific LOGIN and PASSWORD properties are
set, this WebSphere login and password are used by WebSphere SPI for all administrative
privileges. For more information about the configuration structure, see Structure on
page 147.

If the WebSphere administrative login and password are the same for all WebSphere
application servers on all HPOM managed nodes, follow these steps:

a Set the LOGIN and PASSWORD properties in the Set Access Info for Default
Properties window.

b  Select Next.
¢ Gotostep 9.

If the WebSphere administrative login and password are different for different instances
of WebSphere, you must customize the WebSphere SPI configuration by setting the
LOGIN and PASSWORD properties at the NODE or server-specific level (for more
information about the configuration structure, see Structure on page 147):

a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere
login and password in the Set Access Info for Default Properties window.

b  Select Customize to open the configuration editor.

6 From the configuration editor, set the configuration properties. For more information
about using the configuration editor, see The Configuration Editor on page 149.

7 Select Next to save any changes and exit the editor.
8 The Confirm Operation window opens. Select OK.

’ If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discovery application, select Next from the configuration editor, and then select OK.
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Init Non-Root

The Init Non-Root application simplifies the configuration of a non-root HTTPS agent on a
UNIX managed node (OVO for UNIX 8.x only). For all the steps necessary to configure a
non-root HTTPS agent on a UNIX managed node see Configuring a Non-Root HTTPS Agent
on a UNIX Managed Node (OVO for UNIX 8.x Only) on page 53.

Function

The Init Non-Root application performs the following actions on the selected managed nodes:

1 Runs the wasspi wbs perl -S wasspi wbs makePlatdef -force command to set the
proper SPI path configuration and updates the
/var/opt/OV/bin/instrumentation/wasspi wbs platdef.pmand
wasspl wbs platdef.prop files.

2 Generates the wasspi wbs sudoers configuration file on the selected managed nodes.
To Launch the Init Non-Root Application

1 From the HPOM console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin — Init Non-Root.
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Self-Healing Info

The Self-Healing Info Application collects data that you can send to your HP support
representative.

Required Setup

If you are collecting data for a reproducible problem, follow these steps before running the
Self-Healing Info application:

1 Run the Start Tracing application. For more information, see Start/Stop Tracing on
page 177.

2 Reproduce the problem.

Function

Self-Healing Info application performs the following functions:
e Saves data in in the following file:
— on a UNIX managed node: /tmp/wasspi wbs support.tar

— on a Windows managed node: wasspi wbs support.zip in $TEMP% directory .

’ This file might be hidden on some Windows managed nodes. If you do not see the
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click
the View tab. Under Hidden files and folders, select Show hidden files and folders.

e Launches and saves data using the Verify application (for more information, see Verify on
page 178).

To Launch the Self-Healing Info Application

1 From the HPOM console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.
3 In the Application Bank window select WBSSPI > WBSSPI Admin — Self-Healing Info.

You can launch this application to collect data that you can send to the HP support
representative.

Required Setup

If you are collecting data for a reproducible problem, follow these steps before launching the
Self-Healing Info application:

1 Launch the Start Tracing application. For more information see Start/Stop Tracing on
page 177.

2 Reproduce the problem.
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Start/Stop Monitoring

The Start or Stop Monitoring applications allow you to start or stop the WebSphere SPI from
collecting metrics for one application server or all application servers on a managed node.

Metrics generate alarms (when thresholds are exceeded) and you can use them to create
reports (automatically or manually generated) and graphs. The reports and graphs help in
analyzing trends in server usage, availability, and performance.

Typically, you might stop monitoring on a managed node if the node is not running for a
known reason (for example, the node is down for maintenance). Stopping the monitoring
prevents unnecessary alarms from being generated.

Run the Verify application to determine if monitoring is started or stopped. By default,
monitoring is on.

Function

The Start Monitoring application starts the collection of metrics for one or all application
servers on a managed node.

The Stop Monitoring application stops the collection of metrics for one or all application
servers on a managed node.

To Launch the Start or Stop Monitoring Application

1 From the HPOM console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Start
Monitoring or Stop Monitoring.

Start/Stop Tracing

The Start or Stop Tracing applications allow you to start or stop gathering tracing
information for the collection of metrics. Run this tool only when instructed by your HP
support representative.

The Self-Healing Info application collects the files created by this application as a part of the
data that the HP support representative can use.

Function

The Start Tracing application saves information about the collection of metrics in a file.

The Stop Tracing application stops saving information about the collection of metrics.

To Launch the Start or Stop Tracing tools

1 From the HPOM console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Start
Tracing or Stop Tracing.
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Verify

>»

The Verify application enables you to verify if WebSphere SPI is installed and configured
correctly on the server or managed node.

Before you launch the Verify application, ensure that you installed the latest version of
Self-Healing Service (SHS) component from the SPI DVD.

Function

The Verify application performs the following functions:

¢ On all managed nodes:

e Checks that the following directories exist:

<OV_AGT_DIR>/wasspi/wbs/conf/
<OV_AGT_DIR>/wasspi/wbs/datalog/
<OV_AGT_DIR>/wasspi/wbs/history/
<OV_AGT_DIR>/wasspi/wbs/1lib/
<OV_AGT_DIR>/wasspi/wbs/log/
<OV_AGT_DIR>/wasspi/wbs/tmp/

e  Checks that the following files exist:

<OV_AGT_DIR>/wasspi/wbs/conf/MBeanReports.dtd
<OV_AGT_DIR>/wasspi/wbs/conf/MBeanReports.xsl
<OV_AGT_DIR>/wasspi/wbs/conf/MetricDefinitions.dtd
<OV_AGT_DIR>/wasspi/wbs/conf/MetricDefinitions.ser
<OV_AGT_DIR>/wasspi/wbs/conf/MetricMap
<OV_AGT_DIR>/wasspi/wbs/conf/OVTrace.sample
<OV_AGT_DIR>/wasspi/wbs/conf/ReportsHeader.xsl
<OV_AGT_DIR>/wasspi/wbs/conf/ReportsUtil.xsl
<OV_AGT_DIR>/wasspi/wbs/conf/SiteConfig
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfig
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfigCfgFiles
<OV_AGT_DIR>/wasspi/wbs/conf/SPIConfigLogFiles
<OV_AGT_DIR>/wasspi/wbs/conf/trigger
<OV_AGT_DIR>/wasspi/wbs/lib/GraphSP.xsl
<OV_AGT_DIR>/wasspi/wbs/1lib/JspiCola.jar
<OV_AGT_DIR>/wasspi/wbs/lib/MetricMap.xsl
<OV_AGT_DIR>/wasspi/wbs/lib/xalan.jar
<OV_AGT_DIR>/wasspi/wbs/lib/xerces.jar

Appendix C



Applications

On Windows managed nodes:

Checks that the following files exist:
<OV_AGT_DIR>\bin\OpC\cmds\wasspi wbs admin.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi wbs debug.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi wbs spiapps.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi wbs udmgraphs.exe
— <OV_AGT_DIR>\bin\OpC\cmds\wasspi wbs verify.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs ca.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs config.exe
— <OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs files.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs le.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs logdata.exe

<OV_AGT_DIR>\bin\OpC\monitor\wasspi wbs setpath.exe
Checks that the following files exist and the version is higher than A.01:
<OV_AGT_DIR>\bin\OpC\monitor\ddfcomp.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddfcomp coda.exe
— <OV_AGT_DIR>\bin\OpC\monitor\ddflog.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddflog coda.exe
— <OV_AGT_DIR>\bin\OpC\monitor\ddfutil.exe

<OV_AGT_DIR>\bin\OpC\monitor\ddfutil coda.exe

On UNIX managed nodes:

Checks that the following files exist:
<OV_AGT_DIR>/bin/OpC/cmds/wasspi_ wbs admin

<OV_AGT_DIR>/bin/OpC/cmds/wasspi_wbs debug

— <OV_AGT_DIR>/bin/0pC/cmds/wasspi wbs spiapps

— <OV_AGT_DIR>/bin/0pC/cmds/wasspi wbs udmgraphs
— <OV_AGT_DIR>/bin/0pC/cmds/wasspi wbs verify

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi setpath

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi wbs ca

— <OV_AGT_DIR>/bin/0OpC/monitor/wasspi wbs config
— <OV_AGT_DIR>/bin/0OpC/monitor/wasspi wbs config.pl
— <OV_AGT_DIR>/bin/0OpC/monitor/wasspi wbs files

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi wbs le

— <OV_AGT_DIR>/bin/0OpC/monitor/wasspi wbs lib.pl
— <OV_AGT_DIR>/bin/OpC/monitor/wasspi wbs logdata
— <OV_AGT_DIR>/bin/0OpC/monitor/wasspi xterm
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¢ Checks that the following files exist and the version is higher than A.01:

<OV_AGT_DIR>/bin/0OpC/monitor/ddfcomp

— <OV_AGT_DIR>/bin/0OpC/monitor/ddfcomp coda
— <OV_AGT _DIR>/bin/0OpC/monitor/ddflog

— <OV_AGT_DIR>/bin/0OpC/monitor/ddflog coda
— <OV_AGT _DIR>/bin/OpC/monitor/ddfutil

<OV_AGT_DIR>/bin/OpC/monitor/ddfutil coda

In this instance, <OV_AGT DIR>is /var/opt/OV on a UNIX managed node and on a
Windows managed node it depends on the installation of the product.

To Launch the Verify Application

1 From the HPOM console, select a node in the Node Bank window.

2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Verify.
If the Verify application is successful, the following message appears:

Installation is clean

View Error File

The View Error File application enables you to view the contents of the WebSphere SPI error
log file.

Function

The View Error File application enables you to view the contents of the WebSphere SPI error
log file <OV_AGT DIR>/wasspi/wbs/log/errorlog where <OV_AGT DIR> typically is:

e /var/opt/0V on UNIX managed nodes

® /Program Files/HP OpenView/Installed Packages/
{790 ...} on Windows managed nodes
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To Launch the View Error File Application

1 From the HPOM console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click View
Error File.

View Graphs

The View Graphs application launches the WebSphere SPI graphs, generated through HP
Performance Manager, in a web browser.

Required Setup

To run this application successfully, install the HP Performance Manager and edit the
ovweb. conf file. For more information, see Task 1: Configure the Management Server to
Launch Your Web Browser on page 37.

If your browser is Netscape Navigator, use version 6.0 or higher. Do not use Netscape
Navigator 4.79 with this application.

Function

The View Graphs application launches a web browser to display WebSphere SPI metric data
graphed using HP Performance Manager.

To Launch the View Graphs Application

1 From the HPOM console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin — View Graphs.
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WebSphere Applications Group

The WebSphere Applications Group includes the following applications.

Check WebSphere

The Check WebSphere application displays a status report of the WebSphere instances on the
selected managed nodes. It enables you to check the status of each application server running
on a managed node.

Function

The Check WebSphere application displays the following information for each application
server on the selected nodes:

Information Description

Server Name The server name as defined in WebSphere.

Server State The status of the WebSphere Server.

Start Date The date when the WebSphere Server was started.

Port The port on which the WebSphere Server listens.

Admin Server Host The location of the WebSphere administration server for this
WebSphere instance.

Admin Server Port The port of the WebSphere administration server for this
WebSphere instance.

Current Open Socket Count | The number of open sockets for the WebSphere Server.

WebSphere Version The version number of the WebSphere Server.

If the WebSphere SPI has been configured to not collect metrics for a WebSphere Server, the
message Collection is temporarily OFF for <server_name> appears.

To Launch the Check WebSphere Application

1 From the HPOM console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WebSphere and double-click Check
WebSphere.
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Start/Stop WebSphere

The Start and Stop WebSphere applications starts or stop a WebSphere application server
from the HPOM console. You can start or stop one or more WebSphere Application servers on
the selected managed nodes without logging in to each WebSphere Administration Server.

Required Setup

The START_CMD, STOP_CMD, and USER configuration properties must be set before
launching these applications.

Function

The Start and Stop WebSphere applications start or stop one or all application servers on the
selected managed nodes.

To Launch Start/Stop WebSphere

1
2
3

From the HPOM console, select a node in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI > WebSphere and double-click Start
WebSphere or Stop WebSphere. The START WBS or STOP WBS window opens.

Select the server you want to start/stop from the options given.

View WebSphere Logs

Applications

The View WebSphere Logs application enables you select and view a WebSphere Server log
file without logging in to the system on which a WebSphere Server is running.

Function

The View WebSphere Logs application performs the following functions:

When you launch the View WebSphere Logs application without a parameter, the
applications returns a numbered list of available log files for the selected managed node.

When you launch the View WebSphere Logs application with an invalid parameter (for
example, a non-numeric value or a number that does not correspond to the list of available
log files), the application returns a numbered list of available log files for the selected
managed node.

When you launch the View WebSphere Logs with a valid parameter, the application
returns the contents of the corresponding log file for the managed node.

You can enter only one numeric value in the parameter field. This log file designated to this
number (for all managed nodes) will appear. Select one log file per managed node to view each
time you launch the application.

If you keep the Application Status window open and re-launch the application, the output in
the Application Status window accumulates.
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To Launch the View WebSphere Logs Application

10
1

12
13

14
15

From the HPOM console, select a node in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI > WebSphere and double-click View
WebSphere Logs.

Select the managed nodes on which you want to view the WebSphere Server log file.

Select Launch. The Edit Parameters window appears. If you know the number of the log
file you want to view, enter it into the Parameters field. Otherwise, leave this field blank
to list available log files to view.

Select Launch. The Application Status window opens.
In the Launched Applications field, check the Status of the application for each node:
e Started/Starting - The application is running.

¢ Succeeded - A list of available log files to view appears. Highlight the node in the
Launched Applications field and scroll through the Application Output field to view
the list of available log files.

e Failed - The application did not succeed. Highlight the node in the Launched
Applications field and scroll through the Application Output field for more
information about the problem.

Double-click View WebSphere Logs.
Select the managed nodes on which you want to view the WebSphere Server log file.
Select Launch. The Edit Parameters window appears.

In the Parameters text box, enter the number of the log file you want to view. Only one log
file can be selected.

If you do not remember the number of the log file, go to the Application Status window,
highlight the node in the Launched Applications field, scroll through the Application
Output filed to view the list of available log files, and enter the number of the log file you
want to view in the Edit Parameters window.

Select Launch.

In the Application Status window, highlight the node on which to view the selected log file
and scroll through the Application Output filed to view the log file.

Repeat steps 8-11 for each log file you want to view.

Select Close to close the Application Status window.
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Glossary

agent

A program or process running on a remote device or computer system that responds to
management requests, performs management operations, or sends performance and event
notification. An agent can provide access to managed objects and MIB variables, interpret
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is executed in response to an event, message, or a
change in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service
from another computer (server). When the context is software, a program or executable
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out.
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that
make up the network. For example the components of a network may include computer
systems, routers, switches, hubs, operating systems and network software. The configuration
of the network determines the way that it works and the way that it is used. In a software
context, the combination of settings of software parameters and attributes that determine the
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified
environment, application or usage.

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of
applications.

customization

The process of designing, constructing or modifying software to meet the needs and
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the
business environment.

Deployed application

An application and its components that have been installed and started to work in the
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.



event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated
by an agent or process in a managed object or by a user action. Events usually indicate a
change in the state of a managed object or cause an action to occur.

HP Operations Manager

A family of network and system management products, and an architecture for those
products. HPOM includes development environments and a wide variety of management
applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure.

icon

An on-screen image that represents objects that can be monitored or manipulated by the user
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application
or set of management applications. The console may be on the system that contains the
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of
one or more events relative to specified conditions, or a change in application, system,
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an
event, the evaluation of one or more events relative to specified conditions or a change in
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from
particular events.The string summarizes the important characteristics of the event. Message
keys can be used to allow messages to acknowledge other messages, and enables for the
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that
initiated the message. See also severity level.

metadata
Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT
environments. Management products are added or "snapped into" the management console
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the
presentation of a specific type of data. Modules can interact with one another and with other
software.

node

When the context is network, a computer system or device (for example, printer, router,
bridge) in a network. When the context is a graphical point to point layout, a graphical
element in a drawing that acts as a junction or connection point for other graphical elements.

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data
that is valid for the parameter. For example a parameter type could be IP Address which
indicates that parameter values must have 4 numbers separated by decimals with the value
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policy

A set of one or more specifications rules and other information that help automate network,
system, service, and process management. Policies can be deployed to various targets (for



example, managed systems, devices, network interfaces) providing consistent, automated
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying,
deleting) for the purposes of network, system or service management.

policy type
An abstraction or categorization of policies based on the function of the policy or the services
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device.
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for
example, management capabilities, file storage capabilities) to other computer systems
(clients) on the network. If the context is a software component, a program or executable
process that responds to and services requests issued by clients.

severity level
A property of an object indicating the status of the object. Severity level is based on the impact
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management
capabilities specific to a given type of business application, database, operating system, or
service.

trace log

An output file containing records of the execution of application software

189



190



Index

A

actions
customizing, 62

Add Application Server action, 151, 152
Add Group action, 151, 154

adding
nodes to WebSphere SPI node group, 50

Add Node action, 151, 155
ADDRESS property, 161
ALIAS property, 161
annotation reports, 77

Application Bank
reports, 19

application bank
reports generated, 78

applications, 17, 171
Check WebSphere, 19, 182
Configure WBSSPI, 18, 172
Deploy UDM, 21
Discover, 18, 47, 173
Gather MBean Data, 21
Init Non-Root, 18, 175
JMX Metric Builder, 21
Self-Healing Info, 18, 176
Start Monitoring, 18, 177
Start Tracing, 18, 177
Start WebSphere, 19, 183
Stop Monitoring, 18, 177
Stop Tracing, 18, 177
Stop WebSphere, 19
UDM Graph Disable, 21
UDM Graph Enable application, 21
Verify, 18, 178
View Error File, 18, 180
View Graphs, 18, 181
View WebSphere Logs, 19, 183
WBSSPI Admin group, 17
WBSSPI Reports group, 19
WebSphere group, 19

application server
verifying status, 42

Application Servers tree item, 150

Application Servers view, 158

assigning operator responsibilities, 31, 38
AUTO_DISCOVER, 157
AUTO_DISCOVER property, 161

automatic action reports, 77

B
bundles, 26

C
Cancel button, 151
cell, 58

Check WebSphere application, 19, 182
how to run, 182
what it does, 182

CODA
using, 82

collecting
WebSphere login information, 43

collection intervals
changing, 69
changing for selected metrics, 69

collector templates, 22

conditional properties
configuring, 51
requirements, 51
setting, 51

configuration
properties, 159
structure, 147
syntax, 147

configuration editor, see Configure WBSSPI
application

configuration example
different login information, 169
global defaults, 167
global login information, 169
group and node properties, 167
single node/two servers, 167
virtual IP addresses, 168
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configuration files

location, 145

Configurations view, 158

Configuration tree item, 150
Configure WBSSPI application, 18, 172

how to run, 172
using
what it does, 172

configuring, 37

conditional properties, 51

HP Performance Manager, 37
managed nodes, 42
management server, 37, 45
ovweb.conf, 37

prerequisites, 37

remote systems, 73

Config WBSSPI application
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actions, 151

Add Application Server action, 151, 152
Add Group action, 151, 154

Add Node action, 151, 155

Application Servers tree item, 150
Application Servers view, 158
AUTO_DISCOVER, 157

buttons, 151

Cancel button, 151

Configurations view, 158

Configuration tree item, 150

Default Properties tree item, 150

Default Properties view, 158

Defaults tree item, 150

Defaults view, 158

Exit action, 152

Finish button, 151

Groups tree item, 150

Groups view, 158

modifying a property, 157

Next button, 151

Nodes tree item, 150

Nodes view, 158

Remove ALL App Servers action, 152, 155
Remove ALL Groups action, 152, 155
Remove ALL Nodes action, 152, 156
Remove Application Server action, 152, 155
Remove Group action, 152, 155

Remove Node action, 152, 156

removing a property, 157

Save action, 152

Save button, 151

Set Configuration Properties tab, 152, 156
setting a property, 156

tree, 149

View Configuration Settings tab, 152, 157
View Inherited Properties, 158

creating
template groups, 70

customizing
creating new templates, 70
metrics, 17
templates, 61, 65
thresholds for different servers, 70

D

data collection, 13

data interpretation, 14

Default Properties tree item, 150
Default Properties view, 158
Defaults tree item, 150

Defaults view, 158

Deployment Manager, 58

Deploy UDM application, 21

directories
locations for trace file/error logs, 101

Discover application, 18, 47, 173
how to run, 173
setting LOGIN and PASSWORD, 48
what it does, 173

Discover WebSphere Application, 59, 60

discovery process
verifying, 49

discovery template, 22
displaying graphed metrics, 37
distributed network deployer scenario, 58, 59

distributing
templates, 50

duration
customizing, 62

E
enabling PMI, 44

error logs
location, 145

error messages, 106 to 143
Exit action, 152

F

files, locations on management server/managed
nodes, 99, 101

filesets, 26
Finish button, 151



G

Gather MBean Data application, 21
global properties, 147
GRAPH_URL property, 162

graphs
example, 88
HP Performance Manager, 81
metrics used to generate, 88
pre-defined for HP Performance Manager, 88

GROUP block, 147
Groups tree item, 150

Groups view, 158

H
HOME property, 162

HP Performance Agent, 81
using, 82

HP Performance Insight
pre-defined reports, 86

HP Performance Manager
integrating with WebSphere SPI, 37, 87
pre-defined graphs, 88

Init Non-Root application, 18, 175
how to run, 175
what it does, 175

installing, 25
bundles, 26
filesets, 26
report package, 83
software requirements, 25
swinstall, 25

instruction text
location, 14

J

JAVA_HOME property, 162
JMB_JAVA_HOME property, 162
JMX_CLASSPATH property, 162
JMX Metric Builder application, 21

L

license count, 79

limitations
remote systems, 75

logfile monitoring
remote systems, 75

LOGFILE property, 162
logfiles templates, 21

LOGIN
setting, 48

LOGIN property, 162

M

managed nodes
configuring, 42

management server
configuring, 45

MAX_ERROR_LOG_SIZE property, 163

MeasureWare
using, 82
messages

instruction text, 14
message browser, 14

message template, 22

message text
customizing, 62

metrics
customizing, 17
data collected, 13
graphs generated from, 88

HP Performance Insight reports generated from,

86

modifying collections in the collector template,

65
Reporter reports generated from, 85

metrics templates, 21

modifying
collection intervals, 69

modifying a property, 157

N

NAME property, 163

Next button, 151

Node Agent, 58

NODE block, 148

Nodes tree item, 150

Nodes view, 158
NUM_SERVERS property, 163

(o)

ov.envvars.sh, 37
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OV_CONF environment variable, 37
OVERRIDE_DISTRIBUTED_MODE, 60

ovweb.conf
configuring, 37
OV_CONF environment variable, 37

P

PASSWORD
setting, 48

PASSWORD property, 163

PMI
enabling, 44
metrics generating WebSphere SPI Reports, 78
template groups level, 23

PORT property, 163

prerequisites
configuring, 37

PROFILE_HOME property, 164

properties, 159
global, 147
listed by WebSphere SPI requirements, 160
precedence, 148
server-specific, 148

R

reinstalling
templates, 76

remote systems, 72
configuring, 73
limitations, 75
logfile monitoring, 75
overview, 72
requirements, 72

Remove ALL App Servers action, 152, 155
Remove ALL Groups action, 152, 155
Remove ALL Nodes action, 152, 156
Remove Application Server action, 152, 155
Remove Group action, 152, 155

Remove Node action, 152, 156

removing
swremove, 27, 30
WebSphere SPI, 26

removing a property, 157

Reporter
pre-defined reports, 85
using, 83

Reporter reports, 15
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Report package, 15

report package
installing, 29, 83

reports

annotation, 77

application bank, 78

Application Bank generated, 19

automatic action, 77

generated from alarms, 20

generated from HP Performance Insight, 86

generated from HP Reporter, 84

HP Performance Insight, 81

HP Reporter, 15

included, 15

metrics used to generate in HP Performance
Insight, 86

metrics used to generate in Reporter, 85

pre-defined for HP Performance Insight, 86

pre-defined for Reporter, 85

Reporter, 81

reports (automatic action)
how they are generated, 77

requirements
remote systems, 72

resetting thresholds, 64
RMID_PORT property, 163
RMID_START_TIME property, 164

S

Save action, 152
Save button, 151
Schedule templates, 22

Self-Healing Info application, 18, 176
how to run, 176
required setup, 176
what it does, 176
server-specific properties, 148
Set Access Info for Default Properties window, 48
Set Configuration Properties tab, 152, 156

Set Configuration Settings tab
AUTO_DISCOVER, 157
modifying a property, 157
removing a property, 157
setting a property, 156

setting a property, 156

severity
customizing, 62

software requirements, 25

START_CMD property, 164



Start Monitoring application, 18, 177
how to run, 177
what it does, 177

Start Tracing application, 18, 177
how to run, 177
what it does, 177

Start WebSphere application, 19, 183
how to run, 183
what it does, 183

STOP_CMD property, 164

Stop Monitoring application, 18, 177
how to run, 177
what it does, 177

Stop Tracing application, 18, 177
how to run, 177
what it does, 177

Stop WebSphere application, 19
how to run, 183
what it does, 183

structure
configuration, 147

swinstall, 25
swremove, 27, 30

syntax
configuration, 147

T
tag option

creating custom template groups, 70

template groups
changing collection intervals, 69
creating, 70
creating with tag parameter, 70
PMI level, 23
WBSSPI Discovery, 22
WBSSPI-Logfiles, 21
WBSSPI-Metrics, 21
WBSSPI-Schedule, 22

templates, 21
collector, 22
continuously setting, 64
customizing, 61, 65
customizing actions, 62
customizing duration, 62
customizing message text, 62
customizing severity, 62
customizing thresholds, 62
discovery, 22
distributing, 50
logfiles, 21
message, 22
metrics, 21
reinstalling, 76
resetting thresholds, 64
schedule, 22
thresholds without reset, 64
WBSSPI-Messages, 22

thresholds
customizing, 62
resetting, 64
settings for different servers, 70
without reset, 64

TIMEOUT property, 164
TYPE property, 165

U

UDM_DEFINITIONS_FILE property, 165
UDM Graph Disable, 21

UDM Graph Enable, 21

uninstallilng, 26

unsupported platforms, 72

upgrading, 29
management server, 31
WBS-SPI report package, 29
WebSphere SPI report package, 29, 35, 36

Use Case
1,59
2,59
3, 60
4, 60

user defined metrics
graphing, 98
USER property, 165
using
Configure WBSSPI application

Using JMX Actions Command Parameters, 67
Examples, 68
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Verify application, 18, 178
how to run, 180
what it does, 178
verifying
application server status, 42
discovery process, 49

VERSION property, 165

View Configuration Settings tab, 152, 157
View Inherited Properties, 158

View Error File application, 18, 180
how to run, 181
what it does, 180

View Graphs application, 18, 181
how to run, 181
required setup, 181
what it does, 181

View Inherited Properties, 158

View WebSphere Logs application, 19, 183
how to run, 184
what it does, 183

virtual IP addresses
example configuration, 168

w

wasspi_wbs_ca command, 65
parameters, 65
tag option, 70
WBSSPI Admin application group, 17, 172
WBSSPI Discovery template group, 22
WBSSPI-Logfiles template group, 21
WBSSPI-Messages template, 22
WBSSPI-Metrics template group, 21
WBSSPI Reports application group, 19
WBSSPI-Schedule template group, 22
WebSphere application group, 19, 182

WebSphere login information
collecting, 43

WebSphere SPI
capabilities, 13
components, 17
overview, 14
removing, 26

WebSphere SPI node group
adding nodes, 50
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